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1

Wprowadzenie

Maya jest to wydawany przez firmę Autodesk program do tworzenia szeroko
rozumianej grafiki 3D. Obok 3ds Max jest obecnie jednym z najpopularniej-
szych pakietów wspomagających prace nad grafiką trójwymiarową. Wykorzy-
stuje się go na szeroką skalę w produkcji filmowej, reklamach, wizualizacjach,
grach wideo oraz wszelkich innego rodzaju zastosowaniach wymagających two-
rzenia wysokiej jakości obiektów i obrazów 3D - zarówno statycznych, jak
i animowanych.

1.1 Praca nad projektem 3D

Podczas pracy nad projektem 3D można wyróżnić następujące tematy:

1. Faza koncepcyjna (preprodukcja) - tworzenie założeń projektu i zbie-
ranie materiałów referencyjnych, na podstawie których modelowana jest
scena i ustawiane oświetlenie. Zagadnieniu temu nie poświęciliśmy odręb-
nego rozdziału, ponieważ nie jest on bezpośrednio związany z obsługą pro-
gramu Maya, jednakże w kilku omówionych przykładach można znaleźć
wskazówki dotyczące tego etapu pracy.

2. Modelowanie - scena 3D musi być wypełniona odpowiednio ukształto-
wanymi modelami i zazwyczaj pierwszym etapem pracy w Maya jest two-
rzenie trójwymiarowych siatek reprezentujących te obiekty. Jest to jedno-
cześnie głównym tematem niniejszej książki - poświęcono mu rozdziały od
3 do 8.

3. Tworzenie materiałów - powierzchnie wymodelowanych siatek 3D do-
myślnie są jednolicie gładkie i jednokolorowe, nie odzwierciedlając wyglą-
du i struktury materiałów, z jakich wykonane byłyby obiekty w rzeczy-
wistości. Dzięki materiałom nakładanym na obiekty możemy nadawać im
różne właściwości, takie jak kolor, chropowatość, połyskliwość, przezro-
czystość itd. Jest to więc zagadnienie bezpośrednio związane z wyglądem
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modelowanych obiektów - rozdziały 8 i 9 poświęcono zagadnieniom doty-
czącym tworzeniu materiałów oraz tekstur i ich nakładaniu na powierzch-
nie obiektów.

4. Oświetlenie i rendering - aby scena 3D została przetworzona do obrazu
uwzględniającego wygląd materiałów i inne symulowane w niej zjawiska
optyczne, konieczne jest przeprowadzenie złożonych obliczeń w procesie
zwanym renderingiem. W tym celu w scenie symulowane są emitery świa-
tła, a sam proces renderowania uzależniony jest od wielu opcji i parame-
trów. Ze względu na brak miejsca w niniejszej książce, wspominamy o tych
zagadnieniach tylko w związku z kilkoma specyficznymi przykładami.

5. Animacja i efekty specjalne - ten etap pracy często wykonywany jest
równolegle z dwoma wymienionymi powyżej (lub nawet przed nimi), ale
nie jest to regułą. W ramach tej książki brakło miejsca na omówienie na-
rzędzi animacyjnych, jednak warto podkreślić, że sukces w tych dziedzi-
nach w dużej mierze zależy od umiejętności modelarzy przygotowujących
obiekty do animacji i efektów specjalnych.

Ze względu na mnogość i złożoność zagadnień związanych z procesem two-
rzenia grafiki 3D oraz liczbę funkcji dostępnych w programie Maya, niniejsza
książka skupia się na wybranych narzędziach, które wykorzystuje się na etapie
modelowania.

1.2 Techniki modelowania

Modelowanie w grafice 3D to tworzenie brył geometrycznych o określonych
kształtach. W zależności od ich przeznaczenia mogą one być tak proste jak
sześcian lub tak złożone jak renesansowa budowla. Do modelowania brył róż-
nego typu zazwyczaj wykorzystujemy nieco inne zestawy narzędzi, a w obrębie
samego modelowania można wyróżnić podziały na kategorie ze względu na
różne kryteria:

• Modelowanie obiektów uproszczonych (low-poly) i złożonych (hi-poly),
czyli podział w zależności od stopnia skomplikowania kształtów i struktury
modeli.

• Modelowanie obiektów technicznych i organicznych, czyli zróżnicowanie ze
względu na regularność brył i pożądaną dokładność w odwzorowaniu wy-
miarów.

• Modelowanie obiektów do grafiki interaktywnej (np. gier), animacji i złożo-
nego renderingu, czyli szereg dodatkowych kryteriów (takich jak topologia
siatek, typy wykorzystanych powierzchni i materiałów i inne), które muszą
być spełniane w zależności od tego, na jakim medium ma być wyświetlany
dany model.

W następnych rozdziałach postaramy się dość przekrojowo przedstawić różne
techniki modelowania, kładąc szczególny nacisk na modelowanie ściankowe
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Rysunek 1.1. Model pistoletu Glock utworzony metodą wygładzania ścianek up-
roszczonej siatki (zobacz rozdział 6)

(rysunek 1.1), jako metodę najbardziej uniwersalną oraz posiadającą w Mayi
najbardziej rozbudowany zestaw narzędzi. Oprócz klasycznego modelowania
ściankowego Maya umożliwia wykorzystanie innych technik, takich jak po-
wierzchnie podpodziałowe (Subdivision Surfaces - rysunek 1.2) czy rzeźbienie
(Sculpting), jednak te metody zostały lepiej rozwinięte w innych programach
niż Maya (rysunek 1.3), a poza tym w wielu zastosowaniach trudno jest się
nimi posługiwać.

Przykłady modeli wykonanych różnymi technikami przedstawiają rysunki
1.1 - 1.3.

1.3 Siatki, ich komponenty i transformacje

W następnych rozdziałach zostaną przedstawione różne techniki modelowania
i szereg mniej lub bardziej zaawansowanych ćwiczeń z tworzenia obiektów 3D,
a w każdym z nich zetkniemy się z kilkoma pojęciami i narzędziami, których
opanowanie jest niezbędne do pracy przy modelowaniu.

1.4 Scena i dodawanie do niej obiektów

Po uruchomieniu Mayi widzimy okno z interfejsem omówionym bardziej szcze-
gółowo w rozdziale 2. Centralną część okna programu zajmuje obszar robo-
czy (zwany też oknem widokowym), reprezentujący trójwymiarowy podgląd
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Rysunek 1.2. Model dzbana wykonany przy użyciu powierzchni podpodziałowych
(zobacz rozdział 7)

Rysunek 1.3. Model głowy utworzony techniką rzeźbienia w programie ZBrush,
który pozwala na rzeźbienie brył organicznych w sposób o wiele wydajniejszy niż
Maya
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sceny. Scena to wirtualna przestrzeń, w której umieszczamy tworzone przez
nas obiekty. Scenę z obiektami można zapisać na dysku (polecenie File > Save
Scene) i ponownie otwierać podobnie jak dokumenty tworzone w innych apli-
kacjach. Jeśli chcemy usunąć zawartość aktualnej sceny i zacząć pracę w pustej
przestrzeni, wystarczy wybrać polecenie File > New Scene.

Do sceny możemy dodawać niemal nieograniczoną liczbę obiektów, zmie-
niając ją na przykład w skomplikowany model miasta wypełniony budynkami,
pojazdami i postaciami. Zazwyczaj każdy obiekt dodany do sceny jest odręb-
nym modelem, czyli bryłą o pewnym kształcie i właściwościach.

Aby dodać do sceny prosty obiekt - sferę, wybierz polecenie Create > Poly-
gon Primitives > Sphere, a następnie kliknij kursorem w obszarze roboczym
oraz nie zwalniając lewego przycisku myszy, przeciągnij w oknie, definiując
rozmiar modelu sfery (rysunek 1.4). Aby ujrzeć wypełniony (cieniowany) pod-
gląd sfery, naciśnij klawisz 5.

Rysunek 1.4. Dodawanie modelu sfery do sceny 3D

Analogicznie można dodawać do sceny inne proste bryły (np. prostopa-
dłościan - Cube, czy stożek - Cone) i składać z nich bardziej złożone kształty
(zobacz rozdział 4), jednakże zbiór predefiniowanych obiektów szybko okazuje
się niewystarczający i konieczne jest ręczne modyfikowanie kształtu siatek
w celu uzyskania odpowiednich rezultatów.
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Transformacje obiektu

Podstawą wszelkich operacji edycyjnych są transformacje, czyli zmiany poło-
żenia, obrotu lub skali obiektów bądź ich elementów składowych. Transformo-
wać można zarówno obiekty w całości (lub nawet grupy obiektów), jak również
ich komponenty, takie jak ścianki, wierzchołki czy krawędzie.

Aby wykonać transformację przesunięcia sfery, naciśnij klawisz W, uaktyw-
niając narzędzie Move Tool. W środku sfery wyświetlona zostanie ikona ukła-
du współrzędnych z trzema osiami - klikając na jednej z tych osi i przeciąga-
jąc kursorem, możemy przesunąć obiekt w wybranym kierunku (rysunek 1.5).
Analogicznie, klawiszami E i R włączamy odpowiednio narzędzia do obraca-
nia (Rotate Tool) i skalowania (Scale Tool). Narzędzia te można włączać też
ikonami w przyborniku po lewej stronie ekranu, na których czerwone strzałki
symbolizują odpowiednie transformacje.

Rysunek 1.5. Transformacja przesunięcia sfery narzędziem Move Tool

Edycja ścianek

Siatka (ang. mesh lub polygon object) to reprezentacja obiektu 3D w postaci
zbioru wielokątnych ścianek (ang. polygons lub faces), o różnych kształtach,
odpowiednio połączonych ze sobą i ulokowanych w przestrzeni. W przypadku
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Rysunek 1.6. Zaznaczanie ścianek do transformacji

sfery widzimy, że większość jej ścianek to czworokąty, które w zależności od
odległości od biegunów mają różne kształty. Dodatkowo, tuż przy biegunach
znajdują się ścianki trójkątne. Modyfikując kształt oraz położenie poszcze-
gólnych ścianek, a także wstawiając dodatkowe ścianki w odpowiednich miej-
scach, możemy z prostej bryły wymodelować dowolnie skomplikowany obiekt.

Chcąc zmodyfikować kształt sfery poprzez transformacje ścianek, naciśnij
klawisz F11, spowoduje to przejście z trybu edycji całego obiektu do trybu edy-
cji poszczególnych ścianek. Klikając pośrodku danej ścianki albo przeciąga-
jąc kursorem nad kilkoma ściankami, zaznaczamy komponenty do późniejszej
transformacji. Zamiast klawisza F11, można kliknąć sferę prawym przyciskiem
myszy i z menu podręcznego wybrać pozycję Face, co również uaktywni tryb
edycji ścianek. Zaznaczone ścianki można przesunąć, obrócić i przeskalować
tak samo jak całe obiekty - zobacz rysunek 1.7.

Jak można się domyślić, wykonując więcej tego typu operacji z większą pre-
cyzją i na siatce o większej liczbie ścianek, możemy uzyskać bardziej złożone
kształty (rysunek 1.8).

Edycja wierzchołków i krawędzi

Ścianki są tylko jednym z poziomów struktury obiektu, który możemy podda-
wać edycji. Często zamiast modyfikować ścianki, wygodniej jest przekształcać
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Rysunek 1.7. Transformacje przesunięcia, obrotu i skalowania zaznaczonych ścia-
nek

Rysunek 1.8. Abstrakcyjny model głowy utworzony poprzez transformacje ścianek
sfery
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wierzchołki (ang. vertices) lub krawędzie (ang. edges), pomiędzy którymi roz-
pięte są ścianki.

Rysunek 1.9. Przesunięcie zaznaczonych wierzchołków w trybie Vertex

Rysunek 1.10. Skalowanie zaznaczonych krawędzi w trybie Edge
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Aby przejść do trybów edycji wierzchołków lub krawędzi, należy posłużyć
się odpowiednio klawiszami F9 (lub poleceniem Vertex z menu podręcznego)
bądź F10 (lub skrótem Edge). Krawędzie i wierzchołki można transformować
tymi samymi narzędziami co ścianki, jednak w tych dwóch trybach dostępne
stają się inne specyficzne narzędzia, które omówimy w późniejszych rozdzia-
łach.



2

Interfejs programu Maya

2.1 Wprowadzenie

Po zainstalowaniu programu Autodesk Maya 2010 na dysku twardym, możemy
uruchomić go za pomocą ikony na pulpicie lub skrótu dostępnego w menu Start
systemu Windows. Jeśli na naszym komputerze zainstalowana była wcześniej
inna wersja programu Maya, program może przenieść zdefiniowane ustawienia
interfejsu użytkownika do najnowszej wersji. Przy domyślnych ustawieniach po
uruchomieniu powinniśmy ujrzeć ekran widoczny na rysunku 2.1.

Rysunek 2.1. Domyślny interfejs programu Maya
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Pośrodku ekranu znajduje się okno dialogowe Learning Movies, dające bez-
pośredni dostęp do filmów szkoleniowych dotyczących posługiwania się prog-
ramem. Osobom, które po raz pierwszy zetknęły się z Mayą i miały trudności
z podstawowymi narzędziami omówionymi w następnych rozdziałach, zale-
camy obejrzenie tych filmów. Większość zagadnień przedstawionych w filmach
szkoleniowych jest omówiona w następnych rozdziałach, dlatego zapoznanie
się z nimi nie jest konieczne dla opanowania tematów przedstawionych w dal-
szej części książki.

Okno Learning Movies może nie być nam potrzebne przy każdym urucho-
mieniu programu, dlatego po obejrzeniu filmów szkoleniowych warto aktywo-
wać opcję Do not show this at startup w dole tego okna, która wyłączy jego
wyświetlanie.

2.2 Podstawowe grupy narzędzi

Narzędzia programu Maya są pogrupowane w panele, które można ukrywać
i ponownie wyświetlać w miarę potrzeb, konfigurując interfejs wedle własnego
uznania. Do niemal każdej funkcji dostęp możliwy jest na kilka różnych spo-
sobów. W tym podrozdziale przedstawimy najistotniejsze elementy interfejsu,
wyróżnione kolejnymi numerami na rysunku 2.2.

Rysunek 2.2. Najważniejsze panele narzędziowe programu Maya

Kolejne numery na rysunku 2.2 oznaczają:

1. Pasek tytułowy i listwa menu;
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2. Listwa statusu (Status Line);
3. Półka narzędziowa (Shelf );
4. Narzędzia podręczne (Tool Box ) - panel związany z zaznaczaniem i trans-

formacjami;
5. Narzędzia podręczne (Tool Box ) - panel związany z oknami widokowymi;
6. Suwak czasu (Time Slider);
7. Suwak zakresów (Range Slider);
8. Linia poleceń (Command Line);
9. Linia pomocy (Help Line);

10. Narzędzia do sterowania oknami widokowymi;
11. Główne okno widokowe;
12. Panel atrybutów, kanałów, warstw i ustawień narzędzi (Attribute Editor/

Tool Settings/Channel Box/Layer Editor).

Pasek tytułowy i listwa menu

Na samej górze interfejsu programu jest pasek z napisem Autodesk Maya 2010
i nazwą aktualnie otwartego pliku sceny (rysunek 2.3). Dopóki nie zapiszemy
nowej sceny na dysku lub nie załadujemy stworzonego wcześniej pliku, na pa-
sku tytułowym widnieje napis untitled.

Rysunek 2.3. Górna część interfejsu z rozwiniętą listą układów menu

Poniżej paska tytułowego znajduje się listwa z rozwijanymi menu (File,
Edit, Modify, Create, Display itd.). Menu te dają dostęp do niemal wszystkich
funkcji programu - ogromna większość ikon i przycisków programu ma swoje
odpowiedniki w jednym z tych menu. Interfejs Mayi jest na tyle elastyczny, że
poszczególne funkcje z rozwijanych menu można przenosić na łatwiej dostępne
półki z narzędziami, podobnie jak możliwe jest przekonfigurowanie samego
układu menu.

Należy zwrócić uwagę na to, że zestaw dostępnych menu zależy od tego, ja-
ki układ menu wybierzemy z rozwijanej listy po lewej stronie półki narzędzio-
wej (rysunek 2.3). Przy domyślnie wybranym układzie Animation, listwa menu
wyświetla inne pozycje niż na przykład w przypadku trybu Polygons. Pierwsze
7 menu (od File do Assets) występuje w każdym układzie, natomiast pozostałe
(np. Mesh, Proxy, Normals) dostępne są tylko w określonych układach menu.
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Ze względu na tematykę tej książki, która obejmuje przede wszystkim mo-
delowanie obiektów ściankowych, najkorzystniej jest wybrać układ Polygons
(rysunek 2.3), w którym dostępne są narzędzia służące do pracy z tego typu
obiektami. W niniejszym rozdziale omówimy menu zawierające ogólne funk-
cje, natomiast narzędzia związane ze specyficznymi zadaniami dotyczącymi
modelowania zostaną przedstawione bardziej szczegółowo w następnych roz-
działach.

Każde menu może być odłączone od listwy i wyświetlane na ekranie przez
cały czas, dając nam bezpośredni dostęp do znajdujących się w nim narzędzi.
W tym celu należy dwukrotnie kliknąć podwójną linię znajdującą się na górze
danego menu (rysunek 2.4), co spowoduje utworzenie nowego okna dialogowe-
go zawierającego wszystkie polecenia z tego menu. Okno to możemy następ-
nie przeciągnąć w dowolne miejsce ekranu (rysunek 2.5), a gdy przestanie być
potrzebne, zamknąć je krzyżykiem w prawym górnym rogu.

Rysunek 2.4. Aby odłączyć menu od listwy, należy dwukrotnie kliknąć podwójną
linię w jego górnej części

Większość poleceń we wszystkich menu służy do wywoływania określonych
funkcji programu.

Niektóre pozycje w menu pozwalają na rozwijanie kaskadowych podmenu,
grupujących pewne zbiory funkcji, jak na przykład Convert Selection z menu
Select (rysunek 2.6).
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Rysunek 2.5. Odłączone menu można przemieścić w dowolne miejsce na ekranie

Dość specyficzną cechą interfejsu programu Maya jest występująca przy
niektórych poleceniach w menu ikona pudełka (rysunek 2.7), która służy do ot-
wierania okna dialogowego z ustawieniami dotyczącymi danej funkcji lub na-
rzędzia. Na rysunku 2.7 przedstawiono przykładowe okno z opcjami narzędzia
Extract. Kiedy wybierzemy dane polecenie bezpośrednio, klikając jego nazwę
w menu, program wykona to polecenie z domyślnymi ustawieniami, natomiast
gdy klikniemy ikonę pudełka przy nazwie tego polecenia, możemy sparamet-
ryzować działanie tej funkcji zanim zostanie ona wykonana.

Menu operacji plikowych (File)

Pierwsze menu od lewej, File, zawiera polecenia związane z operacjami na pli-
kach, w których przechowywane są sceny 3D tworzone oraz modyfikowane
w Mayi. Najważniejsze dla nas polecenia z tego menu to:

• New Scene - tworzenie nowej pustej sceny. Aktualnie otwarta scena zostaje
usunięta z pamięci (program pyta o zapisanie jej na dysku, o ile nie została
wcześniej zapisana) i przywracana jest domyślna zawartość okien edycyj-
nych. Ikona pudełka obok tego polecenia pozwala na otwarcie okna dialogo-
wego, w którym możemy określić kilka dość istotnych ustawień, takich jak
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Rysunek 2.6. Podmenu Convert Selection

Rysunek 2.7. Ikona pudełka otwiera okno z opcjami danego narzędzia
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domyślne jednostki miary (Default Working Units) dla wielkości obiektów,
kątów obrotu czy czasu animacji.

• Open Scene - otwarcie sceny zapisanej na dysku. Na ekranie wyświetlane
jest okno dialogowe pozwalające odszukać oraz załadować plik z obiektami
Mayi. Domyślnie sceny te zapisywane są w plikach z rozszerzeniem *.mb,
można jednak w tym oknie ustawić filtr wyświetlania nazw plików (Files of
type) na pliki z innymi rozszerzeniami, w formatach obsługiwanych przez
program.

• Save Scene i Save Scene As - zapisanie aktualnej sceny na dysku. Polecenie
Save As zapisuje scenę pod bieżącą nazwą (chyba że scena nie była jeszcze
zapisywana, wtedy otwierane jest okno dialogowe pozwalające na wprowa-
dzenie nazwy i wybranie docelowego katalogu). Polecenie Save Scene As
pozwala zapisać kopię sceny pod inną nazwą niż bieżąca.

• Archive Scene - zapisanie sceny w formacie skompresowanym (ZIP), co
pozwala zmniejszyć rozmiar pliku na dysku.

• Save Preferences - zapisanie ustawień programu dotyczących konfiguracji
interfejsu i modułów zewnętrznych (pluginów).

• Optimize Scene Size - polecenie dość przydatne, gdy przez dłuższy czas
pracujemy z dość rozbudowaną sceną i gromadzi się w niej dużo niepot-
rzebnych danych, które program może automatycznie usunąć. Pozwala to
zmniejszyć rozmiar pliku ze sceną i przyspieszyć pracę, ale w niektórych
przypadkach może doprowadzić do powstania błędów w strukturach sceny.
Program po wybraniu tego polecenia ostrzega nas o braku możliwości cof-
nięcia zmian dokonanych tą funkcją - przed jej użyciem warto zapisać kopię
sceny na dysku pod inną nazwą.

• Import - dołączanie do bieżącej sceny obiektów z zewnętrznego pliku, który
może być w formacie innym niż standardowy format Mayi, o ile tylko jest
on obsługiwany przez aktualną wersję programu.

• Export All i Export Selection - zapisanie na dysku odpowiednio wszystkich
lub wyłącznie zaznaczonych obiektów, w jednym z formatów obsługiwa-
nych przez Mayę.

• Create Reference - polecenie działa podobnie do Import, czyli importuje do
sceny obiekty z zewnętrznego pliku. W tym przypadku jednak obiekty za-
chowują połączenie z plikiem źródłowym i w przypadku zmiany jego za-
wartości docelowa scena jest uaktualniana.

• Reference Editor - edytor powiązań pomiędzy scenami i obiektami, pozwa-
la on m.in. na zarządzanie połączeniami utworzonymi poleceniem Create
Reference.

• Project - podmenu zawierające 3 polecenia dotyczące zarządzania projek-
tami - New, Edit Current oraz Set. Omawiając te polecenia, musimy rów-
nież wspomnieć o ogólnej organizacji pracy z plikami Mayi, która bazuje na
tzw. projektach. Projekt to struktura katalogów, która porządkuje pliki od-
powiednich typów związane z realizowanymi przez nas zadaniami. Oprócz
plików ze scenami 3D na dysku często przechowywane są związane z danym
projektem tekstury (Textures), dźwięki (Sounds), skrypty z zewnętrznymi
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narzędziami (Mel) itd. Utworzenie projektu pozwala nam na katalogowanie
tych plików w taki sposób, aby program automatycznie wiedział, gdzie za-
pisywać i skąd pobierać poszczególne pliki (rysunek 2.8). Dzięki temu mo-
żemy łatwo przełączać się pomiędzy różnymi projektami i nie wyszukiwać
za każdym razem na dysku scen, tekstur czy wyrenderowanych obrazków.

• Recent Files, Recent Projects - podmenu dające dostęp do listy ostatnio
otwieranych scen i projektów.

Po wybraniu polecenia New możemy określić nazwę projektu (Name) oraz je-
go położenie na dysku (Location), a także nazwy poszczególnych katalogów,
w których znajdą się docelowo pliki projektu. Klikając przycisk Accept, doko-
nujemy utworzenia katalogów na dysku, a poleceniem Use Defaults możemy
przypisać katalogom domyślne nazwy przedstawione na rysunku 2.8.

Rysunek 2.8. Polecenie New z podmenu Project otwiera okno z ustawieniami no-
wego projektu
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Menu poleceń edycyjnych (Edit)

W tym menu znajdują się podstawowe funkcje edycyjne do pracy z obiektami
oraz scenami. Część z nich zostanie wykorzystana i zilustrowana nieco dokład-
niej w przykładach przedstawionych w dalszych rozdziałach niniejszej książki,
natomiast poniżej znajduje się ich ogólne zestawienie.

• Undo, Redo, Repeat, Recent Commands List - grupa poleceń służących do
cofania i ponawiania (lub powtarzania) ostatnio wykonanych operacji, łą-
cznie z możliwością wyświetlenia listy wszystkich zapamiętanych przez pro-
gram akcji, które przeprowadziliśmy (rysunek 2.9). Działanie tych funkcji
jest identyczne jak w większości aplikacji systemu Windows, np. edytorach
tekstu czy arkuszach kalkulacyjnych.

Rysunek 2.9. Lista ostatnio wykonanych operacji

• Cut, Copy, Paste - wycinanie, kopiowanie do schowka i wklejanie obiektów
- te polecenia również działają analogicznie jak ich odpowiedniki w innych
programach.

• Keys - grupa funkcji związanych z edycją animacji. Pozwalają one na za-
rządzanie kluczami animacji, czyli opisem ruchu w animowanych scenach.

• Delete, Delete by Type, Delete All by Type - polecenia do usuwania obiek-
tów lub ich atrybutów, takich jak historia edycji czy ścieżki animacji. Po-
leceniem Delete usuwamy obiekt ze sceny, zaś Delete by Type i Delete All
by Type pozwala usunąć wybrane atrybuty odpowiednio zaznaczonych lub
wszystkich obiektów sceny.

• Narzędzia zaznaczania (w ich nazwach występuje słowo Select) - to grupa
funkcji związanych z zaznaczaniem (selekcjonowaniem) obiektów w scenie.
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Z przykładami ich działania można zapoznać się w następnych rozdziałach
książki.

• Narzędzia klonowania (w ich nazwach występuje słowo Duplicate) - narzę-
dzia do tworzenia kopii obiektów, z możliwością uwzględnienia powiązań
właściwości kopii i oryginału oraz innych parametrów.

• Narzędzia grupowania (w ich nazwach występuje słowo Group) - funkcje
pozwalające na tworzenie tak zwanych grup obiektów, czyli zbiorów ele-
mentów, które można poddawać wspólnym transformacjom.

• Parent, Unparent - funkcje łączące i rozdzielające hierarchiczne powiązania
między obiektami, które umożliwiają przenoszenie transformacji z jednego
obiektu na drugi.

Polecenia znajdujące się w pozostałych menu zostaną zilustrowane w dalszej
części książki, przy omawianiu poszczególnych technik pracy z Mayą.

Listwa statusu (Status Line)

Listwa statusu, ulokowana tuż pod listwą menu, udostępnia najbardziej pod-
stawowe i jedne z najczęściej używanych narzędzi, z których korzystamy nieza-
leżnie od tego, jakiego rodzaju projekty mamy do zrealizowania. Poniżej, na
rysunku 2.10 kolejnymi numerami wyróżniono jej poszczególne sekcje zwią-
zane z różnymi grupami narzędzi.

Rysunek 2.10. Listwa statusu. Z uwagi na format druku książki, dla większej czy-
telności na rysunku listwa została podzielona na trzy części

Numery na rysunku 2.10 oznaczają kolejno:

1. Przycisk służący do ukrywania listwy. Mały czarny trójkąt z dwiema krop-
kowanymi liniami pozwala ukryć niepotrzebny w danej chwili element in-
terfejsu. O ile listwa statusu zazwyczaj jest dość przydatna w każdej sytu-
acji, można za pomocą identycznych przycisków powyłączać te panele lub
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listwy, z których nie planujemy korzystać (w naszym przypadku mogą to
być np. narzędzia animacyjne). Jeśli chcemy przywrócić wyświetlanie uk-
rytego panelu lub listwy, należy wybrać odpowiednią nazwę z menu Dis-
play > UI Elements.

2. Lista z układami menu. Po rozwinięciu listy możemy wybrać układ menu
najlepiej pasujący do zadań, nad którymi w danej chwili pracujemy. Do-
myślnie jest to układ z menu dotyczącymi animacji (Animation), jednak
na potrzeby ćwiczeń przedstawionych w dalszej części książki, najkorzys-
tniej jest wybrać układ z narzędziami do pracy nad modelowaniem obie-
któw ściankowych (Polygons).

3. Przycisk do zwijania oraz rozwijania danej sekcji narzędzi na listwie. Pio-
nowa czarna kreska z prostokątem pozwala ukryć sekcję ikon znajdującą
się bezpośrednio na prawo od niej - po zwinięciu widnieje na niej kształt
trójkąta. Kliknięcie trójkąta rozwija daną sekcję narzędzi z powrotem. Uk-
rycie niektórych sekcji narzędzi na listwie statusu może być przydatne, gdy
ze względu na rozdzielczość ekranu nie wszystkie sekcje mieszczą się nam
w oknie programu.

4. Sekcja operacji plikowych - ikony te są odpowiednikami najczęściej uży-
wanych poleceń z menu File, czyli tworzenia nowej sceny, otwierania sceny
i zapisywania jej na dysku.

5. Sekcja maski zaznaczania. Z rozwijanej listy możemy wybrać ograniczenie
możliwości zaznaczania niektórych obiektów, co przydaje się w bardziej
skomplikowanych scenach. W przypadku przykładów z tej książki nie ma
konieczności dokonywania żadnych zmian w tym polu.

6. Sekcja dodatkowych filtrów zaznaczania. Pozwala wybrać jakie struktury
w scenie chcielibyśmy zaznaczać. Tutaj również chwilowo nie ma potrzeby
dokonywania żadnych zmian.

7. Kolejna sekcja filtrów zaznaczania. Jej zawartość jest zależna od wyboru
maski zaznaczania (pkt 5).

8. Sekcja narzędzi przyciągania. Ikony z magnesami pozwalają włączyć przy-
ciąganie kursora do określonych punktów w przestrzeni (np. węzłów siatki
konstrukcyjnej), co umożliwia precyzyjne rozmieszczanie obiektów.

9. Sekcja kanałów i historii. Dwie pierwsze ikony w tej sekcji - ze strzałkami -
służą do zaznaczania kanałów wejściowych i wyjściowych wybranego obie-
ktu (tematem tym nie będziemy się zajmować w niniejszej książce), nato-
miast trzecia ikona - kartka z zegarem - pozwala włączać i wyłączać zapisy-
wanie historii obiektu. Gdy jest włączona, operacje wykonywane na obiek-
cie zapisywane są w sposób umożliwiający późniejszą modyfikację ich pa-
rametrów. Zwiększa to zapotrzebowanie na pamięć operacyjną oraz obję-
tość sceny na dysku, ale w niektórych sytuacjach ułatwia edycję obiektów.
Wyłączenie zapisu historii może przyspieszyć pracę orz wyeliminować mo-
żliwość powstawania pewnych błędów związanych z edycją historii, lecz
uniemożliwia powrót do wcześniejszego stanu obiektu. Należy podkreślić,
że poruszanie się w obrębie historii obiektu nie jest tożsame z korzystaniem
z edycyjnych poleceń Undo i Redo - historia jest zapisywana na dysku wraz
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ze sceną, podczas gdy polecenia Undo i Redo działają tylko do zakończenia
danej sesji z programem i obejmują wyłącznie pewien zbiór ostatnio wy-
konanych operacji w scenie.

Półka narzędziowa (Shelf)

Poniżej listwy statusu znajduje się półka narzędziowa. Jest to panel wyświe-
tlający szereg ikon, dających bezpośredni dostęp do wybranych funkcji z danej
kategorii narzędzi. Wyboru kategorii dokonujemy klikając zakładkę na górze
półki narzędziowej (rysunek 2.11). Półkę można konfigurować, dodając do niej
dowolne polecenia z menu - w tym celu po wybraniu odpowiadającej nam za-
kładki, na której chcemy umieścić skrót do danego polecenia, należy wybrać
interesującą nas funkcję z górnej listwy menu, trzymając wciśnięte klawisze
Ctrl+Shift. Wybrane przez nas polecenie zostanie dodane na końcu półki w po-
staci przypisanej mu ikony.

Rysunek 2.11. Półka narzędziowa z wybraną zakładką Polygons

Ikony z półki można też usuwać, przeciągając je środkowym klawiszem myszy
na ikonę kosza na śmieci, znajdującą się na końcu po prawej stronie półki.

Narzędzia podręczne (Tool Box)

Po lewej stronie ekranu znajduje się pasek z narzędziami podręcznymi, po-
dzielonymi na dwie grupy (rysunek 2.12).

Rysunek 2.12. Narzędzia podręczne (Tool Box)

Pierwsza grupa to najbardziej podstawowe narzędzia do pracy z obiekta-
mi 3D, pozwalające na ich zaznaczanie i transformowanie (przesunięcie, obrót,
skalowanie). W drugiej grupie umieszczono ikony skrótów do funkcji związa-
nych z zarządzaniem oknami widokowymi sceny. Dzięki tym ikonom możemy
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Rysunek 2.13. Zamiast domyślnego układu z jednym oknem widoku perspektywi-
cznego można włączyć podgląd sceny w rzutach izometrycznych

Rysunek 2.14. Panel Outliner po lewej stronie ekranu wyświetla listę wszystkich
obiektów w scenie i ułatwia ich zaznaczanie
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powiększyć wybrane okno widokowe na cały ekran lub włączyć jeden z najczę-
ściej używanych układów okien, ułatwiających prace nad różnymi aspektami
projektów (rysunki 2.13-2.14). Układ okien można dodatkowo zmodyfikować,
klikając ikonę z czarnym trójkątem w panelu narzędzi podręcznych odpowia-
dającą danemu widokowi - z listy, która zostanie wyświetlona na ekranie, moż-
na wtedy wybrać panel lub narzędzie, którego okno chcemy umieścić w danym
miejscu interfejsu.

Suwak czasu (Time Slider) i suwak zakresów (Range Slider)

Dwa paski ulokowane tuż pod oknem widoku sceny zawierają narzędzia do
sterowania animacją, a korzystamy z nich tylko wtedy, gdy w scenie znajdują
się animowane obiekty. Ponieważ w niniejszej książce nie będziemy zajmować
się tematem animacji, można ukryć obydwa te paski, klikając ich uchwyty po
lewej stronie ekranu.

Linia poleceń (Command Line)

Pasek z napisem MEL lub Python na dole ekranu zawiera pola służące do
wpisywania poleceń w językach skryptowych, którymi możemy programować
i automatyzować różne operacje wykonywane przez Mayę. W niniejszej książce
nie będziemy poruszać tematów dotyczących tych języków, dlatego ten pasek
również można ukryć.

Linia pomocy (Help Line)

Na samym dole ekranu widnieje szary pasek, na którym program wyświetla
podpowiedzi dotyczące aktualnie wybranego narzędzia lub funkcji. W przypa-
dku gdy po wybraniu jakiejś funkcji mamy wątpliwości, jakiej następnej czyn-
ności program od nas oczekuje, należy zerknąć właśnie na ten pasek.

Narzędzia do sterowania oknami widokowymi

Ponad oknem widoku sceny znajduje się pasek z kilkoma menu i dużą liczbą
ikon służących do zmiany sposobu wyświetlania obiektów w oknie widokowym.
Z tych narzędzi najczęściej wykorzystywanymi na potrzeby tematów omawia-
nych w niniejszej książce są ikony przedstawione na rysunku 2.15.

Rysunek 2.15. Ikony zmieniające sposób renderowania sceny w oknie widokowym
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Rysunek 2.16. Różne tryby wyświetlania sceny - teksturowany (klawisz 6), cienio-
wany z podglądem krawędzi i szkieletowy (klawisz 4)
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Ikony zaprezentowane na rysunku 2.15 określają sposób, w jaki wyświet-
lane są obiekty znajdujące się w scenie. Włączając i wyłączając te ikony (lub
używając odpowiadających im poleceń z listwy menu tuż ponad nimi), decy-
dujemy o tym, czy obiekty będą renderowane w sposób uwzględniający oświe-
tlenie, cieniowanie, wyświetlanie krawędzi siatki, tekstur itd. (rysunek 2.16).
Warto też zapamiętać, że skróty klawiszowe przełączające pomiędzy widokiem
szkieletowym (widoczne wyłącznie krawędzie siatek), cieniowanym (widoczne
powierzchnie ścianek) oraz teksturowanym (z uwzględnieniem materiałów na-
łożonych na obiekt) to odpowiednio klawisze 4, 5 oraz 6. Większość rysunków
przedstawionych w tej książce powstała w jednym z tych trybów wyświetlania
sceny.

Główne okno widokowe

W centralnej części ekranu znajduje się główne okno widokowe, przedstawia-
jące zawartość sceny. Jest to miejsce, w którym wykonujemy najwięcej operacji
i w którym wizualizowane są efekty użycia niemal wszystkich funkcji, który-
mi się posługujemy (rysunek 2.17). Do sprawnej pracy z oknem widokowym
konieczne jest opanowanie technik nawigacji po scenie 3D, które omawiamy
w końcowej części tego rozdziału.

Rysunek 2.17. W głównym oknie widokowym wykonujemy większość czynności
związanych z pracą nad scenami 3D
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Panel atrybutów, kanałów, warstw i ustawień narzędzi

Po prawej stronie ekranu zlokalizowany jest specjalny panel, w którym wyś-
wietlane są ustawienia i opcje dotyczące aktualnie zaznaczonego obiektu. Do-
myślnie wyświetlany jest panel kanałów, czyli lista parametrów obiektu i tak
zwanych kanałów, czyli struktur wpływających na aktualną postać obiektu
(rysunek 2.18). W dolnej części tego panelu może być dodatkowo wyświetlona
lista warstw służących do organizacji obiektów w scenie. Wygląd panelu okre-
ślają trzy ikony w jego lewym górnym rogu, które umożliwiają włączenie lub
wyłączenie wyświetlania kanałów lub warstw.

Rysunek 2.18. Panel kanałów z panelem warstw

Zamiast panelu kanałów i warstw możliwe jest wyświetlenie edytora atry-
butów (polecenie Display > UI Elements > Attribute Editor z górnej listwy
menu lub skrót Ctrl+A). W panelu atrybutów możemy zmieniać parametry
obiektów podobnie jak w panelu kanałów, ale są one pogrupowane w nieco inny
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sposób (w poziomo rozłożone zakładki) i uzyskujemy tu dostęp do niektórych
ustawień niedostępnych bezpośrednio w panelu kanałów (rysunek 2.19).

Rysunek 2.19. Edytor atrybutów umożliwia modyfikowanie dodatkowych ustawień
obiektów

Oprócz paneli kanałów i atrybutów po prawej stronie ekranu może znajdo-
wać się też panel z ustawieniami aktualnie wybranego narzędzia. Wyświetlamy
go poleceniem Display > UI Elements > Tool Settings. Domyślnie, gdy wybra-
ne jest narzędzie zaznaczania obiektów (Select), w panelu tym znajdą się opcje
i ustawienia tego narzędzia, przedstawione na rysunku 2.20. W przypadku gdy
wybierzemy inne narzędzie, zawartość tego panelu zmieni się automatycznie.

2.3 Nawigacja w scenie 3D

Praca z trójwymiarowymi obiektami i złożonymi scenami wymaga częstych
zmian widoku, dzięki czemu możliwe jest oglądanie modeli z różnych stron
i w różnych powiększeniach. Sprawne posługiwanie się funkcjami do nawiga-
cji jest kluczową umiejętnością w pracy przy modelowaniu obiektów. Dlatego
przed przystąpieniem do realizacji zadań omówionych w kolejnych rozdziałach
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Rysunek 2.20. Panel z ustawieniami narzędzia Select

książki konieczne jest przećwiczenie i zapamiętanie funkcji wymienionych po-
niżej.

Nawigacja za pomocą myszy i klawisza Alt

Najbardziej podstawowym i najszybszym sposobem poruszania się po scenie
jest wykorzystanie przycisków myszy i klawisza Alt. Trzymając wciśnięty kla-
wisz Alt i jeden z przycisków myszy podczas przeciągania kursorem w oknie
widokowym, wykonujemy operacje przesuwania, obracania i przybliżania lub
oddalania widoku sceny, zgodnie z następującymi skrótami:

• Alt+lewy przycisk myszy - obracanie widoku;
• Alt+prawy przycisk myszy - przybliżanie lub oddalanie widoku;
• Alt+środkowy przycisk myszy - przesuwanie widoku.

Dzięki tym operacjom możemy ustawić widok sceny w dowolny sposób, odpo-
wiedni do obserwowania efektów działania, aktualnie stosowanych narzędzi
(rysunek 2.21).

Nawigacja za pomocą sześciennego manipulatora

W prawym górnym rogu okna widokowego znajduje się szary sześcian z wid-
niejącymi na jego ściankach napisami Top, Front, Right itd., oznaczającymi
kierunki, z których można wyświetlić scenę. Klikając na ściankę z napisem
Top, uzyskamy widok pionowo z góry, po kliknięciu ścianki Right uzyskamy
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Rysunek 2.21. Różne widoki tej samej sceny ustawione za pomocą narzędzi do na-
wigacji
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widok z prawej strony itd. Możemy też klikać na krawędzie lub narożniki sze-
ścianu, aby uzyskać widok pod kątem odpowiadającym danej krawędzi lub na-
rożnikowi. Należy zwrócić uwagę, że stosując ten manipulator, zachowujemy
widok perspektywiczny, nie jest on więc odpowiednikiem włączenia okien z
rzutami izometrycznymi o analogicznych nazwach (Top, Front, Right itp.).

Szybkie przełączanie pomiędzy jednym a wieloma oknami
widokowymi

Krótkie naciśnięcie klawisza spacji w czasie gdy kursor znajduje się nad oknem
widokowym powoduje przełączenie pomiędzy układem z jednym oknem wi-
dokowym (widok perspektywiczny) a układem zawierającym cztery okna wi-
dokowe, z których trzy przedstawiają rzuty izometryczne, a czwarte jest po-
mniejszonym widokiem perspektywicznym. W dole każdego okna widokowego
widnieje jego nazwa (top, persp, front, side), będąca jednocześnie nazwą wir-
tualnej kamery, z której obiektywu pokazywana jest scena w danym oknie.

Rysunek 2.22. Układ czterech okien widokowych

Przełączanie pomiędzy tymi dwoma układami interfejsu jest bardzo po-
mocne w pracy nad scenami zawierającymi wiele obiektów lub w sytuacjach,
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gdy chcemy precyzyjnie modyfikować bądź też przemieszczać obiekty albo ich
komponenty. W widoku perspektywicznym przeprowadzenie drobnych zmian
w położeniu wierzchołków lub ścianek obiektów może być dość mało dokładne,
natomiast okna z rzutami izometrycznymi pozwalają na lepszą obserwację
efektów modyfikacji i unikanie błędów związanych ze zniekształceniem per-
spektywicznym.

Każde z tych czterech okien widokowych można powiększyć na cały ekran,
umieszczając nad nim kursor i naciskając krótko klawisz spacji.

Dłuższe przytrzymanie klawisza spacji służy do wyświetlenia specjalnego
menu kompasowego, które jest dość specyficzne dla programu Maya oraz od-
biega od standardów spotykanych w innych programach (rysunek 2.23). Menu
to duplikuje polecenia z górnej listwy menu oraz pewien zbiór najczęściej uży-
wanych funkcji programu. Dzięki temu menu nie musimy przesuwać kursora
w górę interfejsu w celu wybrania potrzebnej nam funkcji, jednak przyzwycza-
jenie się do korzystania z tego menu wymaga pewnego czasu.

Rysunek 2.23. Menu kompasowe dostępne po wciśnięciu i przytrzymaniu klawisza
spacji

Nawigacja za pomocą funkcji z półki narzędziowej lub menu View

Zamiast skrótów wykorzystujących myszkę i klawisz Alt, w oknie widokowym
możemy się poruszać, używając odpowiednich funkcji sterujących wirtualną
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kamerą ustawioną w scenie. Na rysunku 2.24 przedstawiono dwie możliwości
wywoływania tych funkcji - pierwsza to włączenie zakładki General na półce
narzędziowej i użycie jednej z ikon przedstawiających kamerę wraz z odpo-
wiednim manipulatorem (górna część rysunku). Druga metoda to rozwinięcie
podmenu View > Camera Tools i wybranie któregoś ze znajdujących się tam
narzędzi służących do manipulowania widokiem (dolna część rysunku).

Rysunek 2.24. Widokiem sceny można manipulować za pomocą funkcji z półki
narzędziowej lub menu kamery

Narzędzia te pozwalają na bardziej precyzyjne operowanie zawartością ok-
na widokowego, ale w ogromnej większości przypadków dużo bardziej prakty-
czne jest stosowanie skrótów klawiszowych i myszy.

Centrowanie widoku na obiektach

Bardzo przydatną funkcją podczas pracy z obiektami 3D jest możliwość au-
tomatycznego wycentrowania widoku na zaznaczonych obiektach lub na całej
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Rysunek 2.25. Naciśnięcie klawisza F gdy zaznaczony jest jakiś obiekt powoduje
wycentrowanie widoku względem tego obiektu

Rysunek 2.26. Jeśli żaden obiekt w scenie nie jest zaznaczony, po naciśnięciu kla-
wisza F kamera obejmuje kadrem całą scenę
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zawartości sceny. Służy do tego polecenie View > Frame Selection, wywoły-
wane klawiszem F. W zależności od tego, czy zaznaczone są jakieś obiekty
w scenie, widok dopasowywany jest albo do centrum zaznaczenia (rysunek
2.25), albo w taki sposób, by wypełnić okno wszystkimi obiektami znajdują-
cymi się w scenie (rysunek 2.26).



3

Podstawowe operacje edycyjne i praca ze

scenami 3D

3.1 Dodawanie obiektów do sceny

Aby dodać obiekty do sceny, musimy je utworzyć, korzystając z górnego menu
Create.

Rysunek 3.1. Menu Create

Korzystając z tego menu, możemy dodać do sceny obiekty takie jak siatki,
światła, kamery, itd. Menu Create zawiera w sobie większość obiektów, które
wykorzystujemy w pracy w programie Maya (rysunek 3.2), do najczęściej wy-
korzystywanych zaliczają się:
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Rysunek 3.2. Funkcje dostępne w menu Create

• NURBS Primitives (siatki tworzone na zasadzie krzywych nurbs);
• Polygon Primitives (podstawowe bryły tworzone z wielokątów);
• Subdivision Primitives (zagęszczone siatki tworzone z wielokątów);
• Lights (światła);
• Cameras (kamery).

Rysunek 3.3. Tworzenie prostopadłościanu
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Aby dodać obiekt do sceny, musimy wybrać jego nazwę menu Create, a nas-
tępnie kliknąć lewy przycisk myszy (w skrócie LPM). Chcąc na przykład stwo-
rzyć prostopadłościan, musimy wybrać Create > Polygon Primitives > Cube
(rysunek 3.3).

W tej chwili mamy włączony tryb tworzenia obiektu Cube i możemy wsta-
wić go do sceny przytrzymując lewy klawisz myszy, by stworzyć jego podstawę,
a następnie przeciągając góra-dół, określimy jego wysokość (rysunek 3.4a).

Rysunek 3.4. a) Prostopadłościan dodany do sceny

Warto też zaznaczyć, iż w starszych wersjach pakietu Maya obiekty zawsze

były tworzone w środku układu współrzędnych, tak więc po wybraniu polece-
nia Create > Polygon Primitives > Cube nasz sześcian pojawiał się w punkcie
0,0,0 układu X,Y,Z. W nowszych wersjach Mayi można tworzyć obiekt w do-
wolnym miejscu sceny. Sposób tworzenia obiektów zmieniamy, zaznaczając lub
odznaczając opcję Interactive Creation na samym dole menu Create.

Jeżeli przed stworzeniem sześcianu chcemy dokładnie określić jego wyso-
kość, szerokość, głębię czy też liczbę podziałów ścianek na segmenty (subdivi-
sions), musimy kliknąć na mały kwadracik znajdujący się po prawej stronie
słowa Cube w menu (rysunek 3.4b).

W oknie dialogowym z opcjami prostopadłościanu można też określić mię-
dzy innymi pożądane przez nas wymiary jak również sposób mapowania tek-
stury na obiekcie. Następnie zaś klikając na przycisk Create, tworzymy sze-
ścian (rysunek 3.5).

Po stworzeniu obiektu możemy poddawać go dalszej edycji, czyli zmieniać
jego właściwości. Korzystając z listy z historią operacji w bocznym panelu ka-
nałów po prawej stronie ekranu (sekcja Inputs, wyróżniona ramką na rysunku
3.6), można zmienić wysokość, szerokość, głębokość sześcianu oraz liczbę po-
działów (subdivisions) wysokości, szerokości, głębokości stworzonej przez nas
bryły (rysunek 3.6). Jeśli panel kanałów nie jest widoczny na ekranie tak
jak na rysunku 3.6, należy włączyć go pierwszą ikoną w górnej części panelu
bocznego.
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Rysunek 3.4. b) Klikając ikonę obok nazwy polecenia, możemy ustawić jego opcje

Rysunek 3.5. Okno dialogowe z opcjami tworzenia prostopadłościanu
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Rysunek 3.6. Zmiany właściwości obiektu dokonane za pomocą menu historii po
prawej stronie erkanu

3.1.1 Kopiowanie, wycinanie i wklejanie obiektów

Kopiowanie stworzonych przez użytkownika obiektów można dokonać co naj-
mniej na kilka sposobów. Podstawowe operacje edycyjne wykonujemy w Mayi
podobnie jak w większości aplikacji, czyli poprzez popularne skróty typu: Cut/
Copy/Paste itd. W odróżnieniu na przykład od edytora tekstu, nie operujemy
tu na słowach, lecz na bryłach geometrycznych, materiałach, teksturach itd.

Wszystkie operacje edycyjne znajdziemy w górnym menu Edit (por. rysu-
nek 3.7).

• Cut (Ctrl+X) - wycina oznaczony obiekt ze sceny, aby z powrotem wstawić
do niej wycięty obiekt, należy użyć funkcji Paste,

• Copy (Ctrl+C) - kopiuje zaznaczony obiekt, aby wkleić go ponownie do
sceny należy użyć funkcji Paste,

• Paste (Ctrl+V) - wkleja wcześniej skopiowany lub wycięty obiekt do sceny.

Warto pamiętać, iż opcji kopiowania możemy używać bez problemu pomiędzy
kilkoma otwartymi równocześnie oknami programu Maya - wtedy z jednej
sceny kopiujemy dany obiekt (razem z jego wszystkimi właściwościami jak
materiały, transformacje, współrzędne mapowania itd.) i wklejamy do nowej
sceny w drugim oknie. Opcja ta jest bardzo użyteczna, szczególnie jeśli pra-
cujemy na dużych scenach ze znaczną liczbą obiektów i chcemy uniknąć eks-
portowania i importowania plików, co z reguły pochłania zdecydowanie więcej
czasu niż kopiowanie.
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Rysunek 3.7. Menu Edit

3.1.2 Usuwanie obiektów

Jedną z najczęściej używanych funkcji edycyjnych podczas pracy w Mayi jest
usuwanie. Niejednokrotnie tworzymy w scenie nowe obiekty, które później mu-
simy z różnych względów usunąć w całości lub poszczególne ich fragmenty, cza-
sem też usuwamy informacje o historii obiektu, która niepotrzebnie zajmuje
pamięć operacyjną i dyskową. Poniżej wymieniono różne funkcje usuwania da-
nych w pakiecie Maya:

• Delete (klawisz Delete) - klasyczna funkcja usuwania obiektów, wartości
numerycznych itd.

• Delete by Type - usuwa określone rodzaje danych z obiektu, np. historię
operacji wykonanych na obiekcie.
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Rysunek 3.8. a) Kopiowanie obiektu ze Sceny#1 przy użyciu skrótu klawiszowego
Ctrl+C

Rysunek 3.8. b) Wklejanie obiektu do Sceny#2 przy użyciu skrótu klawiszowego
Ctrl+V
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• Delete All by Type - usuwa wszystkie dane określonego typu, np. historię
operacji dla wszystkich obiektów.

Operacji usuwania dokonujemy na wcześniej wyselekcjonowanych obiektach,
czyli mówiąc inaczej, musimy najpierw zaznaczyć te obiekty, klikając na nie -
kolor zaznaczenia w Mayi to kolor zielony.

3.1.3 Zaznaczanie obiektów

Kolejną podstawową grupą narzędzi, z której najczęściej korzystają użytkow-
nicy każdego oprogramowania 3D, są funkcje zaznaczania (selekcji). Korzy-
stając z funkcji selekcjonowania, możemy wybrać do dalszej edycji bryły jak
i ich elementy składowe - wierzchołki, krawędzie oraz ścianki. Wszystkie funk-
cje selekcjonowania znajdziemy w menu Edit lub w panelu narzędziowym po
lewej stronie okna roboczego (rysunek 3.9).

Rysunek 3.9. Najważniejsze narzędzia selekcji

3.1.4 Podręczne narzędzia do zaznaczania obiektów

• Selection Tool - służy do standardowego selekcjonowania obiektów i wierz-
chołków, aby zacząć selekcjonowanie, musimy kliknąć LPM na obiekcie;
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Rysunek 3.10. Podręczne funkcje do zaznaczania w bocznym panelu narzędziowym

• Lasso Tool - pozwala selekcjonować jeden lub więcej obiektów w oparciu
o wyznaczony obszar ekranu - cienka przerywana linia obrazuje obszar se-
lekcji, aby zacząć selekcjonowanie, musimy przytrzymać LPM;

Rysunek 3.11. Selekcja za pomocą narzędzia Lasso (po prawej stronie okno wła-
ściwości tego narzędzia)

• Paint Selection Tool - pozwala selekcjonować jeden lub więcej wierzchoł-
ków, malując ręcznie selekcjonowany obszar po powierzchni obiektu, aby
zacząć selekcjonowanie, musimy przytrzymać LPM.

Wskazówka: Podwójne kliknięcie na ikonie danego narzędzia selekcji po
lewej stronie ekranu spowoduje otwarcie okna właściwości tego narzędzia.
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Rysunek 3.12. Obiekty zaznaczone narzędziem Lasso

Rysunek 3.13. Selekcjonowanie wierzchołków obiektu za pomocą narzędzia Paint
Selection (po prawej stronie okno właściwości tego narzędzia)

3.1.5 Funkcje do grupowego zaznaczania obiektów

W menu Edit znajduje się pewna grupa funkcji służących do operowania na
zaznaczeniach większej liczby obiektów (rysunek 3.15):

• Select All - selekcjonuje wszystkie obiekty w scenie;
• Deselection - odznacza wcześniej zaznaczone obiekty;
• Select Hierarchy - selekcja obiektów przez hierarchię;
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Rysunek 3.14. Wyselekcjonowanie kilku obszarów obiektu za pomocą Paint Selec-
tion

Rysunek 3.15. Menu Selection
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• Invert Selection - selekcja przez odwrócenie bieżącego zaznaczenia;
• Select All by Type - selekcja wszystkich obiektów w scenie określonego ty-

pu, np. wszystkich kości lub siatek;
• Quick Select Sets - szybka selekcja zestawów obiektów (zestawy muszą być

wcześniej zdefiniowane, aby mogły zostać wybrane).

3.1.6 Duplikowanie obiektów

Duplikacja służy do powielania obiektów w obrębie tej samej sceny z opcjo-
nalnym transformowaniem każdego kopiowanego obiektu. Wszystkie operacje
związane z duplikacją znajdziemy w górnym menu Edit (rysunek 3.16).

Rysunek 3.16. Menu Duplicate

• Duplicate (Ctlr+d) - duplikacja zaznaczonych obiektów;
• Duplicate Special (Ctrl+D) - duplikacja zaznaczonych obiektów razem

z określonymi atrybutami;
• Duplicate with Transform (D) - duplikacja zaznaczonych obiektów połą-

czona z transformacją;
• Transfer Attribute Values - kopiowanie atrybutów z jednego obiektu na

drugi.
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Aby dokonać podstawowej duplikacji (Duplicate), musimy wyselekcjono-
wać obiekt i nacisnąć Ctrl+d, a duplikat obiektu pojawi się dokładnie w tym
samym miejscu co oryginał i zostanie automatycznie wyselekcjonowany (ry-
sunek 3.17).

Rysunek 3.17. Wyselekcjonowany obiekt (po lewej) i jego duplikat skopiowany za
pomocą skrótu Ctrl+d (po prawej)

Duplicate Special - funkcja ta daje nam możliwość duplikacji wraz z atry-
butami przesunięcia, obrotu oraz skali. Możemy również wybrać, w jakiej ilości
chcemy duplikować obiekt, czy chcemy, aby duplikowany obiekt był zależną in-
stancją czy niezależną kopią itd. Do okna z ustawieniami duplikacji możemy
dostać się, klikając na mały kwadracik znajdujący się tuż obok komendy Du-
plicate Special (rysunek 3.18).

Rysunek 3.18. Menu Duplicate Special
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Poniższy przykład ilustruje jak duże możliwości w duplikowaniu obiektów
daje nam funkcja Duplicate Special:

• Zaznaczamy dowolny obiekt w scenie, otwieramy okno Duplicate Special
Options, w nim zaznaczamy, aby obiekt był skopiowany 7 razy (Number of
copies =7 ), każda kopia była przesunięta o 7 jednostek w osi Z względem
poprzedniej (Translate X=0,Y=0, Z=7 ) oraz aby każdy kopiowany obiekt
był obrócony o 45 stopni względem poprzedniego i dodatkowo, aby każda
kopia był instancją (rysunek 3.19).

Rysunek 3.19. Okno Duplicate Special Options wraz z ustawieniami duplikowania
obiektów

• Po naciśnięciu przycisku Apply w menu nasz obiekt zostanie skopiowany,
a kopie będą wyselekcjonowane (rysunek 3.20).

Rysunek 3.20. Duplikacja i automatyczna selekcja
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• Ponieważ przy kopiowaniu określiliśmy, iż obiekty duplikowane mają być
instancjami (Instance ) oryginału, to teraz wszelkie modyfikacje będą au-
tomatycznie przenoszone z oryginału na kopie. Na rysunku 3.21 widzimy
selekcję wierzchołków, która jest duplikowana z oryginału na instancje.

Rysunek 3.21. Edycja oryginalnego obiektu jest przenoszona na instancje

• Na rysunku 3.22 widoczne jest, iż zmiana kształtu oryginalnego obiektu
została przeniesiona na instancje, czyli wszelkie edycje siatek, tekstur lub
materiałów zostają automatycznie odwzorowane we wszystkich kopiach.

Rysunek 3.22. Operacje z oryginału przeniesione na instancje

Praca na instancjach daje dużą swobodę w procesie kreacji - załóżmy, że
tworzymy wizualizację greckiej świątyni, np. Akropolu. Mamy w scenie kolu-
mnadę w liczbie ponad 100 obiektów, nagle zachodzi potrzeba przesunięcia
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bazy kolumny o pół metra w dół - jeśli pracujemy na instancjach, to wystarczy
że zmienimy oryginał, zaś pozostałe 99 kolumn przejmie jego deformacje, co
pozwoli szybko i sprawnie wprowadzać dowolne poprawki. Jeśli skopiowaliśmy
standardowo kolumny (używając funkcji Copy), to konieczne byłoby ręczne
modyfikowanie 99 kolumn lub kopiowanie zmodyfikowanej kolumny na nowo,
co niepotrzebnie wydłużyłoby naszą pracę.

Duplicate with Transform - to duplikacja obiektu wraz z jego wszystkimi
transformacjami: pozycją, obrotem i skalą. Zilustruje to poniższy przykład:

• Po duplikacji obiektu (Shift+D, D lub polecenie z górnego menu Edit)
zmieniamy jego skalę, obrót i pozycje. Widzimy, iż nasze zmiany są rejes-
trowane w panelu po prawej stronie ekranu (rysunek 3.23).

Rysunek 3.23. Duplicate with Transform

• Teraz po kolejnym zduplikowaniu obiektu (Shift+D), każda następna du-
plikowana kopia będzie automatycznie obrócona, przesunięta i przeskalo-
wana względem swojej poprzedniej kopii. Co warto nadmienić, duplikowa-
ne kopie nie są instancjami, w związku z czym nie przejmują modyfikacji
siatki z oryginału, a jedynie dziedziczą skalę, przesunięcie i obrót z pop-
rzedniego duplikatu.

Grupowanie obiektów

Grupowanie to łączenie ze sobą obiektów w tak zwane grupy transformacji -
pozwala selekcjonować i transformować zbiory obiektów tak jak pojedynczy
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Rysunek 3.24. Ciąg duplikatów utworzony funkcją Duplicate with Transform

obiekt. Grupowania używamy najczęściej w sytuacji, kiedy w scenie chcemy
zaznaczyć i przemieścić większą liczbę obiektów z jednego miejsca w drugie,
ale nie chcemy scalać tych obiektów w pojedynczą siatkę. Co ważne, po póź-
niejszym rozdzieleniu grupy wszystkie nazwy obiektów, unikane transformacje
itd. pozostają zachowane. Aby wykonać operację grupowania, musimy zaz-
naczyć obiekty, a następnie wybrać z górnego menu Edit > Group, wtedy
to zaznaczone obiekty zostaną złączone w jedną grupę (rysunek 3.25).

Rysunek 3.25. Grupowanie obiektów
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Aby rozdzielić grupę obiektów, należy użyć funkcji Edit > Ungroup albo
kliknąć na dowolny obiekt, który nie był zgrupowany, wtedy pozostałe obiekty
rozłączą się automatycznie.

W oknie z ustawieniami grupowania możemy również określić opcje układu
współrzędnych grupy i hierarchii (rysunek 3.26):

• Group under: Parent - grupowanie obiekty będą w hierarchii zawsze jedną
podgrupą;

• Group under: World - grupowanie obiekty będą w hierarchii zawsze nową
grupą;

• Group pivot: Center - środek transformacji zgrupowanych obiektów będzie
umiejscowiony w środku grupy;

• Group pivot: Orgin - środek transformacji obiektów będzie umiejscowiony
w środku układu współrzędnych świata;

• Preserve position - zachowuje lub modyfikuję pozycje obiektów względem
osi świata.

Rysunek 3.26. Grupowanie obiektów
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Modelowanie prostych obiektów w oparciu

o predefiniowane bryły geometryczne

Wstęp

Najbardziej podstawową metodą modelowania jest wykorzystanie dostępnych
w Mayi brył parametrycznych, z których można składać różnego rodzaju obie-
kty. Zanim sięgniemy po bardziej zaawansowane narzędzia, warto przyjrzeć się
możliwościom płynącym z dostępnych w programie predefiniowanych siatek
o różnych kształtach.

4.1 Bryły podstawowe

Wszystkie niezbędne bryły podstawowe, z których będziemy korzystać, znaj-
dziemy w menu Create > Polygon Primitives (rysunek 4.1). Każdą z tych brył,
po wybraniu odpowiedniego polecenia w menu Create, tworzymy, przeciągając
(zazwyczaj kilkakrotnie) w oknie widokowym programu, aby zdefiniować po-
szczególne wymiary danej siatki.

W swoich podstawowych formach bryły Polygon Primitives wyglądają jak
na rysunkach 4.2-4.4.

Warto nadmienić, iż mały czarny kwadracik przy nazwach obiektów to jest
skrót do okna z opcjami bryły, klikając na niego, możemy jeszcze przed stwo-
rzeniem obiektu określić z ilu ścianek ma się składać lub ile ma mieć podziałów
w pionie i poziomie, jakie mają być rozmiary itd. Parametry te są różne dla
poszczególnych obiektów, na przykład dla sfery (obiektu Sphere) zestaw dos-
tępnych atrybutów widoczny jest na rysunku 4.5b.

4.1.1 Przykłady modeli tworzonych w oparciu o bryły podstawowe

Tworząc kilka brył podstawowych oraz odpowiednio dobierając ich parametry,
możemy utworzyć wiele różnego rodzaju kombinacji dających w rezultacie zło-
żone modele obiektów. Poniżej przedstawiamy przykłady takich modeli.
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Rysunek 4.1. Menu Create > Polygon Primitives

Rysunek 4.2. Od lewej - Sphere; Cube; Cylinder; Cone; Plane
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Rysunek 4.3. Od lewej - Torus; Prism; Piramid; Pipe

Rysunek 4.4. Od lewej - Helix; Soccer Ball; Platonic Solids

Rysunek 4.5. a) Skróty do okna z opcjami obiektów b) Opcje tworzenia obiektu
Sphere
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Rysunek 4.6. Model beczki powstały z połączenia brył Torus, Cylinder i Sphere

Rysunek 4.7. Model latarni powstały z połączenia brył Torus, Cylinder, Sphere
i Cone
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Rysunek 4.8. Modele kolumn powstałe z połączenia brył Torus, Cylinder, Cube
i Platonic Solids. Trzecia kolumna wykorzystuje bryłę Helix jako trzon

Rysunek 4.9. Model portalu w stylu rzymskim zbudowany z brył Cube, Piramid,
Torus, Plane, Cylinder oraz Prism w trójkątnym zwieńczeniu tympanonu
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Rysunek 4.10. Model portalu w stylu romańskim zbudowany z brył Pipe i Cube

Rysunek 4.11. Model stolika oraz krzeseł z brył Cube, na blacie stołu znajdują
się gazety wymodelowane z brył typu Plane oraz kości z brył Platonic Solid. Futu-
rystyczna rzeźba znajdująca się w centrum zbudowana jest z brył Pipe, Soccer Ball,
Cone oraz Helix
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Rysunek 4.12. Model Okna zbudowany z brył Cube, Torus, Cylinder i Plane

4.2 Deformacje

Deformacje są operacjami, które przeprowadzamy na bryłach w celu edycji ich
kształtu - wyginanie, skręcanie, zwężanie itp. Aby dostać się do menu defor-
macji, najpierw musimy przełączyć układ menu w tryb narzędzi animacyjnych
(rysunek 4.13), a następnie, korzystając z narzędzi znajdujących się w menu
Create Deformers, możemy deformować modele.

Rysunek 4.13. Układ menu Animation oraz menu Create Deformers
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4.2.1 Kratownica (Lattice)

Aby użyć deformacji bazującej na kratownicy, z górnego menu Create De-
formers wybieramy polecenie Lattice (rysunek 4.14). Ta deformacja stworzy
naokoło obiektu specjalną kratownicę w kształcie prostopadłościanu, która
odpowiada za odkształcanie obiektu. Podczas tworzenia kratownicy możemy
w oknie dialogowym z parametrami deformacji (rysunek 4.15) określić liczbę
podziałów kratownicy (Divisions) w osiach X, Y, Z. Ma to znaczący wpływ na
operacje deformacji, ponieważ w celu odkształcenia obiektu posługujemy się
węzłami kratownicy, które ulokowane są w wierzchołkach segmentów.

Rysunek 4.14. Wybór Lattice z górnego menu Create Deformers. Poniżej łuk pół-
kolisty, który będziemy deformować

Rysunek 4.15. Opcje deformacji Lattice
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Aby przeprowadzić deformację przykładowego obiektu, wykonaj następu-
jące czynności:

1. Zaznacz obiekt, a następnie wybierz deformację Lattice z górnego menu
Create Deformers. Powinieneś ujrzeć wokół obiektu kratownicę podobną
do tej z rysunku 4.16.

Rysunek 4.16. Kratownica deformacji Lattice utworzona wokół edytowanego obie-
ktu

2. Aby wejść w tryb deformacji, musimy przytrzymać prawy klawisz myszy
i z podręcznego menu wybrać Lattice Point - wtedy będziemy mogli zaz-
naczać i przesuwać punkty na kratownicy i tym samym deformować nasz
obiekt (rysunek 4.17).

Rysunek 4.17. Kratownica w trybie edycji węzłów kontrolnych (Lattice Point)
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3. Operując węzłami kontrolnymi (Lattice Point), możemy dowolnie defor-
mować obiekt. Spróbuj przesuwać, skalować i rozciągać punkty na krato-
wnicy, nadając modelowi pożądany kształt. W ten sposób możemy zmienić
całkowicie wygląd modelu (rysunki 4.18 i 4.19).

Rysunek 4.18. Model poddany deformacji przy użyciu kratownicy Lattice

Rysunek 4.19. Model poddany deformacji przy użyciu kratownicy Lattice w wi-
doku perspektywicznym

4. Jeśli chcemy zmienić liczbę podziałów kratownicy lub cofnąć się do stanu
sprzed deformacji, musimy udać się do menu Edit Deformers i w podmenu
Lattice wybrać polecenie Reset Lattice (cofa zmiany podziałów kratow-
nicy) lub Remove Lattice Tweaks (cofa edycję węzłów kontrolnych Lattice
Points).
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Rysunek 4.20. Funkcje Reset Lattice i Remove Lattice Tweaks pozwalają cofnąć
obiekt lub kratownicę do stanu sprzed deformacji

Poniższe rysunki przedstawiają inne przykłady deformacji opartych na kra-
townicach.

Dzięki kratownicy możemy między innymi: wyostrzyć kształt łuku półko-
listego (rysunek 4.21), możemy zmienić kształt trzonu kolumny, jak również
jej wysokość, szerokość, rozmiar całkowity itd. (rysunek 4.22).

Rysunek 4.21. Model poddany deformacji przy użyciu kratownicy Lattice
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Rysunek 4.22. Model poddany deformacji przy użyciu kratownicy Lattice

4.2.2 Deformacje nieliniowe (Nonlinear)

Nonlinear to grupa deformacji, która pozwala odkształcać bryły symetrycznie
lub asymetrycznie. Deformacje Nonlinear to sześć funkcji, z których każda de-
formuje modele w charakterystyczny dla siebie sposób (rysunek 4.23).

Rysunek 4.23. Menu deformacji Nonlinear
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Aby dokonać deformacji, musimy wpierw zaznaczyć obiekt, a następnie
wybrać odpowiednią funkcję z menu Nonlinear, np. Bend. Należy też pamię-
tać, iż po nałożeniu deformacji na obiekt możemy lub wręcz powinniśmy do-
konać edycji parametrów w panelu po prawej stronie ekranu.

Rysunek 4.24. Parametry deformacji Bend (wyróżnione ramką)

Wyginanie (Bend)

Bend to deformacja, która wygina modele siatek, bazując na łuku krzywej (ry-
sunek 4.24). W parametrach deformacji możemy określić wielkość okręgu wy-
znaczającego krzywiznę łuku, kąt zagięcia oraz górną i dolną granicę deforma-

Rysunek 4.25. Bend - obiekt pierwotny po lewej, przykład deformacji po prawej
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cji. Możemy także obracać, skalować i przemieszczać samą krzywą, która od-
kształca model. Najczęściej Bend używany jest do kształtowania łuków półko-
listych z wcześniej przygotowanych szczegółowych siatek.

Rozszerzanie (Flare)

Flare to deformacja odpowiedzialna za rozszerzanie obiektu w pionie i pozio-
mie. Podobnie jak w Bend, można tu obracać, skalować oraz przemieszczać sa-
mą krzywą Flare, która odkształca model. Flare używany jest na przykład do
kształtowania kopuł z wcześniej przygotowanych szczegółowych siatek.

Rysunek 4.26. Flare - oryginalny obiekt po lewej, przykład deformacji po prawej

Deformacja sinusoidalna (Sine)

Rysunek 4.27. Sine - po lewej pierwotny obiekt, przykłady deformacji po prawej
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Zgniatanie lub zwężanie (Squash)

Rysunek 4.28. Squash - po lewej stronie obiekt pierwotny, przykłady deformacji
po prawej

Skręcanie (Twist)

Rysunek 4.29. Twist - po lewej stronie obiekt pierwotny, przykłady deformacji po
prawej
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Rysunek 4.30. Twist, zbliżenia na szczegóły obiektu przed i po deformacji

Falowanie (Wave)

Wave to deformacja symulująca rozchodzenie się fal po tafli wody.

Rysunek 4.31. Wave - po lewej stronie obiekt pierwotny, przykładowa deformacja
po prawej

4.3 Zaawansowane transformacje

4.3.1 Środek transformacji obiektu (pivot point)

Środek transformacji (pivot point) to przypisany do każdego obiektu punkt
w przestrzeni 3D, który określa układ współrzędnych wszelkich transformacji
wykonywanych na modelu. Od położenia środka transformacji zależy to, w jaki
sposób obiekt jest przesuwany, skalowany lub obracany.

Podczas operacji grupowania obiektów środek transformacji lokowany jest
zawsze w środku globalnego układu współrzędnych sceny (0,0,0). Aby spraw-
dzić, gdzie znajduje się środek transformacji obiektu, należy zaznaczyć model
oraz nacisnąć jeden z klawiszy włączających transformacje (W - przesunięcie,
E - obrót, R - skalowanie), co wyświetli ikonę układu współrzędnych naszego
obiektu, charakterystyczną dla danego typu transformacji (rysunek 4.32 - 1).
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Jeśli chcemy zmienić ustawienie środka transformacji obiektu, naciskamy kla-
wisz INSERT (rysunek 4.32 - 2), a następnie korzystając z myszki, przemie-
szczamy układ współrzędnych w inne miejsce. Aby zakończyć operacje wci-
skamy powtórnie klawisz INSERT. Można również zaznaczyć model, a następ-
nie przytrzymać klawisz D, który włącza interaktywne przesuwanie środka
transformacji. Dodatkowo możemy również przyciągać środek transformacji
do określonych punktów w scenie (rysunek 4.32 - 3). Przytrzymując klawisze
X (przyciąganie do siatki konstrukcyjnej), C (przyciąganie do krawędzi), V
(przyciąganie do wierzchołków obiektów).

Rysunek 4.32. Wizualizacja środka transformacji (pivot point) w różnych trybach
pracy

4.3.2 Scalanie obiektów (Combine)

Scalanie to łączenie dwóch lub kilku obiektów ściankowych w jeden. W ten
sposób tworzymy nowy obiekt, któremu zostaje automatycznie nadana uni-
kalna nazwa. Topologia siatki połączonych obiektów pozostaje bez zmian. Aby
dokonywać swobodnej edycji modelu złożonego z kilku obiektów, dobrze jest je
wpierw scalić, czyli złączyć w jeden obiekt, który wygodniej jest edytować na
poziomie wierzchołków albo krawędzi. Aby dokonać operacji scalania, musimy
najpierw zaznaczyć dwa lub więcej obiektów, a następnie wybrać z górnego
menu polecenie Mesh > Combine (rysunek 4.33).

Rysunek 4.33. Polecenie (Mesh > Combine)
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Przykładowa operacja scalania obiektów wygląda następująco:

1. Zaznacz równocześnie dwa obiekty (lub większą liczbę) które chcesz scalić.
Po zaznaczeniu można zauważyć, że obiekty są od siebie niezależne, gdy
mają dwa osobne środki transformacji (rysunek 4.34).

2. Następnie wybierz z górnego menu polecenie Mesh > Combine.
3. Po wykonaniu polecenia Combine dwa obiekty stały się pojedynczą siatką

(rysunek 4.35).
4. Ponieważ operacja Combine umieszcza środek transformacji nowej siatki

w punkcie (0,0,0), dobrze jest wycentrować go, korzystając z polecenia Mo-
dify > Center Pivot (rysunek 4. 36).

5. Po wykonaniu powyższej operacji środek transformacji (pivot point) zos-
tanie wycentrowany względem nowego obiektu.

4.3.3 Rozdzielanie obiektów (Separate i Extract)

Separate - w każdej chwili możemy rozdzielić scalone obiekty na ich elementy
składowe. Aby tego dokonać, należy zaznaczyć obiekt i wybrać polecenie Mesh
> Separate. Musimy pamiętać, iż po operacji Separate każdy element stanie się
samodzielnym modelem, z własnym środkiem transformacji, nazwą, miejscem
w hierarchii obiektów itd.

Rysunek 4.34. Zaznaczone obiekty do scalenia, przy każdym widoczny jest jego
środek transformacji
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Rysunek 4.35. Obiekty scalone poleceniem Mesh > Combine

Rysunek 4.36. Polecenie Modify > Center Pivot
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Rysunek 4.37. Efekt centrowania środka transformacji

Extract - jeśli ze scalonego obiektu obiektu chcemy oddzielić zaznaczoną
ściankę lub kilka ścianek, pozostawiając oryginalny model bez zmian (czyli
jako połączenie kilku modeli), to musimy posłużyć się funkcją Extract - czyli
ekstrakcją. Aby wykonać operację ekstrakcji ścianek, musimy najpierw zazna-
czyć obiekt, następnie przejść do edycji ścianek (klawisz F11), zaznaczyć od-
powiednie ścianki i wybrać z górnego menu polecenie Mesh > Extract.

Rysunek 4.38. Polecenie Mesh > Extract

Klikając ikonkę sześcianu obok polecenia Extract, możemy określić prze-
sunięcie (Offset) odłączanych ścianek względem pierwotnej siatki. Jeśli pozo-
stawimy wartość parametru Offset na 0.00, ścianki pozostaną w początkowej
pozycji. Odłączona ścianka (ścianki) staje się automatycznie samodzielnym
obiektem w hierarchii i przyjmuje własną nazwę, środek transformacji itd.
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Rysunek 4.39. Opcje funkcji Extract

Rysunek 4.40. Operacja Extract krok po kroku
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4.3.4 Wyrównywanie obiektów (Align Objects)

Align Objects jest narzędziem służącym do wyrównywania modeli lub oriento-
wania ich względem określonej osi. Narzędzie to przydaje się najczęściej, gdy
chcemy uszeregować dużą grupę obiektów rozmieszczonych w różnych miej-
scach sceny lub na różnych wysokościach. By wykonać operację Align musimy
zaznaczyć grupę modeli, a następnie wybrać z górnego menu polecenie Mo-
dify > Snap Align Objects > Align Objects (rysunek 4.41). Zazwyczaj chcemy
ustawić dokładne opcje wyrównywania, więc najlepiej jest od razu kliknąć
ikonę sześcianu obok tego polecenia w menu (rysunek 4.42).

Rysunek 4.41. Polecenie Align Objects

W opcjach narzędzia Align (rysunek 4.42) możemy określić tryb wyrówny-
wania (Align Mode), czyli wyrównywanie do minimum, maksimum lub według
odległości. Opcje z grupy Align In określają osie wyrównywania (X, Y, Z).
Opcja Align to decyduje, czy wyrównywanie odbywa się względem środka za-
znaczonych obiektów (Selection average) czy ostatniego zaznaczonego obiektu
(Last selected objects).

Aby przyswoić sobie działanie narzędzia Align, prześledź poniższy przy-
kład.
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Rysunek 4.42. Opcje narzędzia Align Objects

1. Poniżej mamy zbiór chaotycznie rozmieszonych brył, które chcielibyśmy
uszeregować i wyrównać. Musimy je najpierw wszystkie zaznaczyć (rysu-
nek 4.43).

Rysunek 4.43. Zaznaczone obiekty do wyrównania

2. Jeśli w oknie opcji narzędzia Align Objects zaznaczymy World Y w polu
Align In i włączymy ikonę Min w polu Align mode, a następnie klikniemy
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przycisk Apply, to nasze obiekty zostaną wyrównane dolnymi krawędziami
w osi Y (rysunek 4.44).

Rysunek 4.44. Wyrównanie obiektów względem osi Y

3. Teraz jeśli włączymy World X oraz Dist i klikniemy Apply, to obiekty zo-
staną rozstawione równomiernie w określonym w osi X (rysunek 4.45)

Rysunek 4.45. Równomierne rozstawienie obiektów względem osi X
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4. Dodatkowo możemy zsunąć obiekty ze sobą krawędziami, używając funkcji
Stack w polu Align mode (rysunek 4.46).

Rysunek 4.46. Obiekty przysunięte do siebie wzdłuż osi X
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Modelowanie prostych obiektów ściankowych

5.1 Modelowanie ściankowe

Modelowanie ściankowe zwane też poly-modelingiem (słowo pochodzi z języka
angielskiego, “polygon” znaczy “wielokąt”) jest jedną z podstawowych technik
tworzenia trójwymiarowych obiektów w każdym programie 3D. W modelowa-
niu ściankowym sami określamy położenie każdego z wierzchołków siatki obie-
ktu, a tym samym, sami też definiujemy kształty modelu. Innymi słowy, ope-
rując na wierzchołkach, krawędziach i ściankach siatek, swobodnie edytujemy
wygląd obiektów. Modelowanie ściankowe jest bardzo popularne ze względu
na fakt, iż daje modelarzowi pełną kontrolę nad każdym aspektem obiektu
podczas procesu modelowania. Modele ściankowe dzielimy na dwie kategorie:

1) Low-poly - czyli obiekty o małej liczbie ścianek, przeznaczone zazwyczaj
do gier wideo, prezentacji internetowych lub symulacji fizycznych;

2) Hi-poly - czyli modele o dużej liczbie ścianek, gdzie najważniejszym wy-
znacznikiem jest jakość modelu i zwyczajowo jest on bardzo dokładny. Modele
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hi-poly wykorzystuje się najczęściej w przemyśle filmowym i reklamie, spec-
jalne zastosowania mają też w grach wideo.

Podstawą modelowania ściankowego jest umiejętne edytowanie obiektu po-
przez operacje na:

• wierzchołkach (ang. vertices)
• krawędziach (ang. edges)
• ściankach (ang. polygons)

Aby dokonać operacji edycyjnych na modelu ściankowym, musimy najpierw
zaznaczyć ten model, a potem przejść do edycji wierzchołków (klawisz F9),
krawędzi (klawisz F10) lub ścianek (klawisz F11) (rysunek 5.1). Jeśli chcemy
wrócić do trybu edycji obiektu jako całości, należy użyć klawisza F8. Odpo-
wiednikami tych skrótów klawiszowych są polecenia dostępne w menu podrę-
cznym, które otwieramy, klikając prawym klawiszem myszy na obiekcie - Ve-
rtex (edycja wierzchołków), Edge (edycja krawędzi), Face (edycja ścianek),
Object Mode (edycja obiektów jako całości).

Rysunek 5.1. Tryby edycji: wyselekcjonowanie obiektu (1), edycja wierzchołków
(2), edycja krawędzi (3), edycja ścianek (4)

W każdym z trybów edycji można przemieszczać, skalować i obracać od-
powiednio wierzchołki, krawędzie lub ścianki (tak samo jak transformujemy
całe obiekty) i tym samym modyfikować kształt modelu.

Trzymanie ścianek razem (Keep Faces Together)

Jedną z najważniejszych opcji przy modelowaniu ściankowym jest tzw. “trzy-
manie ścianek razem”. Opcja ta ma zasadnicze znaczenie przy wytłaczaniu,
które jest podstawową techniką modelowania ściankowego i włączenie lub wy-
łączenie jej wpływa na zachowanie wytłaczanych ścianek. Opcja Keep Faces
Together decyduje o tym, czy ścianki i krawędzie są interpretowane jako poje-



5.1 Modelowanie ściankowe 83

Rysunek 5.2. Edycja wierzchołków: (1) przemieszczanie, (2) skalowanie, (3) obra-
canie (3)

dyncza powierzchnia, czy też każda ścianka jest modyfikowana z osobna. Włą-
czyć lub wyłączyć trzymanie ścianek możemy używając polecenia Edit Mesh
> Keep Faces Together (rysunek 5.3). W zależności od potrzeb, podczas pracy
opcje tę raz się włącza, a innym razem wyłącza, co zależne jest od pożądanych
rezultatów w danym momencie edycji (rysunek 5.4).

Rysunek 5.3. Opcja Keep Faces Together (trzymanie ścianek razem lub osobno)

Na podstawie modelu portalu rzymskiego przedstawimy wszystkie najważ-
niejsze techniki modelowania ściankowego, takie jak wytłacznie, fazowanie,
przycinanie itd.

5.1.1 Wytłaczanie ścianek (Extrude)

Wytłaczanie polega na wyciągnięciu ścianek, krawędzi i wierzchołków w wy-
branym kierunku w przestrzeni. Podczas operacji wytłaczania powstają nowe
ścianki, tworzące połączenie pomiędzy położeniem początkowym oraz końco-
wym wytłaczanego elementu. W ten sposób, bryła zawsze pozostaje w zam-
kniętej formie. Wytłaczanie jest jednym z podstawowych i najczęściej wyko-
rzystywanych narzędzi przy modelowaniu low-poly jak i hi-poly. Aby wykonać
operacje wytłaczania, musimy z górnego menu wybrać Edit Mesh > Extrude.
Dodatkowo w opcjach wytłaczania, włączanych czarną ikoną sześcianu obok
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Rysunek 5.4. Trzymanie ścianek przy wytłaczaniu: z lewej włączone, z prawej wy-
łączone

polecenia Extrude, możemy ustawić liczbę podziałów nowych ścianek (Divis-
ions), przesunięcie (Offset) czy kąt wygładzania (Smoothing Angle).

Rysunek 5.5. Zaznaczenie ścianki do wytłoczenia

Na rysunku 5.5 widać, jak z obiektu typu Prism utworzono model trójkąt-
nego tympanonu. Następnie w trybie edycji ścianek (klawisz F11) zaznaczamy
ściankę, którą chcemy wytłoczyć i wybieramy polecenie Extrude. Wytłoczoną
ściankę można przeskalować, obrócić albo przesunąć, tworząc wypukłość lub
zagłębienie - dla ułatwienia pracy program w trakcie wytłaczania wyświetla
ikonę układu współrzędnych, pozwalającą od razu transformować zaznaczony
element (rysunek 5.6). Dla uzyskania bardziej skomplikowanych kształtów,
operacje wytłaczania często powtarza się wielokrotnie na tej samej ściance,
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tworząc coraz bardziej złożony przekrój bryły. Dla zachowania równomier-
nych odstępów pomiędzy krawędziami wytłoczeń, zamiast skalowania, często
lepiej wykorzystać parametr Offset w narzędziu Extrude. Tym samym z pro-
stych obiektów typu Prism czy Box możemy uzyskać skomplikowane kształty
przedstawione na rysunku 5.6.

Rysunek 5.6. Kilkukrotne wytłoczenie ścianki połączone ze zmianą parametru
Offset w opcjach wytłaczania pozwala na kształtowanie wnęk i wypukłości modelu

5.1.2 Fazowanie (Bevel)

Fazowanie to inaczej zaokrąglanie krawędzi poprzez dodanie segmentów siatki
wzdłuż fazowanego elementu. Funkcja fazowanie dostępna jest tylko i wyłącz-
nie w trybie edycji krawędzi. Podczas fazowania wybranych krawędzi program

Rysunek 5.7. Zaznaczenie krawędzi do fazowania
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automatycznie wygładza i zaokrągla model. Dzięki temu narzędziu możemy
zlikwidować ostre kanty, przez co model staje się ładniejszy i zazwyczaj bar-
dziej realistyczny. Aby wykonać operację fazowania, musimy zaznaczyć jedną
lub więcej krawędzi (rysunek 5.7) i wybrać polecenie Edit Mesh > Bevel (ry-
sunek 5.8). Dodatkowo w opcjach narzędzia możemy ustalić liczbę segmentów
zaokrąglenia (Segments), jego szerokość (Width) oraz przesunięcie (Offset type
i Offset space).

Rysunek 5.8. Krawędzie po operacji fazowania

5.1.3 Wypełnianie powierzchni (Fill Hole i Append to Polygon
Tool)

Zajmiemy się teraz utworzeniem łuku półkolistego, który w naszym portalu
będzie pełnił rolę zwieńczenia drzwi. Zacznijmy od utworzenia obiektu typu
Pipe (Create > Polygon Primitives > Pipe), którzy posłuży za bazę do dalszej
pracy. Następnie po przejściu do trybu edycji ścianek (F11) zaznaczmy dolną
połowę modelu (rysunek 5.9a) i usuńmy ją klawiszem Delete. W siatce poja-
wiły się otwory. Funkcja Fill Hole służy do wstawiania nowych ścianek w miej-
sce otworów w siatkach. Oznacza to, iż Fill Hole wypełni wybrany otwór lub
przestrzeń nowymi wielokątami. Operacje wypełniania możemy stosować glo-
balnie, dla całego obiektu lub też w wybranym miejscu - wtedy sami wyzna-
czymy powierzchnie, które mają zostać wypełnione nowymi ściankami. Aby
wykonać operacje wypełniania, zaznaczamy krawędzie, a następnie wybierzmy
polecenie Mesh > Fill Hole. W ten sposób otwory w obiekcie zostaną zabudo-
wane nowymi ściankami (rysunek 5.9b).

Podobną operacją, która także wypełnia puste przestrzenie w siatce, jest
Append to Polygon Tool. Efekt końcowy w obu przypadkach prowadzi do tego
samego, czyli zamykania otworów w modelach, ale różnica polega na tym, że
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Rysunek 5.9. a) Zaznaczanie ścianek obiektu Pipe do usunięcia

przy operacji Append ręcznie dobudowujemy ścianki, w czym pomaga nam
wskaźnik wypełnienia. Korzystając z funkcji Append, możemy połączyć dwie
krawędzie nie tylko w obrębie otworu. Aby wykonać operację wypełniania na-
rzędziem Append, zaznaczmy obiekt, a następnie wybierzmy polecenie Edit
Mesh > Append to Polygon Tool. Funkcja wymaga dokonania wypełnienia,
musimy zatem wskazać co najmniej dwie krawędze za pomocą kolejnych klik-
nięć. Po wybraniu tego polecenia (szare strzałki pokazują nam kierunek wypeł-
nienia). Operację zatwierdzamy klawiszem Enter (do cofania poszczególnych
etapów wypełniania służy klawisz Backspace). Dodatkowo w opcjach wypeł-
nienia możemy określić liczbę podziałów nowych ścianek na segmenty i sposób
ich mapowania.

5.1.4 Tworzenie ścianek (Create Polygon Tool)

Dzięki narzędziu Create Polygon możemy stworzyć ściankę opartą na dowol-
nej liczbie trójkątów. Narzędzie to daje nam dużą swobodę w tworzeniu no-
wych obiektów, często narzędziem tym posługujemy się, gdy chcemy zbudować
ściankę z otworem. W naszym modelu rzymskiego portalu będzie to ścianka za
łukiem półkolistym. Aby utworzyć nową ściankę, wybierz polecenie Mesh >
Create Polygon Tool i kolejnymi kliknięciami narysuj kształt powierzchni, wy-
znaczając jej kolejne wierzchołki (rysunek 5.12). Operację zatwierdzamy kla-
wiszem Enter (do cofania się w historii edycji podczas tworzenia służy klawisz
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Rysunek 5.9. b) Operacja Fill Hole: najpierw zaznaczamy krawędzie, a następnie
wypełniamy ścianki, efekt zapełnienia powierzchni nowymi ściankami widzimy na
dolnym łuku.
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Rysunek 5.10. Operacja Append to Polygon Tool, dobudowanie nowych ścianek
analogicznie jak w przypadku funkcji Fill Hole (u góry). Ścianki można później
wytłaczać narzędziem Extrude, dobudowując kolejne segmenty modelu (u dołu)

Rysunek 5.11. Operacja Append to Polygon Tool, specyficzne dobudowanie nowych
ścianek, możliwe dzięki połączeniu dwu przeciwstawnych krawędzi
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Backspace). Nową ściankę musimy wytłoczyć poleceniem Extrude i nowy frag-
ment modelu jest tym samym gotowy.

Rysunek 5.12. Nowa ścianka utworzona za pomocą narzędzia Create Polygon Tool

5.1.5 Przycinanie (Cut Faces Tool)

Narzędzie Cut służy do przecinania ścianek dodatkowymi krawędziami. Przy
operowaniu cięciami mamy pełną swobodę, gdyż możemy je wykonywać w do-
wolnym miejscu modelu. Warto też nadmienić, iż klasyczne cięcie typu Cut
dokonywane jest zawsze z jednego rzutu lub widoku kamery oraz że cięcie na-
stępuje zawsze w linii prostej (najczęściej cięć dokonujemy w kierunku werty-
kalnym lub horyzontalnym). Aby dokonać cięcia, musimy najpierw zaznaczyć
obiekt, który będziemy ciąć, a następnie wybrać polecenie Edit Mesh > Cut
Faces Tool - teraz możemy dokonać interaktywnego cięcia w linii prostej, do-
datkowo jeśli przytrzymamy klawisz Shift, to włączymy opcję obracania linii
cięcia co 22,5 stopnia, ułatwiającą cięcie pod ściśle określonymi kątami. Aby
zakończyć operacje cięcia, musimy wcisnąć klawisz Q (Quit - koniec operacji).
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Rysunek 5.13. Wytłaczanie nowej ścianki w celu nadania jej grubości

Teraz wykorzystamy narzędzie cięcia w naszym modelu rzymskiego portalu
i potniemy wcześniej utworzoną ściankę - chcemy w środku ściany, lekko powy-
żej drzwi, utworzyć lukę, która będzie miejscem np. na płaskorzeźbę albo tab-
licę pamiątkową. Na rysunku 5.14 możemy zobaczyć efekt cięcia ściany. Prze-
cinając model narzędziem Cut, powodujemy tworzenie nowych ścianek, które
można później wytłaczać (Extrude) lub też edytować w inny sposób (rysu-
nek 5.15).

5.1.6 Interaktywne cięcie (Split Polygon Tool)

Bardzo często wykorzystywanym narzędziem do cięcia jest tzn. interaktywne
cięcie. Różni się ono tym od klasycznego cięcia (Cut Face Tool), że tutaj dużo
dokładniej decydujemy o kierunku, kształcie oraz liczby cięć. Podczas ope-
racji interaktywnego cięcia mamy pełną kontrolę nad wykonywaną operacją,
niczym laserem przecinamy model wzdłuż, wszerz, zygzakiem lub liniami two-
rzącymi inne kształty.
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Rysunek 5.14. Ścianka przed (lewa strona) i po cięciu (prawa strona)

Rysunek 5.15. Przycięta i wytłoczona ścianka

Aby dokonać interaktywnego cięcia, musimy najpierw zaznaczyć obiekt,
który będziemy ciąć, a następnie wybrać polecenie Edit Mesh > Split Polygon
Tool - dodatkowo w opcjach narzędzia, możemy też określić liczbę wierzchoł-
ków (Division) wstawianą na krawędzi pomiędzy dwoma punktami cięcia. Kąt
wygładzania nowych ścianek (Smoothing angle) lub cięcie może biec do dowol-
nego punktu modelu albo będzie przyciągane do istniejących krawędzi (opcja
Split only from edges). Ważne jest, że interaktywnie możemy przecinać model
przechodząc z jednej ścianki do drugiej, jednak przy przecinaniu istniejących
krawędzi w ten sposób należy zachować dużą ostrożność w lokowaniu nowych
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wierzchołków, aby uniknąć postawania zbędnych ścianek o nieprawidłowej to-
pologii.

Musimy również pamiętać, iż ze względu na ograniczenia narzędzia Split,
obiekt należy wcześniej przygotować “pod cięcie”, inaczej nie będziemy w sta-
nie wyciąć poprawnego kształtu na pojedynczej ściance. Mówiąc najogólniej,
narzędzie Split często nie radzi sobie z wycinaniem skomplikowanych kształ-
tów na pojedynczej ściance, dlatego ściankę, w której chcemy wyciąć złożony
wzór, należy zazwyczaj najpierw przeciąć na równomierne segmenty, np. na-
rzędziem Cut (można też użyć do tego celu narzędzia Split).

Taka sytuacja właśnie ma miejsce w naszym modelu kolumny. Chcemy ją
nieco uszkodzić poprzez utworzenie efektu odłupania fragmentu modelu, naj-
pierw jednak musimy przygotować do tego ściankę, następnie dokonać cięć,
zaś na końcu wytłoczyć narzędziem Extrude (rysunki 5.16 i 5.17). Operacje
te można powtórzyć w innym miejscu modelu, lub na innej kopii kolumny
(rysunek 5.18).

Rysunek 5.16. Przygotowanie modelu do cięcia: 1 - pierwotny model, 2 - model
przygotowany do cięcia, 3 - wycinanie kształtu otworu

5.1.7 Wstawianie nowych krawędzi (Insert i Offset Edge Loop)

Dodawanie nowych krawędzi na ściankach lub pomiędzy istniejącymi już kra-
wędziami jest jedną z najczęściej wykorzystywanych technik w modelowaniu
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Rysunek 5.17. Zaznaczenie i wytłaczanie ścianek

Rysunek 5.18. Portal z uszkodzonymi kolumnami
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ściankowym. Często potrzebujemy dodać krawędzie, które będą oplatały mo-
del dookoła, a w ten sposób działają właśnie narzędzia Insert oraz Offset Edge
Loop. Oba funkcjonują bardzo podobnie, czyli dodają krawędzie do modelu
w określonym miejscu, z tą różnicą, iż Insert dodaje krawędzie wewnątrz zaz-
naczenia, a Offset na zewnątrz zaznaczenia.

Aby wykonać operacje dodawania krawędzi, musimy najpierw wybrać je-
dno z wcześniej wspomnianych narzędzi poleceniem Edit Mesh > Insert Edge
Loop lub Edit Mesh > Offset Edge Loop. Następnie przystępujemy do dodawa-
nia nowych krawędzi wskazując pożądane miejsca na już istniejących krawę-
dziach (rysunki 5.19 i 5.20). Warto tu wspomnieć, iż nowe krawędzie będą two-
rzyły pętle tylko na kwadratowych ściankach, gdy zaś ścieżka cięcia trafi na
trójkątną ściankę, tam nastąpi koniec cięcia. W opcjach narzędzi możemy rów-
nież ustalić odległości pomiędzy dodawanymi krawędziami.

Po wstawieniu nowego segmentu krawędzi można go przesunąć lub przes-
kalować, dodając nowe szczegóły do modelu (rysunek 5.21).

Rysunek 5.19. Segment wstawiony narzędziem Insert Edge Loop

5.1.8 Scalanie wierzchołków (Merge)

Scalanie wierzchołków pomaga w usuwaniu zbędnych otworów w siatkach oraz
daje dodatkowe możliwości kształtowania modeli. Dzięki scalaniu wierzchoł-
ków możemy zachowywać ciągłość siatki modelu (eliminowanie niepożądanych
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Rysunek 5.20. Nowe segmenty krawędzi dodane narzędziem Insert Edge Loop

Rysunek 5.21. Gzymsy ukształtowane techniką wstawiania i skalowania krawędzi
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szczelin i błędnie wstawionych ścianek lub krawędzi) i tym zamym uzyskiwać
poprawną topologię siatki. Scalanie jest operacją, która działa tylko i wyłącz-
nie na wierzchołkach, modyfikacji podlegają wtedy dwa lub więcej zaznaczone
wierzchołki lub całość obiektu.

Aby wykonać operację scalania, należy zaznaczyć wierzchołki a następnie
wybrać polecenie Edit Mesh > Merge. W opcjach narzędzia możemy też okre-
ślić próg dystansu, jaki ma być przy scalaniu (Threshold). Dystans ten odnosi
się do odległości pomiędzy zaznaczonymi wierzchołkami - gdy jest ona mniej-
sza od wartości Threshold, wierzchołki zostają scalone w jeden (rysunek 5.22).
Maya oferuję całą gamę narzędzi do scalania, które wykorzystujemy w zależ-
ności od potrzeb, jednak najbardziej typowe scalanie (Merge) jest najczęściej
wykorzystywanym spośród tych narzędzi.

Rysunek 5.22. Scalanie wierzchołków

5.2 Automatyczne mapowanie UV (Automatic Mapping)

Aby nałożyć na powierzchnię modelu ściankowego materiały z teksturami sy-
mulującymi na przykład drewno lub kamień, należy określić wspórzędne ma-
powania UV, czyli sposób rzutowania materiału na obiekt. Więcej informacji
na temat materiałów, tekstur i mapowania UV znajduje się w dwóch ostatnich
rozdziałach niniejszej książki.

Precyzyjne mapowanie współrzędnych UV często zajmuje dużo czasu i za-
leżne jest od stopnia skomplikowania siatek, jednak w początkowej fazie pracy
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nad modelem zazwyczaj automatyczne mapowanie UV w zupełności wystar-
czy, aby nałożyć tekstury na obiekt.

Aby wykonać operację automatycznego mapowania, należy zaznaczyć mo-
del, a następnie polecenie Create UVs > Automatic Mapping - dodatkowo też
w opcjach narzędzia możemy określić opcje płaszczyzn rzutujących teksturę na
obiekt. Narzędzie automatycznego mapowania rzutuje teksturę na różne ścia-
nki modelu w zależności od tego, jak są one ustawione względem płaszczyzn
mapowania (rysunek 5.23).

Rysunek 5.23. Automatyczne mapowanie UV

Gdy już zmapowaliśmy model, musimy nałożyć na niego materiał z teksturą.
Aby tego dokonać, należy otworzyć okno edytora materiałów Hypershade (po-
lecenie Window > Rendering Editors > Hypershade). Na ekranie pojawi się
Hypershade, w którym tworzymy materiały i dodajemy do nich tekstury. Aby
stworzyć nowy materiał, musimy w oknie Hypershade wybrać polecenie Create
> Materials > Blinn (Blinn, to typ materiału, w tej chwili ma on drugorzędne
znaczenie). Po tej operacji w polu Work Area powinna pojawić się kulka rep-
rezentująca wygląd nowego materiału.

W ten sposób tworzymy podstawowy materiał. Aby dodać do niego teks-
turę, musimy otworzyć edytor atrybutów (Attribute Editor) po prawej stronie
ekranu roboczego. Można to uczynić na dwa sposoby: klikając dwukrotnie na
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Rysunek 5.24. Hypershade - edytor materiałów z dodanym nowym materiałem
typu Blinn

zaznaczonej kulce z podglądem materiału lub używając skrótu klawiszowego
Ctrl+A (w zależności od aktualnego stanu interfejsu programu, może być ko-
nieczne użycie go kilka razy). W ustawieniach atrybutów można określić wiele
właściwości materiału (rysunek 5.25).

W atrybutach materiału, w zakładce Color można określić jednolity kolor
materiału lub klikając na szachownicy obok, załadować teksturę, która określi
kolor za pomocą pikseli pobieranych z bitmapy. Wybierając File z listy dostęp-
nych tekstur, musimy wskazać ścieżkę na dysku do tekstury, czyli pliku z bit-
mapą (np. w formacie JPG, BMP, TGA). W ten właśnie sposób w atrybutach
materiału wpinamy określoną teksturę ze wzorem reprezentującym drewno,
kamień, cegłę itd.

W atrybutach materiału możemy także określić przeźroczystość (Transpa-
rency), kolor światła otaczającego (Ambient Color), mapowanie nierówności
(Bump Mapping), odblaski (Specular Shading) itd.

Na rysunku 5.26 można zobaczyć fragment rzymskiego portalu zmapowa-
nego automatycznie materiałem Blinn z teksturą kamiennych płyt oraz tę sa-
mą ścianę z teksturą nałożoną z innymi opcjami mapowania.
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Rysunek 5.25. Attribute Editor - edytor atrybutów

Rysunek 5.26. Mapowanie automatyczne (lewa strona) i planarne dopasowane do
proporcji ściany (prawa strona)
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Rysunek 5.27. Finalny model portalu utworzony narzędziami omówionymi w roz-
dziale
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Modelowanie złożonych obiektów ściankowych

6.1 Modelowanie ściankowe

Modelowanie ściankowe, zwane także poly-modelingiem (słowo pochodzi z ję-
zyka angielskiego, “polygon” znaczy “wielokąt”) jest jedną z podstawowych te-
chnik tworzenia trójwymiarowych obiektów w niemal każdym programie 3D.
W modelowaniu ściankowym sami określamy położenie każdego z wierzchoł-
ków siatki, a tym samym definiujemy jej kształty. Najwygodniejszym sposo-
bem tworzenia modeli ściankowych jest tworzenie jak najprostszych brył, któ-
re potem mogą być zagęszczane i uszczegóławiane w sposób częściowo auto-
matyczny.

6.1.1 Wykorzystanie referencji

Praca przy modelowaniu jest wieloetapowa i aby końcowy rezultat był zado-
walający, musimy płynnie przejść przez kilka charakterystycznych faz modelo-
wania. W niniejszym rozdziale prześledzimy kolejne etapy modelowania złożo-
nych obiektów ściankowych krok po kroku.

Najpierw musimy określić temat pracy, w naszym przypadku będzie to mo-
del pistoletu Glock. Aby dobrze przygotować się do zadania, musimy znaleźć
odpowiednie materiały referencyjne, czyli zdjęcia, rzuty techniczne lub szkice
przedmiotu, który mamy wymodelować. Najprostszym sposobem zdobycia re-
ferencji jest Internet. Korzystając z wyszukiwarek typu Google lub Flickr mo-
żemy znaleźć wiele fotografii a nawet tzw. blueprintów (czyli rzutów lub rysun-
ków technicznych wraz ze specyfikacją inżynierską). Korzystając z serwisów
z filmami takich jak Youtube warto także obejrzeć filmy, które pokazują intere-
sujący nas obiekt w ruchu. Zdobyta w ten sposób wiedza jest bardzo pomocna
- możemy zaobserwować pistolet w działaniu, obejrzeć jak działa zamek i inne
ruchome części, dzięki czemu unikamy problemów przy późniejszej animacji
obiektu 3D.

Możemy też wyruszyć z aparatem fotograficznym w teren, do muzeum lub
na strzelnicę, a zrobione własnoręcznie fotografie staną się nieocenioną pomocą
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przy teksturowaniu, jednocześnie zaś, pozwolą obejrzeć model z każdej strony.
W Internecie znajdziemy wiele fotografii interesujących nas obiektów, ale wię-
kszość z nich to ujęcia z boku, z tyłu lub z przodu, natomiast znalezienie dob-
rych ujęć z góry lub z dołu często jest bardzo trudne lub publikowane obrazki
są w zbyt niskiej rozdzielczości.

Wszystkie zebrane referencje warto zgromadzić w jednym katalogu (rysu-
nek 6.1). Trzymanie wszystkich materiałów w jednym miejscu ułatwia dostęp
do nich i pozwala na lepszą organizację pracy.

Rysunek 6.1. Katalog z referencjami pistoletu Glock

W podobny sposób wygląda modelowanie przy wykorzystaniu szkiców kon-
cepcyjnych. W tym przypadku rysownik w porozumieniu z projektantem dos-
tarczają modelarzowi wszystkie wymagane ilustracje oraz informacje opisujące
zachowanie np. postaci, pojazdu, broni itd.

6.1.2 Dodawanie referencji do sceny (Image Plane)

Aby zaimportować obraz referencyjny do okna roboczego w Mayi, musimy wy-
brać polecenie View > Image Plane > Import Image (rysunek 6.2), a następnie
wskazać lokalizację na dysku, gdzie znajduje się obrazek, który chcemy zaim-
portować.
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Dodatkowo wybierając polecenie View > Image Plane >Image Plane Att-
ributes, w atrybutach obrazu referencyjnego możemy ustawić szerokość, ska-
lowanie, obrót, itp. zaimportowanej bitmapy. Możemy także ustawić stopień
przeźroczystości obrazka, tła oraz zdecydować, czy obraz ma się poruszać ra-
zem z kamerą, czy też pozostać nieruchomo (Image Plane > Fixed/Attached
To Camera). Obrazek w tle jest wyróżniony zieloną ramką, zmieniającą kolor
na żółty, gdy edytujemy atrybuty obrazka.

Rysunek 6.2. Polecenie View > Image Plane > Import Image

Jedną z popularniejszych metod pracy jest wyświetlanie referencji w trzech
rzutach - bok, przód i tył lub góra. Jeśli więc mamy obrazki, na których mo-
del jest przedstawiony w kilku rzutach, to najlepiej jest zbudować w scenie
sześcian i na każdą ściankę nałożyć odpowiedni rzut, a niepotrzebne ścianki
skasować. W ten sposób tworzymy bryłę (rysunek 6.4), której ściankom odpo-
wiadają rzuty ortogonalne, w związku z czym nasza praca przy modelowaniu
może stać się zdecydowanie wygodniejsza.
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Rysunek 6.3. Widok okna roboczego z zaimportowanym obrazkiem referencyjnym
w tle

6.1.3 Modelowanie z referencji

Korzystając z obrazków referencyjnych, możemy rozpocząć modelowanie obie-
ktu. Aby wymodelować zamek korpusu pistoletu, przechodzimy widok z boku
i na podstawie obrazku referencyjnego umieszczamy w scenie bryłę typu Cube,
a następnie korzystając z rzutów z przodu oraz tyłu, dopasowujemy proporcje
siatki zgodnie z tym, co widać na obrazkach (rysunek 6.5). Tym samym wymo-
delowaliśmy uproszczony korpus Glocka.

Oczywiście tworząc bryłę korpusu wspomagamy się wszystkimi referencja-
mi które zgromadziliśmy a w dalszych etapach modelowania dodajemy kolejne
detale (np. muszka, zamek itd.) tak, żeby bryła modelu przypominała w jak
największym stopniu rzeczywisty pistolet Glock.

W ten sposób tworzymy większość brył w początkowym, wstępnym etapie
modelowania - czyli na bazie zgromadzonych referencji tworzymy niskopoligo-
nowe bryły, które w dalszych etapach pracy będziemy uszczegóławiać.

6.1.4 Odbicie lustrzane (Mirror Modeling)

Modelowanie przez odbicie lustrzane (z angielskiego “mirror” - lustro) jest
jedną z popularniejszych metod modelowania. W tym przypadku wykorzysta-
nie odbicia lustrzanego oznacza, iż modelujemy tylko połowę modelu, druga
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Rysunek 6.4. Sześcian z obrazkami rzutów technicznych pistoletu Glock

Rysunek 6.5. Tworzenie bryły korpusu pistoletu Glock na bazie referencji w tle
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Rysunek 6.6. Korpus pistoletu Glock w ujęciu perspektywicznym

zaś jest duplikatem (instancją), która odzwierciedla wszystkie operacją wyko-
nywane na oryginale. Wystarczy, że będziemy modelować lewą część modelu,
prawa zaś pozostanie lustrzanym odbiciem lewej. Korzystanie z opcji Mirror
ma wiele zalet, a podstawową jest pominięcie konieczności kopiowania, obra-
cania i scalania dwóch połówek modelu. Zazwyczaj korzysta się z tej opcji do
pewnego momentu pracy, ponieważ często mamy sytuację, kiedy jedna strona
modelu różni się pewnymi szczegółami od drugiej i wtedy musimy na pewnym
etapie pracy zrezygnować z odbicia lustrzanego i detalizować obie strony in-
dywidualnie.

Aby wykonać operację lustrzanego odbicia, musimy wybrać polecenie Mesh
> Mirror Cut. W ten sposób przetniemy modele na dwie połówki, jedna stro-
na stanie się oryginałem, a druga kopią. W opcjach narzędzia Mirror Cut (ry-
sunek 6.7) możemy określić płaszczyznę cięcia względem osi naszego modelu
(Cut along), czyli zdecydować, czy będziemy przecinać model płaszczyznami
YZ, XZ lub XY. Możemy także scalić obie połówki w jedną bryłę (Merge wtih
the oryginal), zaznaczając przy tym margines tolerancji przy scalaniu wierz-
chołków (Merge vertex threshold).

Dodatkowo też, po przeprowadzeniu operacji lustrzanego odbicia widzimy
oś cięcia, a podczas operacji edycyjnych lustrzana kopia wyróżniana jest kolo-
rem fioletowym.

Należy też pamiętać, że czasem podczas operacji cięcia, kopiowania z obra-
caniem lub tworzenia lustrzanego odbicia możemy wygenerować błędy w siat-
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Rysunek 6.7. Opcje operacji lustrzanego odbicia

Rysunek 6.8. Korpusu pistoletu Glock z włączoną opcją lustrzanego odbicia

ce, między innymi w postaci pojawiających się na krawędziach wierzchołków,
których nie możemy usunąć w tradycyjny sposób (klawiszem Delete). W ta-
kich przypadkach musimy użyć polecenia Edit Mesh > Delete Edge /Vertex,
które pozwala usunąć zbędne wierzchołki, bądź krawędzie z dowolnych miejsc
siatki.
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Rysunek 6.9. Zbędne wierzchołki na krawędziach

Alternatywną funkcją do omówionej wcześniej jest Mirror Geometry, czyli
kopiowanie przez odbicie lustrzane. Operacja ta jest często używana przez mo-
delarzy, którzy nie chcą korzystać z opcji Mirror Cut. Część osób woli bowiem
pracować nad pojedynczą połową modelu, nie zaprzątając sobie głowy resztą
modelu i dopiero na koniec pracy skopiować przez odbicie lustrzane oryginalną

Rysunek 6.10. Opcje narzędzia Mirror Geometry
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połówkę. Aby wykonać operację kopiowania przez odbicie, musimy wybrać po-
lecenie Mesh > Mirror Geometry, w którego opcjach możemy określić oś od-
bicia (Mirror Direction) oraz opcje scalania (Merge i Connect).

6.1.5 Fazowanie krawędzi (Bevel)

We wcześniejszym rozdziale opisaliśmy funkcję fazowania, czyli ścinania lub
zaokrąglania krawędzi. Teraz wykorzystamy fazowanie do zaokrąglenia wybra-
nych krawędzi pistoletu (rysunki 6.11 i 6.12). Aby wykonać operację fazowa-
nia, należy zaznaczyć kilka krawędzi oraz wybrać polecenie Edit Mesh > Be-
vel. W opcjach narzędzia możemy ustalić liczbę podziałów zaokrąglenia (Seg-
ments), jego szerokość (Width) oraz przesunięcia (Offset type i Offset space).

6.1.6 Scalanie dwóch siatek (Combine)

Jedną z wygodnych metod modelowania jest praca na odrębnych siatkach dla
różnych części modelu. Wynika to z tego, iż niejednokrotnie łatwiej jest wymo-
delować dwa elementy osobno, potem zaś połączyć je w jedną, spójną całość,
niż pracować na obiekcie połączonym w całość, co często okazuje się niewygod-
ne oraz nazbyt czasochłonne. Musimy jednak pamiętać, iż na pewnym etapie
pracy konieczne jest umiejętne połączenie dwóch siatek w taki sposób, aby
uniknąć błędów w topologii. Należy przy tym dobrze scalić wierzchołki, wy-
pełnić luki w ściankach itd.

W naszym przypadku najpierw wymodelujemy przekroje otworów z przo-
du pistoletu, aby następnie połączyć oraz scalić dwie odrębne siatki w całość

Rysunek 6.11. Zaznaczenie krawędzi do fazowania
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Rysunek 6.12. Zaokrąglone krawędzie po operacji fazowania

Rysunek 6.13. Płaskie siatki utworzone niezależnie od głównego modelu
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(rysunki 6.13 i 6.14). Połączenie siatek (z pierwotnej usuwamy przednią ścia-
nkę klawiszem Delete) wykonujemy poleceniem Mesh > Combine, a następnie
łączymy odpowiednie wierzchołki, dodajemy przecięcia nowych ścianek i wy-
pełniamy otwory w geometrii poleceniami Merge, Split Polygon Tool, Append
To Polygon Tool. Po tych operacjach możemy wytłoczyć i fazować (Extrude,
Bevel) nowe okrągłe ścianki, tworząc otwory w siatce (rysunek 6.15).

Rysunek 6.14. Operacje modelowania wylotu lufy: A. Combine; B. Merge + Split

Polygon Tool; C. Append To Polygon Tool

Rysunek 6.15. A. Widok dwóch siatek scalonych w jedną; B Wersja ostateczna po
wytłoczeniu

6.1.7 Tworzenie nowych ścianek (Create Polygon Tool)

Korzystając z przedstawionej we wcześniejszym rozdziale funkcji Create Poly-
gon, stworzymy nowe elementy naszego pistoletu. Należy jednak pamiętać, że
to modelarz wybiera odpowiednią dla siebie technikę, którą posłuży się pod-
czas pracy. Równie dobrze moglibyśmy zbudować kolbę pistoletu bazując na
bryle Cube - najważniejsze jest, aby tworzyć nowe elementy, bazując na refe-
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rencjach i budować poprawne siatki, zaś wybór samej techniki jest kwestią in-
dywidualną.

Rysunek 6.16. Kolba pistoletu stworzona narzędziem Create Polygon

Tworząc nową ściankę wyznaczającą kształt kolby, przy wykorzystaniu narzę-
dzia Create Polygon, (rysunek 6.16), musimy pamiętać, aby ją później odpo-
wiednio pociąć na segmenty (rysunek 6.17), ponieważ nowo tworzone ścianki
nie są podzielone na czworokąty bądź trójkąty (co jest potrzebne dla peł-
nej kontroli nad siatką). Aby dodać połączenia między wierzchołkami, zaleca
się wykorzystanie narzędzia Split Polygon Tool, gdyż automatyczna topologia

Rysunek 6.17. Przecinanie kształtu kolby przy użyciu narzędzia Split Polygon Tool
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wygenerowana funkcjami Triangulate lub Quadrangulate nie daje żadnej kon-
troli nad nowo powstałymi krawędziami. Na koniec musimy wytłoczyć nową
ściankę (rysunek 6.18) i wstępny zarys kolby jest gotowy.

Rysunek 6.18. Wytłoczona kolba pistoletu w ujęciu perspektywicznym

6.2 Operacje Boole’a (Booleans)

Operacje Boole’a na siatkach (dodawanie, odejmowanie, wyznaczanie części
wspólnej) są rzadko wykorzystywanymi metodami przy modelowaniu skompli-
kowanych kształtów, ponieważ korzystanie z tej techniki generuje wiele błędów
i przekłamań w siatce. Musimy pamiętać, iż po wykonaniu operacji Boole’a
trzeba niemal zawsze poprawiać topologię siatki.

Aby wykonać operacje Boole’a, należy najpierw zaznaczyć dwie siatki (ry-
sunek 6.20), a następnie rozwinąć podmenu Mesh > Booleans i wybrać jedną
z operacji - suma (Union), różnica (Difference) albo część wspólną (Intersec-
tion) (rysunek 6.19). Musimy też wiedzieć, iż operacje te działają tylko i wy-
łącznie po zaznaczeniu dwóch obiektów, które przecinają się ze sobą (rysu-
nek 6.20). Poszczególne polecenia oznaczają: połączenie dwóch siatek w jedną
(Union), wycięcie w jednej siatce otworu odpowiadającego drugiej siatce (Dif-
ference) lub pozostawienie wewnętrznej części wspólnej dla dwóch brył (In-
tersection). Warto też zwrócić uwagę, iż przy operacji Difference (czyli różni-
cy), znaczenie ma kolejność wyselekcjonowanych obiektów, określająca siatkę,
która z dwóch siatek wycina otwory w drugiej.

Przykład poniżej (rysunek 6.21) ilustruje, jak działają i różnią się między
sobą operacje Booleans.
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Rysunek 6.19. Podmenu Booleans

Rysunek 6.20. Obiekty przygotowane do operacji Booleans
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Rysunek 6.21. Operacje Booleans; A. Union; B. Difference; C. Intersection

W naszym modelu wykorzystamy operacje Booleans aby z tyłu modelu wy-
ciąć otwór na bezpiecznik zamka pistoletu (rysunek 6.22). Należy też pamiętać,
iż po wykonaniu operacji wycinania musimy ręcznie poprawić naszą siatkę,
usunąć niepotrzebne krawędzie i skorygować topologię siatki. Poprawna topo-
logia ma ogromne znaczenia przy późniejszym zagęszczaniu modelu funkcją
Smooth, jak i przy wykonywaniu wielu innych operacji edycyjnych.

Rysunek 6.22. Wycięty za pomocą operacji Booleans otwór zamka pistoletu oraz
poprawiona topologia siatki

Poniżej przedstawiamy przykłady innych części modelu wykonanych przy
użyciu operacji wytłaczania, fazowania i pozostałych omówionych do tej pory.
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Rysunek 6.23. Modelowanie kabłąku spustowego przy użyciu wytłaczania

Rysunek 6.24. Wytłaczanie wylotu łusek
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Rysunek 6.25. Fazowanie krawędzi wylotu łusek

Rysunek 6.26. Modelowanie szczerbinki bazującej na bryle sześcianu (Cube)
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Rysunek 6.27. Język spustowy wykonany za pomocą narzędzia Create Polygon

Tool

Rysunek 6.28. Wytłaczanie karbów zamka
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6.2.1 Powierzchnie podpodziałowe (Subdivision)

Subdivision surfaces to technika modelowania przy użyciu nieskomplikowa-
nych brył, które tworzą zarys obiektu, natomiast odpowiednia funkcja zagę-
szczenia siatki nadaje modelowi obły, wygładzony kształt (poprzez rekursyw-
ny podział powierzchni oraz interpolację za pomocą krzywych parametrycz-
nych). Modelując przy wykorzystaniu techniki Subdivision, mamy do czynienia
z dwiema reprezentacjami modelu: pierwsza to uproszczona (niskopoligono-
wa) siatka kontrolna, a druga to zagęszczona oraz wygładzona bryła o dużej
liczbie ścianek (wysokopoligonowa). Obie te siatki opisują pojedynczy obiekt.
Zmieniając kształt niskopoligonowej bryły, jednocześnie zmieniamy kształt za-
gęszczonej, wysokopoligonowej siatki.

Mając jednak na uwadze, że praca na mniejszej liczby poligonów jest wy-
godniejsza jak również bardziej przejrzysta, przy technice Subdivision edytu-
jemy niskopoligonowe siatki, żeby zobaczyć, jak będą wyglądały zagęszczone
ich wersje.

Technikę Subdivision możemy realizować na kilka sposobów. Jednym z nich
jest utworzenie brył Subdiv Primitives. Żeby tego dokonać, musimy rozwinąć
podmenu Create > Subdiv Primitives > i wybrać jedną z brył podstawowych
z tej kategorii. Nowe bryły Subdiv możemy dodać z poziomu półki narzędzio-
wej (Subdivs), znajdującej się powyżej ekranu roboczego. Półka Subdivs (ry-
sunek 6.29) zawiera w sobie większość najpotrzebniejszych narzędzi z grupy
Subdivision.

Rysunek 6.29. Półka narzędziowa Subdivs
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Aby zmieniać kształty brył Subdivs, nie edytujemy siatek wygładzonych,
tylko otaczające je wierzchołki, krawędzie i ścianki odpowiadające siatkom up-
roszczonym (rysunek 6.30).

Rysunek 6.30. Bryła Subdiv Cube z podświetlonymi punktami edycyjnymi

Narzędzie Subdiv Proxy

Kolejną popularną metodą korzystania z powierzchni podpodziałowych jest
Subdiv Proxy - technika, w ogólnych założeniach bardzo zbliżona do pracy na
bryłach Subdivs, z tą różnicą, iż tutaj zagęszczamy model zbudowany z klasy-
cznych ścianek. Proxy tworzy podział na dwie siatki - pierwsza to oryginalna
niskopoligonowa siatka kontrolna, a druga wygładzona to wygładzona powie-
rzchnia podpodziałowa.

Aby uaktywnić operacje Subdiv Proxy na wybranym modelu, musimy go
najpierw zaznaczyć, a następnie wybrać polecenie Proxy > Subdiv Proxy (ry-
sunek 6.31) lub otworzyć jego opcje (rysunek 6.32). W ten sposób zostaną ut-
worzone dwie siatki. Automatycznie zostaną dodane też do sceny dwie war-
stwy (prawy dolny róg ekranu): SmoothMesh (siatka wysokopoligonowa) oraz
ProxyMesh (półprzeźroczysta siatka niskopoligonowa). Podczas pracy edytu-
jemy i kształtujemy siatkę Proxy tak, żeby wygładzony model Smooth wyglą-
dał zadowalająco.

We właściwościach narzędzia Subdiv Proxy możemy ustawić wiele opcji,
a do najważniejszych należy metoda wygładzania (Subdivision Method) oraz

Rysunek 6.31. Polecenie Sybdiv Proxy
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liczba podziałów zagęszczenia (Division Levels) czy wygładzanie współrzęd-
nych UV (Smooth UVs). Dodatkowo możemy także ustawić opcje odbicia
lustrzanego (Setup) oraz właściwości wyświetlania siatki Proxy, jej przeźro-
czystość (Display Settings) i inne.

Rysunek 6.32. Opcje narzędzia Subdiv Proxy

Podczas pracy z narzędziem Subdiv Proxy widzimy na ekranie dwie siatki
(rysunek 6.33). Korzystając z warstw, możemy je na przemian ukrywać, wy-
łączać, zmieniać ich przezroczystość.

Ponieważ wygładzanie Proxy generuje bardzo dużą liczbę nowych trójką-
tów oraz obciąża zasoby komputera, często spotykaną techniką jest korzysta-
nie z funkcji subdivDisplay Smoothness, czyli szybkiego podglądu wygładzania.
Wygładzanie jest tylko pozorne, gdyż siatka jako taka nie zostaje zagęszczona,
choć jej wyświetlany podgląd emuluje zagęszczenie. Przy słabszych wydajno-
ściowo komputerach jest to jedyna metoda, aby szybko wygenerować podgląd
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Rysunek 6.33. Widok siatek SmoothMesh i ProxyMesh

wygładzania powierzchni podpodziałowej. Aby korzystać z subdivDisplaySmo-
othness wystarczy używać klawiszy 1, 2 i 3 (rysunek 6.34). Kolejne liczby
emulują zagęszczanie (Smoothness) na poziomie 1, 2 lub 3, a dodatkowo pod
klawiszem 2 jest dostępne równoczesne wyświetlanie nisko i wysokopoligono-
wej siatki.

Rysunek 6.34. SubdivDisplaySmoothness na poziomie (od lewej) 1, 2 i 3

Topologia i zagęszczanie (Topology & Smoothnes)

Podczas pracy nad modelem musimy cały czas kontrolować poprawność topo-
logii, czyli mówiąc najogólniej, poprzez odpowiednią strukturę siatki dbać
o to, aby dobrze się wygładzała i zagęszczała. Należy śledzić, czy w wygładzo-
nej wersji modelu nie pojawiają się błędy, a jeśli takowe zauważymy, musimy je



6.2 Operacje Boole’a (Booleans) 125

Rysunek 6.35. Pistolet z aktywnym subdivDisplaySmoothness - Smoothness Level 2

jak najszybciej skorygować. Najważniejszą ogólnie przyjęta zasadą dotyczącą
topologii siatki jest trzymanie się czworokątnych ścianek. Przy budowaniu no-
wych segmentów, cięciu i innych operacjach edycyjnych staramy się tworzyć
tylko takie ścianki, w obrębie których można wyróżnić tylko jeden trójkąt (tri
face), a najlepiej dwa trójkąty składające się w czworokąt (quad face). Oczy-
wiście rzadko można zbudować skomplikowany model z samych czworokątów,
ale podczas modelowania powinniśmy starać się trzymać tej zasady tam gdzie
to tylko możliwe. Na późniejszych etapach pracy operacje na czworokątach ta-
kie jak na przykład cięcie lub zagęszczanie, są dużo wygodniejsze i zazwyczaj
dają lepsze rezultaty.

Siatkę do zagęszczenia należy odpowiednio przygotować, także pod wzglę-
dem gęstości, jak i rozmiarów ścianek, gdyż często podstawowy model (rysu-
nek 6.36) nie zagęszcza się tak, jakbyśmy tego oczekiwali (rysunek 6.37).

Należy pamiętać, iż podczas pracy możemy na bieżąco sprawdzać, jak mo -
del zostanie zagęszczony, korzystając z wcześniej omówionej funkcji SubdivDi-
splaySmoothness (rysunek 6.37).

Korzystając z narzędzi do cięcia (Split Polygon, Cut Face oraz Edge Loops)
musimy pociąć model, wstawiając nowe, wąskie segmenty przy krawędziach
(rysunek 6.38). Należy tak to zrobić, aby po zagęszczaniu wygląd siatki był po-
prawny, czyli w naszym przypadku miał krawędzie zaokrąglone do odpowied-
niej gładkości (rysunek 6.39), a nie stawał się bezkształtną, obłą bryłą jak na
rysunku 6.37.

Na etapie przygotowywania siatki do zagęszczenia możemy także dodawać
nowe szczegóły do siatki. Często korzystając z pojedynczej operacji wytłocze-
nia (rysunek 6.41) możemy dodać pożądane odkształcenia siatki, na przykład
znaczniki na szczerbince (rysunek 6.42).
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Rysunek 6.36. Model szczerbinki przed zagęszczeniem - chcemy delikatnie zaokrą-
glić jego ostre krawędzie

Rysunek 6.37. Zagęszczony model szczerbinki - przy aktualnej topologii widoczna
jest zbyt duża obłość bryły
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Rysunek 6.38. Poprawnie docięty model przygotowany do zagęszczenia - wąskie
segmenty po zagęszczeniu dadzą odpowiedni promień zaokrągleń krawędzi

Rysunek 6.39. Zagęszczony model szczerbinki
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Rysunek 6.40. Zagęszczony model szczerbinki - podgląd wygładzonej siatki

Rysunek 6.41. Zaznaczenie ścianek pod wytłoczenie w szczerbince
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Rysunek 6.42. Gotowa szczerbinka z wytłoczeniami

Odpowiednie przygotowanie siatki do zagęszczenia wymaga zazwyczaj dość
długiej pracy, dlatego gdy tworzymy model wysokopoligonowy, który ma być
mocno zagęszczany, najlepiej korygować błędy i wprowadzać poprawki na bie-
żąco podczas pracy na niskopoligonowej wersji modelu.

Porównanie siatek źle i dobrze przygotowanych do zagęszczenia widać na
poniższych rysunkach:

Rysunek 6.43. Porównanie siatek: dobrze (po lewej) i źle (po prawej) przygotowa-
nych do wygładzenia
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Rysunek 6.44. Porównanie siatek: widok subdivDisplaySmoothnes

Rysunek 6.45. Porównanie wygładzonych siatek: widoczna różnica kształtów zwią-
zana z poprawnym i niepoprawnym przygotowaniem modelu do wygładzenia

Aby ostatecznie zagęścić siatkę i uzyskać model wysokopoligonowy, musi-
my użyć polecenia Mesh > Smooth albo przejść do jego opcji. We właściwoś-
ciach tego narzędzia możemy ustawić wiele opcji podobnych jak w narzędziu
Subdiv Proxy. Do najważniejszych należy metoda wygładzania (Linearly lub
Exponentially), liczba podziałów zagęszczenia (Division Levels) oraz wygła-
dzanie współrzędnych UV (Smooth Uvs).

Na rysunkach 6.52-6.56 można obejrzeć ukończony model pistoletu Glock,
wykonany w całości za pomocą technik przedstawionych w poprzednim oraz
niniejszym rozdziale.
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Rzeźbienie (Sculpting)

Ostatnią techniką modelowania, którą warto wymienić w niniejszej książce,
jest tzw. sculpting. Rzeźbienie siatek o organicznych kształtach, potocznie
zwane przez grafików 3D sculptingiem (z angielskiego sculpt - rzeźbić) stało się
ostatnimi laty domeną zewnętrznych programów, wyspecjalizowanych w ob-
róbce bardzo skomplikowanych brył, takich jak np. Zbrush lub Mudbox. Jed-
nak także i w Mayi znajdziemy narzędzia, dzięki którym możemy zapoznać
się z modelowaniem organicznym.

Najlepszymi narzędziami do nadawania bryłom geometrycznym bardziej
organicznych kształtów są Sculp Tool oraz Soft Modification. Aby z nich sko-
rzystać, musimy najpierw przełączyć się do układu menu Surfaces, a następnie
wybrać polecenie Subdiv Surface > Sculpt Geometry Tool (rysunek 6.46).

Rysunek 6.46. Polecenie Sculpt Geometry Tool

Musimy pamiętać, iż aby praca przy modelowaniu organicznym była efek-
tywna, należy edytowaną siatkę mocno zagęścić narzędziem Smooth. W zależ-
ności od sytuacji zaleca się zagęszczania przed lub po rzeźbieniu.

Narzędzie Sculpt Geometry daje nam ogromne możliwości w kształtowaniu
siatek w sposób imitujący tradycyjne narzędzia rzeźbiarskie, skonsolidowane
do tzw. pędzla (Brush). W ustawieniach tego narzędzia (rysunek 6.47) może-
my dokładnie określić zasięg pędzla (Brush Radius), stopień jego wypełnienia
(Opacity) oraz profil pędzla (Profile). Możemy także określić, czy pędzel ma
deformować siatkę w głąb czy na zewnątrz, lub też czy ma ją wygładzać (Sculpt
Parameters), a jeśli zajdzie potrzeba, możemy także skorzystać z wirtualnej
“gumki” do cofania zmian.

Najczęściej narzędzi do rzeźbienia używamy po to, aby nadać powierzchni
bardziej organiczną fakturę (rysunek 6.48), na przykład przy zmarszczkach na
twarzy, pofałdowaniach terenu lub innych nieregularnych odkształceniach.
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Rysunek 6.47. Ustawienia narzędzia Sculpt Geometry Tool
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Rysunek 6.48. Siatka rzeźbiona przy użyciu narzędzia Sculpt Geometry Tool

Kolejnym narzędziem używanym często do rzeźbienia jest Soft Modifica-
tion, czyli tzw. “miękka modyfikacja” - jej zasada działania opiera się na tym,
iż wygładza ona siatkę wokół deformowanych punktów.

Aby skorzystać z miękkiej modyfikacji, musimy wybrać polecenie Create
Deformers > Soft Modification (rysunek 6.49), a następnie kliknąć na siatce
w miejscu, które chcemy zdeformować - w ten sposób wyświetlimy punkt ozna-
czony literą S (skrót od Soft Modification), który będzie odkształcał siatkę.
Dodatkowo zasięg modyfikacji zaznaczony jest kolorem białym (zobacz rysu-
nek 6.50).

Wskutek użycia Soft Modification możemy na przykład utworzyć na terenie
wybrzuszenie o określonym zasięgu, które odkształca siatkę oraz jej okolice
coraz słabiej w miarę odległości od punktu S.

Rysunek 6.49. Polecenie Soft Modification
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Rysunek 6.50. Widok na siatkę odkształconą przy użyciu miękkiej deformacji
(punkty S)

We właściwościach narzędzia Soft Modification (rysunek. 6.51) można tak-
że ustawić zasięg deformacji (Falloff radius) oraz zmienić jej kształt (Falloff
curve) lub też określić rodzaj odkształcenia (Falloff mode).

Rysunek 6.51. Właściwości Soft Modification
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Modelowanie krzywych i powierzchni

7.1 Wprowadzenie

W poprzednich rozdziałach zajmowaliśmy się modelowaniem obiektów ścian-
kowych (Polygons), nazywanych też często obiektami siatkowymi lub po pro-
stu siatkami. Choć jest to najbardziej uniwersalna i jedna z najefektywniej-
szych technik modelowania, Maya oferuje też inne klasy obiektów, dzięki któ-
rym tworzenie niektórych specyficznych modeli może być znacznie wygodniej-
sze.

Do modelowania krzywych (Curves) i powierzchni (Surfaces), o których
mowa w niniejszym rozdziale, służą w większości specjalne narzędzia, ulokowa-
ne w innych menu i panelach niż funkcje, którymi zajmowaliśmy się do tej po-
ry. Dlatego przed przystąpieniem do realizacji przykładów opisanych poniżej,
warto zmienić nieco konfigurację interfejsu Mayi. W lewym górnym rogu ek-
ranu, na listwie statusu, z rozwijanej listy z układami menu należy wybrać
pozycję Surfaces zamiast Polygons lub innej, która była tam wybrana dotych-
czas. Spowoduje to wyświetlenie innego zestawu menu na górnej listwie menu
(pojawią się też nowe menu Edit, Curves, Surfaces itd. - zobacz rysunek 7.1.).
Oprócz tego na półce narzędziowej zamiast zakładki Polygons można włączyć
zakładkę Curves albo Surfaces, dzięki czemu łatwiej dostępne staną się ikony
funkcji do edycji krzywych i powierzchni, których można używać zamiast wy-
woływania funkcji z górnej listwy menu (dolna część rysunku 7.1).

Rysunek 7.1. Układ menu i półki narzędziowej ułatwiający pracę z krzywymi
i powierzchniami
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7.1.1 Krzywe (Curves)

Krzywe są specyficznymi obiektami, które przyjmują postać linii o różnych
kształtach. Przykłady krzywych można obejrzeć na rysunku 7.2. Krzywe nie
są widoczne po wyrenderowaniu sceny i najczęściej służą jako komponenty do
budowania bardziej skomplikowanych obiektów, jako ich przekroje lub ścieżki,
po których wytłaczane są różne kształty. Krzywych używa się też często do
zastosowań innych niż modelowanie, na przykład do określania ścieżek ruchu
(trajektorii) animowanych obiektów.

Rysunek 7.2. Przykłady krzywych o zróżnicowanych kształtach

Maya umożliwia tworzenie kilku rodzajów krzywych o regularnych kształ-
tach (kwadrat, okrąg, łuk) lub rysowanie dowolnego kształtu poprzez doda-
wanie kolejnych wierzchołków krzywej kursorem w oknie widokowym.

7.1.2 Powierzchnie (Surfaces)

Określenie powierzchnia (surface) może być tu nieco mylące, ponieważ każdy
renderowany obiekt 3D posiada pewnego rodzaju powierzchnię (krzywe nie
są renderowane właśnie dlatego, że jej nie posiadają). W przypadku obiektów
typu Polygons powierzchnię obiektu definiują ścianki utworzone z wieloką-
tów, natomiast w kategorii obiektów Surfaces znajdują się narzędzia służące
do tworzenia modeli, których powierzchnie mogą być określone i edytowane
w nieco inny sposób, niż w przypadku obiektów ściankowych. O ile obiekty
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typu Polygons wykorzystujemy zazwyczaj wtedy, gdy zależy nam na możli-
wości dowolnego kształtowania każdego fragmentu powierzchni, o tyle obiekty
tworzone narzędziami z menu Surfaces najczęściej służą do generowania mo-
deli o miękkich, regularnych kształtach, w których zamiast pełnej kontroli nad
siatką cenniejsza jest idealna gładkość i możliwość odkształcania powierzchni
w miękki sposób, bez powstawania ostrych krawędzi. Przykłady takich obiek-
tów przedstawia rysunek 7.2.

Rysunek 7.3. Przykładowe obiekty wygenerowane funkcjami z menu Surfaces

7.2 Tworzenie i edycja krzywych i powierzchni

W podmenu Create > NURBS Primitives znajdują się polecenia służące
do tworzenia prostych powierzchni i krzywych opartych na predefiniowanych
kształtach typu NURBS. Słowo NURBS to w języku angielskim akronim od
Non-uniform rational B-spline, czyli specyficznego rodzaju krzywej opisanej
równaniami matematycznymi.

Pierwsze sześć z nich (Sphere, Cube, Cylinder, Cone, Plane i Torus) to po-
wierzchnie będące odpowiednikami obiektów o analogicznych kształtach i na-
zwach z kategorii Polygons (rysunek 7.4, po lewej). Z kolei Circle i Square (po
prawej stronie rysunku 7.4) to krzywe, tworzące odpowiednio okrąg i kwadrat,
niemające odpowiedników wśród obiektów ściankowych.

Po co w takim razie rozważać tworzenie sześcianu czy sfery w inny sposób
niż jako obiektu ściankowego? Patrząc na sferę przedstawioną na rysunku 7.3,
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Rysunek 7.4. Predefiniowane powierzchnie i krzywe

można zauważyć, że jej krawędzie wyglądają nieco inaczej, niż w przypadku
sfery zbudowanej ze ścianek - mają one postać gładkich krzywych. Aby zmie-
nić kształt sfery opisanej gładkimi krzywymi, nie musimy zaznaczać i modyfi-
kować dużej liczby wierzchołków, ponieważ krzywizna powierzchni określana
jest węzłami, których liczba jest stosunkowo niewielka.

7.2.1 Modyfikowanie prostych obiektów typu NURBS

Aby jeszcze wyraźniej zobrazować sobie specyfikę pracy z obiektami typu Sur-
faces :

1. Wybierz polecenie File > New Scene, aby utworzyć nową, pustą scenę.
2. Użyj polecenia Create > NURBS Primitives > Sphere i przeciągnij kur-

sorem w oknie widokowym, aby dodać do sceny sferę.
3. Przytrzymaj prawy klawisz myszy na zaznaczonej sferze i z menu podręcz-

nego wybierz polecenie Control Vertex, aby przejść do trybu edycji wierz-
chołków (węzłów) kontrolnych. Wokół sfery pojawi się chmura kwadrato-
wych uchwytów reprezentujących węzły kontrolne (rysunek 7.5).

4. Zaznacz kilka węzłów i przeciągnij je w dowolnym kierunku, obserwując,
jak zmienia się krzywizna powierzchni. Operację tę możesz powtórzyć kil-
kakrotnie dla różnych wierzchołków (rysunek 7.6).

Jak można zaobserwować na rysunku 7.6., przesuwanie wierzchołków kontrol-
nych daje inny efekt, niż edycja zwykłych wierzchołków w siatkach typu Poly-
gons. W przypadku powierzchni opisanej krzywymi obiekt zachowuje gładkość
pomimo niewielkiej liczby danych opisujących jego kształt. To jest zasadnicza
różnica praktyczna pomiędzy obiektami Polygons i Surfaces - w przypadku
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Rysunek 7.5. Węzły kontrolne służące do edycji kształtu powierzchni

Rysunek 7.6. Sfera po edycji wierzchołków kontrolnych
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tych pierwszych gładkość i szczegółowość modelu ściśle zależy od liczby punk-
tów i krawędzi, natomiast w obiektach typu Surfaces program automatycznie
interpoluje krzywizny tak, aby wizualnie obiekt pozostał gładki. Ma to jednak
również pewne wady - pojedyncze obiekty typu NURBS nie mogą posiadać os-
trych krawędzi, co zilustruje kolejny przykład.

1. Wybierz polecenie Create > NURBS Primitives > Cube i przeciągnij dwu-
krotnie kursorem w oknie widokowym, aby dodać do sceny prostopadło-
ścian.

2. Kliknij pojedynczą ściankę prostopadłościanu, a zauważysz, że zostanie
ona zaznaczona niezależnie od reszty modelu - w rzeczywistości składa się
on z sześciu odrębnych obiektów, co można dodatkowo uwidocznić, włą-
czając panel Outliner z lewej strony ekranu (rysunek 7.7). Między innymi
z tego względu obiekty typu NURBS nie nadają się do wydajnego modelo-
wania modeli o dowolnych kształtach, ponieważ uzyskanie niektórych efe-
któw może być w ich przypadku problematyczne (choć są sposoby na omi-
janie tego typu ograniczeń).
Na pozór prostopadłościan ten nie różni się niczym od swojego odpowied-
nika z kategorii Polygons, lecz łatwo zauważyć, że jego edycja może być
bardziej problematyczna.

3. Przytrzymaj prawy klawisz myszy na zaznaczonej ściance i z menu pod-
ręcznego wybierz funkcję Control Vertex, przechodząc w tryb edycji wę-
złów kontrolnych. Przesuwając kilka z nich, możesz zaobserwować, że po-
wierzchnia ścianki odkształca się w płynny sposób, ale powstaje widoczna
przerwa pomiędzy krawędziami ścianek (rysunek 7.8).

Rysunek 7.7. Prostopadłościan typu NURBS składa się z sześciu odrębnych po-
wierzchni
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Rysunek 7.8. Edycja jednej ze ścianek prostopadłościanu typu NURBS powoduje
powstanie widocznych nieciągłości na powierzchni modelu

7.2.2 Tworzenie i edycja krzywych o złożonych kształtach

Poleceniami Create > NURBS Primitives > Circle oraz Create > NURBS Pri-
mitives > Square możemy tworzyć dwa najprostsze typy krzywych, czyli okrąg
i prostokąt, przy czym prostokąt podlega podobnym ograniczeniom jak opi-
sany przed chwilą prostopadłościan, czyli ze względu na występowanie kątów
prostych, konieczne jest podzielenie go na kilka odrębnych obiektów. Zazwy-
czaj jednak potrzebujemy krzywych o bardziej skomplikowanych kształtach
i gdy te dwa obiekty nie nadają się do zamodelowania interesujących nas pro-
fili, konieczne jest użycie jednego z narzędzi do ręcznego tworzenia krzywych.

Krzywą o unikalnym kształcie można utworzyć za pomocą dwóch funkcji,
przy czym różnią się one metodą rysowania krzywej, a nie możliwymi do uzy-
skania rezultatami - w obu przypadkach efekt końcowy może być identyczny.
Pierwszą z nich uruchamiamy poleceniem Create > CV Curve Tool, a drugą
Create > EP Curve Tool.

Dla osób nieprzywykłych wcześniej do pracy z krzywymi Beziera (spo-
tykamy je w wielu programach graficznych innych, niż Maya), najbardziej
naturalną metodą modelowania krzywych może być EP Curve Tool. W przy-
padku tego narzędzia, rysując krzywą, określamy położenie punktów edycyj-
nych (Edit Points) i krzywiznę łuków wokół tych punktów (rysunek 7.9).
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Aby utworzyć krzywą typu EP, wykonaj następujące czynności:

1. Wybierz polecenie File > New Scene, aby utworzyć nową, pustą scenę.
2. Wybierz polecenie Create > EP Curve Tool.
3. Kliknij w oknie widokowym, aby określić położenie pierwszego węzła krzy-

wej. Przyjmie on postać małego czerwonego kwadratu na tle żółtego znaku
X .

4. Kliknij drugi raz w innym miejscu okna widokowego, żeby dodać kolejny
węzeł krzywej oznaczony drugim znakiem X . Pomiędzy węzłami pojawi
się pierwszy segment krzywej.

5. Kolejnymi kliknięciami w oknie widokowym możesz dodawać następne wę-
zły, pomiędzy którymi program sam automatycznie wstawi łuki o możliwie
gładkich krzywiznach.

6. Przy każdym kliknięciu możesz przeciągnąć kursorem w dowolnym kieru-
nku, zmieniając położenie kolejnego węzła i obserwując w czasie rzeczy-
wistym zmiany krzywizny łuku w sąsiedztwie tego węzła.

7. Jeśli któryś z węzłów został dodany w niewłaściwym miejscu, możesz kla-
wiszem Backspace cofnąć jego utworzenie (kilkukrotne wciśnięcie Backspa-
ce pozwala cofnąć do etapu dodawania jeszcze wcześniejszych węzłów).

8. Węzły można również dodawać i przesuwać w dowolnych oknach widoko-
wych w trakcie tworzenia pojedynczej krzywej - pomiędzy dodaniem kolej-
nych węzłów możesz nacisnąć szybko spację i kliknąć w innym oknie wido-
kowym. Pozwala to utworzyć krzywą, która nie leży w jednej płaszczyźnie.
Przykład takiej krzywej znajduje się na rysunku 7.9.

9. Aby zakończyć rysowanie krzywej, naciśnij klawisz Enter.

Jak można zauważyć, za pomocą narzędzia EP Curve Tool tworzymy krzywą
poprzez określenie punktów znajdujących się bezpośrednio na tej krzywej.

W grafice wektorowej (nie tylko 3D) popularne są jednak inne techniki
modelowania krzywych, w których o kształcie każdego segmentu pomiędzy
węzłami decyduje ustawienie specjalnych wierzchołków kontrolnych (Control
Vertices), które nie muszą leżeć bezpośrednio na krzywej.

Aby utworzyć krzywą poprzez określenie wierzchołków kontrolnych, wyko-
naj następujące operacje:

1. Wybierz polecenie Create > CV Curve Tool.
2. Kliknij w oknie widokowym, aby utworzyć pierwszy wierzchołek kontrolny.
3. Kolejnymi kliknięciami możesz dodawać następne wierzchołki kontrolne -

odcinki łączące te wierzchołki nie są jednak krzywą, którą tworzymy. Po
dodaniu trzeciego wierzchołka program narysuje pierwszy segment krzy-
wej wyznaczony tymi wierzchołkami.

4. Kolejne kliknięcia pozwolą dodać dalsze wierzchołki i segmenty, przy czym
podobnie jak w przypadku krzywej typu EP, możemy po kliknięciu prze-
ciągnąć kursorem, żeby określić docelowe położenie danego wierzchołka,
mając przed oczyma zmieniający się interaktywnie kształt krzywej (zo-
bacz rysunek 7.10). Aby zakończyć tworzenie krzywej, naciśnij Enter.
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Rysunek 7.9. Przykład krzywej utworzonej narzędziem EP Curve Tool

Rysunek 7.10. Krzywa tworzona narzędziem CV Curve Tool
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Krzywą utworzoną dowolnymi narzędziami możemy później poddać edy-
cji, zmieniając jej kształt. Możliwe jest między innymi przedłużanie krzywej
poprzez dodawanie do niej nowych węzłów na jej końcu (Edit Curves > Add
Points Tool), dodanie nowego węzła w obrębie danego segmentu krzywej (Edit
Curves > Insert Knot) i wiele innych operacji dotyczących wybranych frag-
mentów lub całości krzywej. Poniżej przedstawimy kilka przykładowych funk-
cji do kształtowania krzywej.

Aby zmodyfikować kształt krzywej poprzez edycję punktów kontrolnych:

1. Utwórz dowolną krzywą o kilku segmentach przy użyciu narzędzia CV Cu-
rve Tool lub EP Curve Tool (możesz też zmodyfikować krzywą typu Circle
lub Square).

2. Kliknij w dowolnym miejscu krzywej prawym klawiszem myszy i po przy-
trzymaniu go wybierz z menu podręcznego opcję Control Vertex. Wokół tej
krzywej wyświetlone zostaną wierzchołki kontrolne (rysunek 7.11).

3. Zaznacz jeden lub więcej wierzchołków kursorem i przesuń je w dowolne
miejsce okna widokowego, obserwując jak zmienia się kształt krzywej. Po-
wtórz tę operację dla różnych wierzchołków (rysunek 7.12).

Jedną z najbardziej popularnych metod edycji krzywych w grafice kompute-
rowej jest algorytm Beziera, który opiera się na określaniu krzywizny łuku po-
przez modyfikowanie stycznej do krzywej w danym punkcie. Aby skorzystać
z narzędzia tego typu, należy użyć funkcji Curve Editing Tool.

Rysunek 7.11. Krzywa w trybie edycji wierzchołków kontrolnych
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Rysunek 7.12. Krzywa z poprzedniego rysunku po zmianie położenia kilku wierz-
chołków kontrolnych

W celu zmiany kształtu krzywej narzędziem Curve Editing Tool, wykonaj
następujące czynności:

1. Utwórz nową krzywą albo skorzystaj z krzywej utworzonej w poprzednim
przykładzie.

2. Wybierz polecenie Edit Curves > Curve Editing Tool.
3. Kliknij w dowolnym punkcie krzywej. W miejscu kliknięcia pojawi się kilka

uchwytów służących do kształtowania krzywej w tym miejscu.
4. Aby zmienić położenie węzła krzywej, kliknij i przeciągnij kursorem nie-

bieski kwadrat leżący w miejscu, które przed chwilą wskazałeś.
5. Aby zmienić krzywiznę łuku poprzez nachylenie i długość odcinka kontro-

lnego stycznego do krzywej, kliknij jeden z błękitnych kwadratów leżących
na tym odcinku (pusty kwadrat odpowiada za nachylenie, zaś wypełniony
za długość odcinka kontrolnego).

6. Aby przesunąć zaznaczony punkt po krzywej, nie zmieniając jej kształtu,
kliknij i przeciągnij niebieski kwadrat na odcinku prostopadłym do krzy-
wej.

7. By wyrównać styczną krzywej do pionowej lub poziomej osi układu współ-
rzędnych, kliknij niebieską lub czerwoną linię przerywaną w sąsiedztwie
zaznaczonego węzła.

8. W każdej chwili możesz kliknąć w dowolnym innym miejscu krzywej i pod-
dać edycji inny jej węzeł. Spróbuj powtórzyć opisane wyżej czynności, aby
nadać krzywej zupełnie inny kształt (rysunek 7.13).
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Rysunek 7.13. Edycja kształtu krzywej narzędziem Curve Editing Tool

Tworzenie powierzchni o złożonych kształtach

Krzywe same w sobie nie stanowią modeli, które można renderować jako bryły
3D. W oparciu o nie dopiero definiuje się takie powierzchnie, za pomocą innych
narzędzi, z których najważniejsze można znaleźć w menu Surfaces. Poniżej po-
każemy przykłady ich wykorzystania.

7.2.3 Modelowanie bryły obrotowej narzędziem Revolve

Polecenie Surface > Revolve tworzy bryłę obrotową, której przekrój może być
wyznaczony przez dowolną krzywą. Wymodelujemy teraz przykładowy dzban,
którego powierzchnia powstanie przy użyciu tego narzędzia. Aby utworzyć mo-
del dzbanu:

1. Wybierz polecenie File > New Scene, aby utworzyć nową scenę.
2. Powiększ na cały ekran okno widokowe front lub side, dzięki temu bardziej

precyzyjnie będziesz mógł narysować przekrój bryły.
3. Wybierz polecenie Create > EP Curve Tool i kliknij przy pionowej osi głó-

wnej siatki konstrukcyjnej (gruba czarna linia), aby wstawić pierwszy wę-
zeł krzywej.

4. Kolejnymi kliknięciami dodawaj następne węzły, rysując krzywą przypo-
minającą literę “S”, która będzie stanowiła połowę przekroju dzbana (ry-
sunek 7.14). Nie musisz starać się ustawiać węzłów bardzo precyzyjnie,
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możesz później poddać edycji położenie węzłów i krzywizny łuków, np. za
pomocą narzędzia Edit Curves > Curve Editing Tool.

Rysunek 7.14. Krzywa stanowiąca połowę przekroju dzbana

5. Ostatni węzeł wstaw również na pionowej osi głównej siatki konstrukcyj-
nej, tak by węzeł początkowy i końcowy krzywej znajdowały się jeden nad
drugim. Po utworzeniu ostatniego węzła naciśnij klawisz Enter.

6. Jeśli nie jesteś zadowolony z kształtu krzywej, możesz kliknąć prawym kla-
wiszem myszy i z menu podręcznego wybrać funkcję Control Vertex i zmie-
nić położenie dowolnych węzłów, a w celu dokładniejszego wyprofilowania
łuków użyć narzędzia Edit Curves > Curve Editing Tool. Aby przesunąć

Rysunek 7.15. Kształt przekroju dzbana po korekcji położenia węzłów
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początkowy oraz końcowy węzeł dokładnie nad oś symetrii bryły, podczas
przesuwania węzła przytrzymaj klawisz X (w miejscu kursora pojawi się
mały okrąg) i przeciągnij go w stronę jednego z węzłów siatki konstruk-
cyjnej leżących na tej osi. Krzywą po korekcie ilustruje rysunek 7.15.

7. Przejdź do okna widoku perspektywicznego i mając zaznaczoną krzywą,
kliknij czarny kwadrat obok polecenia Revolve w menu Surfaces. Na ekra-
nie pojawi się okno dialogowe Revolve Options, widoczne na rysunku 7.16.
W oknie tym upewnij się, że w polu Axis preset wybrana jest opcja Y okre-
ślająca oś, względem której obracany jest przekrój. Po naciśnięciu przyci-
sku Apply w scenie powinna pojawić się bryła widoczna na rysunku 7.16.

Rysunek 7.16. Bryła obrotowa utworzona narzędziem Revolve

7.2.4 Profilowanie kształtu powierzchni obrotowej

Do utworzenia po jednej stronie dzbana charakterystycznego dziobu, wystar-
czy zmodyfikować odpowiednie węzły kontrolne w utworzonej przed chwilą po-
wierzchni. Wykonaj następujące operacje:

1. W scenie z poprzedniego ćwiczenia kliknij na dzbanie prawym klawiszem
myszy i wybierz z menu podręcznego funkcję Control Vertex.

2. Zaznacz wierzchołki kontrolne pojedynczego segmentu bryły leżące na sa-
mym brzegu dzbana i przesuń je kursorem na zewnątrz bryły oraz nie-
znacznie w dół (zobacz rysunek 7.17). Jak można zauważyć, kształt dużej
części dzbana miękko dopasowuje się do przesuniętych węzłów.

3. Zaznacz wierzchołki w okolicy brzegu dzbana sąsiadujące z wcześniej już
zaznaczonymi i przeskaluj je w taki sposób, aby zwęzić obszar wokół wcze-
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śniej uwypuklonego dzioba (rysunek 7.18). Możesz je przy tym przesunąć,
w zależności od tego, jaki kształt chcesz ostatecznie nadać dziobowi.

Rysunek 7.17. Przesunięcie wierzchołków na brzegu dzbana

Rysunek 7.18. Dalsze profilowanie dzioba w dzbanie

7.2.5 Wytłaczanie profilu po krzywej narzędziem Extrude

Poza Revolve jednym z częściej używanych narzędzi do modelowania powierz-
chni jest Surfaces > Extrude. Należy przy tym zauważyć, że jest to zupełnie
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inne narzędzie niż funkcja wytłaczania ścianek (Extrude) dostępna dla obiek-
tów klasy Polygons. W przypadku Surfaces > Extrude dokonujemy wytłocze-
nia kształtu określonego pewną krzywą wzdłuż ścieżki zdefiniowanej przez in-
ną krzywą. Kontynuując przykład z poprzednich podrozdziałów, użyjemy na-
rzędzia Extrude do utworzenia profilowanego uchwytu dla dzbana. Aby zrea-
lizować to zadanie:

1. W scenie z poprzedniego ćwiczenia przejdź do okna widoku front lub side,
aby ujrzeć dzban z boku, z dziobem skierowanym w prawo lub lewo.

2. Wybierz polecenie Create > EP Curve Tool albo Create > CV Curve Tool
i za pomocą kilku węzłów narysuj krzywą, kształtem przypominającą uch-
wyt dzbana, dopasowując jej początek i koniec do miejsc, w których uch-
wyt mógłby być przytwierdzony do obiektu (rysunek 7.19).

Rysunek 7.19. Krzywa określająca kształt uchwytu dzbana

3. W oknie widokowym top utwórz krzywą typu Circle, czyli okrąg (Create
> NURBS Primitives > Circle) i umieść ją przy końcu profilu, aby nas-
tępnie narzędziem skalowania dopasować rozmiar przekroju do pożądanej
grubości uchwytu (rysunek 7.20). Możesz przeskalować okrąg niepropor-
cjonalnie wzdłuż jednej z osi, czyniąc z niego elipsę, jak przedstawiono na
rysunku 7.20.
Operacje te mogą wymagać przechodzenia pomiędzy różnymi oknami wi-
dokowymi.

4. Zaznacz kształt przekroju (okrąg lub elipsę), a następnie trzymając wci-
śnięty klawisz Ctrl kliknij wcześniej utworzony kształt uchwytu. Kolejność
zaznaczania obu krzywych jest tu bardzo ważna, ponieważ program wytła-
cza pierwszą krzywą (przekrój) wzdłuż drugiej krzywej (ścieżki) i zmiana
kolejności dałaby nieprawidłowe efekty. Ostatni zaznaczony obiekt w Mayi
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Rysunek 7.20. Przekrój uchwytu wymodelowany jako elipsa

jest zawsze wyróżniany na zielono, dlatego w tym przypadku po zazna-
czeniu obu krzywych zielony powinien być kształt uchwytu, który wymo-
delowaliśmy wcześniej.

5. Wybierz polecenie Surfaces > Extrude. W rezultacie elipsa powinna zostać
wytłoczona wzdłuż ścieżki i utworzyć uchwyt podobny do tego z rys. 7.21.
Jeśli profil nie został dopasowany do ścieżki tak jak tego chciałeś, mo-
żesz spróbować użyć dodatkowo opcji Use Profile Normal lub Fixed Path
w bocznym panelu atrybutów.

6. Dość istotne w tej metodzie modelowania jest to, że program zachowuje
powiązanie wytłoczonej powierzchni z jej pierwotnym przekrojem i ścież-
ką, które nie są usuwane ze sceny. Zmieniając kształt którejś z tych krzy-
wych, możemy zmodyfikować wytłoczony obiekt w dowolnym momencie.
Na przykład przesuwając wybrane wierzchołki kontrolne w przekroju uch-
wytu, mamy możliwość nadania uchwytowi bardziej złożonego profilu, jak
na rysunku 7.22.

Tak wymodelowany dzban możemy poddać końcowym modyfikacjom, aby os-
tatecznie wyprofilować wszystkie jego elementy (rysunek 7.23). Co łatwo zau-
ważyć po raz kolejny, powierzchnie modelowane w oparciu o krzywe najlepiej
nadają się do oddawania miękkich, obłych kształtów - dlatego dla prostych na-
czyń, jak omawiany tu dzban, stanowią one interesującą alternatywę w stosun-
ku do przedstawionych wcześniej funkcji do modelowania ściankowego.
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Rysunek 7.21. Wymodelowany uchwyt dzbanu

Rysunek 7.22. Profilowanie uchwytu poprzez edycję węzłów kontrolnych jego pier-
wotnego przekroju
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Rysunek 7.23. Ostateczna postać dzbana wymodelowanego narzędziami Revolve

i Extrude
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Materiały

8.1 Wprowadzenie

Wcześniejsze rozdziały przedstawiały różne techniki modelowania, czyli budo-
wania trójwymiarowych obiektów za pomocą narzędzi dostępnych w progra-
mie Maya. Modelowanie jest jednak wyłącznie wstępem do tworzenia popraw-
nie wyglądających scen 3D. Wszystkie modele utworzone w ćwiczeniach z po-
przednich rozdziałów posiadają jednolitą, zazwyczaj szarą powierzchnię, która
w większości przypadków zupełnie nie przypomina materiałów, z których wy-
konane są rzeczywiste obiekty.

Tworzenie materiałów jest bardzo obszerną dziedziną, dlatego też, w niniej-
szej książce przedstawimy wyłącznie wstęp do zagadnień związanych z tym te-
matem, obejmujący aktualny i następny rozdział. Przykłady tu przedstawione
powinny jednak umożliwić czytelnikowi samodzielne zgłębianie tematyki two-
rzenia materiałów, jak również eksperymentowanie z narzędziami ich doty-
czącymi.

Najogólniej mówiąc, materiał jest to funkcja, która przypisuje powierzchni
modelu określone właściwości definiujące jej wygląd, takie jak kolor, połyskli-
wość, faktura, przezroczystość, itp. Za pomocą materiałów możemy dodawać
do powierzchni obiektu drobne szczegóły, których odwzorowanie nie byłoby
możliwe lub opłacalne przy użyciu narzędzi do modelowania. Przykład obiektu
z różnymi materiałami przedstawia rysunek 8.1.

Materiały nie są widoczne w szkieletowym podglądzie sceny. W celu ich wy-
świetlenia musimy włączyć jeden z trybów cieniowanych (np. skrótem klawi-
szowym 5 dla podglądu bez tekstur, bądź też skrótem 6 dla podglądu z tek-
sturami).

Niektóre właściwości materiałów nie są wizualizowane w oknie roboczym
programu w czasie rzeczywistym i aby obejrzeć ostateczną postać obiektu, na-
leży uruchomić rendering sceny, czyli wygenerować obraz uwzględniający oś-
wietlenie i materiały w dokładny sposób. Rendering uruchamiamy ikoną z fil-
mowym klapsem (Render the current frame) znajdującą się po prawej stronie
półki narzędziowej (zobacz rysunek 8.2).
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Rysunek 8.1. Przypisanie materiału pozwala nadać powierzchni obiektu unikalne
właściwości (scena wyświetlana w trybie High Quality Rendering)

Rysunek 8.2. Efekt renderingu obiektów z różnymi materiałami
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Po wyrenderowaniu można zauważyć, że wpływ oświetlenia i dokładność
odwzorowania tekstur są inne niż w podglądzie roboczym, przy czym od specy-
ficznych ustawień materiałów i wybranego renderera (modułu Mayi odpowie-
dzialnego za renderowanie obrazu) zależy, na ile materiał po wyrenderowaniu
może być podobny do uproszczonego podglądu z okna roboczego. Wpływa tak-
że na to poziom szczegółowości wyświetlania obiektów w oknie roboczym, któ-
ry jest uzależniony od posiadanej karty graficznej i sterowników systemowych.
Jeśli jest to możliwe, z menu Renderer nad oknem widokowym należy wybrać
pozycję High Quality Rendering zamiast domyślnie włączonej Default Quality
Rendering, co włączy dokładniejsze odwzorowanie materiałów w oknie wido-
kowym ale może też spowodować obniżenie wydajności wyświetlania sceny lub
pojawienie się różnego rodzaju artefaktów na wyświetlanych obiektach.

Porównując rysunki 8.1. oraz 8.3. można zaobserwować różnice pomiędzy
wyświetlaniem obiektów ze skomplikowanymi materiałami w trybach Default
Quality Rendering (rysunek 8.3) i High Quality Rendering (rysunek 8.1).

Rysunek 8.3. Tryb Default Quality Rendering znacznie gorzej odwzorowuje zło-
żone materiały w oknach roboczych programu niż tryb High Quality Rendering

Różnice pomiędzy szczegółowością materiałów zauważalną w różnych trybach
wyświetlania sceny i finalnego renderingu są tym większe, im bardziej skompli-
kowane są materiały. Na potrzeby wykonywania przykładów przedstawionych
w niniejszej książce nie będzie konieczności zbyt częstego renderowania sceny,
gdyż stosunkowo proste materiały, które utworzymy, powinny być poprawnie
wyświetlane już w czasie rzeczywistym, po włączeniu trybu High Quality Ren-
dering dla okien widokowych. Gdyby jednak ze względu na ograniczenia sys-
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temowe lub rosnącą złożoność materiałów tryb ten nie dawał odpowiednich
rezultatów, należy użyć funkcji pełnego renderowania sceny w osobnym oknie.

8.2 Podstawy pracy z materiałami

O ile większość operacji dotyczących modelowania wykonujemy w oknie robo-
czym wyświetlającym trójwymiarowy podgląd sceny, o tyle do tworzenia oraz
edycji materiałów służy odrębny edytor, noszący nazwę Hypershade. By go ot-
worzyć, wybierz polecenie Window > Rendering Editors > Hypershade (rysu-
nek 8.4) lub kliknij ikonę Hypershade/Persp w przyborniku po lewej stronie
interfejsu, aby podzielić okno robocze na dwa panele - trójwymiarowy podgląd
sceny i zadokowane okno Hypershade.

Okno Hypershade wyświetla strukturę materiałów w formie grafów ilustru-
jących połączenia pomiędzy materiałem głównym a teksturami definiującymi

Rysunek 8.4. Okno edytora Hypershade
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jego właściwości (prawy dolny róg rysunku 8.4). Po lewej stronie znajduje się
panel Create służący do tworzenia nowych materiałów i tekstur, natomiast
w prawym górnym rogu okna Hypershade wyświetlone są zakładki Materials,
Textures, Utilities i inne, na których pogrupowano kategorie obiektów związa-
nych z renderingiem, takich jak materiały i tekstury, ale też światła, kamery
itd. Ikonami z szachownicą i czarnymi paskami w górze okna można zmieniać
aranżacje tych paneli, włączając lub wyłączając ich wyświetlanie.

Aby zmodyfikować domyślny szary materiał przypisywany każdemu obiek-
towi, wykonaj następujące czynności:

1. Utwórz dowolny obiekt z menu Create > Polygon Primitives lub załaduj
jeden z modeli utworzonych w poprzednich rozdziałach.

2. Wybierz polecenie Window > Rendering Editors > Hypershade, aby wyś-
wietlić na ekranie okno Hypershade.

3. Zaznacz kliknięciem model w oknie widokowym, a następnie w oknie Hy-
pershade wybierz polecenie Graph > Graph Material on Selected Objects.
Polecenie to pobiera materiał (lub materiały, jeśli jest ich więcej) z zaz-
naczonego obiektu i wyświetla ich graf w dolnej części okna Hypershade.
Domyślnie wszystkim obiektom przypisywany jest matowy, szary materiał
o nazwie lambert1, więc po wykonaniu powyższej operacji okno z grafem
materiału powinno wyglądać jak na rysunku 8.5.

Rysunek 8.5. Okno Hypershade z grafem domyślnego materiału lambert1
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4. Materiał lambert1, podobnie jak każdy inny materiał użyty w scenie, mo-
żna dowolnie parametryzować, jednak należy pamiętać o tym, że zmiana
tego materiału wpłynie na wszystkie nowo tworzone obiekty. Zaznacz klik-
nięciem szarą kulkę reprezentującą materiał lambert1, by w bocznym edy-
torze atrybutów wyświetlić właściwości materiału (rysunek 8.6).

Rysunek 8.6. Panel z ustawieniami materiału typu Lambert

5. Zbiór parametrów i opcji wyświetlanych w edytorze atrybutów zależy od
typu materiału, z jakim mamy do czynienia. Zaznaczony materiał korzy-
sta z modelu oświetlenia Lamberta, czyli imituje powierzchnię rozprasza-
jącą światło - matową. Jest to jeden z prostszych typów materiałów. Jego
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najważniejsze właściwości to kolor światła rozpraszanego (Color), prze-
zroczystość (Transparency), kolor światła otoczenia (Ambient), kolor i in-
tensywność świecenia (Incandescence). Na próbę zmieńmy najważniejszą
z nich, czyli Color. Kliknij szary prostokąt z próbką koloru w polu Color,
zaś w oknie Color Chooser, wybierz odpowiadającą Ci barwę. Okno Color
Chooser (rysunek 8.7) pozwala określić kolor w systemie RGB lub HSV,
bądź skorzystać z próbnika gotowych barw. Po wybraniu koloru naciśnij
przycisk Accept.

Rysunek 8.7. Okno służące do zmiany koloru obiektu

6. Podobnie jak kolor powierzchni, można też zmieniać pozostałe właściwości
materiału. Na przykład przezroczystość (Transparency) również można
określić przy pomocy okna Color Chooser (im jaśniejszy kolor, tym bar-
dziej przezroczysty będzie obiekt), ale też, jak w przypadku każdego para-
metru opisywanego pojedynczą liczbą, można po prostu określić jego war-
tość za pomocą suwaka. Kliknij suwak na prawo od pola Transparency
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i przeciągnij go w prawo, a zobaczysz, jak obiekt staje się coraz bardziej
przezroczysty (rysunek 8.8.) - jeśli dociągniesz suwak do prawej krawędzi
zakresu, obiekt zniknie z okna widokowego (chociaż fizycznie dalej będzie
obecny w scenie, stanie się całkowicie przezroczysty).

Rysunek 8.8. Zmiana przezroczystości obiektu za pomocą parametru Transparency

Złożone sceny zazwyczaj wymagają wykorzystania wielu różnych materia-
łów. W oknie Hypershade można utworzyć dowolną liczbę nowych materiałów
i przypisać je wybranym obiektom. Aby dodać i zmodyfikować nowy materiał,
wykonaj opisaną niżej procedurę:

1. W scenie z poprzedniego ćwiczenia, w oknie Hypershade wybierz polecenie
Create > Materials > Phong, co spowoduje utworzenie nowego materiału
typu Phong - jego ikona powinna pojawić się w górnej i dolnej części okna
Hypershade (rysunek 8.9). Materiał ten wykorzystuje algorytm cieniowa-
nia Phonga, uwzględniający odblaski światła na powierzchni obiektu, co
można zauważyć na próbce materiału, która nie jest już w tym przypadku
matowa. Materiały typu Lambert i Phong są jednymi z najczęściej stoso-
wanych w grafice trójwymiarowej, ze względu na swoją prostotę i uniwer-
salność.

2. Materiał można przypisać obiektowi, przeciągając jego ikonę środkowym
klawiszem myszy z okna Hypershade nad obiekt widoczny w oknie widoko-
wym, ten sam efekt można też uzyskać w inny sposób - zaznaczyć obiekt,
kliknąć prawym klawiszem myszy ikonę materiału w oknie Hypershade
oraz wybrać z menu podręcznego polecenie Assign Material To Selection.
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Rysunek 8.9. Okno Hypershade po dodaniu nowego materiału typu Phong

W obu przypadkach obiekt powinien stać się połyskliwy (rysunek 8.10),
zaś w edytorze atrybutów dostępne będą dodatkowe ustawienia materiału
Phong odpowiedzialne za odblaski (Specular Shading).

3. Parametrami z grupy Specular Shading (Cosine Power oraz Specular Co-
lor) możemy modyfikować rozmiar i intensywność odblasków, na przykład
zmniejszając pierwszy z nich i zwiększając drugi uzyskamy większe i bar-
dziej intensywne plamy światła na powierzchni obiektu (rysunek 8.11).

W powyższych przykładach zmienialiśmy parametry materiału za pomocą
wartości koloru lub liczbowej, które określały wygląd materiału globalnie na
całej powierzchni obiektu. Możliwe jest jednak trzecie rozwiązanie - określenie
poszczególnych właściwości materiału w zróżnicowany sposób dla poszczegól-
nych fragmentów obiektu. Służą do tego tekstury (zwane też mapami), czyli
obrazy określające wartość parametru lub kolor w oparciu o intensywność
lub składowe RGB różnych obszarów obrazu. Dzięki temu możemy nakładać
i mieszać różne kolory, poziomy przezroczystości czy odblasków w różnych
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Rysunek 8.10. Obiekt z materiałem typu Phong i właściwości tego materiału
w edytorze atrybutów

Rysunek 8.11. Materiał Phong po zmianie właściwości odblasków
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miejscach modelu. Każdej właściwości materiału określanej poprzez kolor lub
wartość można przypisać inną teksturę, co ilustruje poniższy przykład:

1. Dla obiektu i materiału z poprzedniego ćwiczenia przejdź do panelu atry-
butów phong1 (jeśli nie jest on zaznaczony, w oknie Hypershade kliknij
próbkę materiału, aby go uaktywnić).

2. Na prawo od pola i suwaka Color w edytorze atrybutów znajduje się ikona
szachownicy (identyczna jak dla innych parametrów). Kliknij w tę ikonę,
żeby otworzyć okno Create Render Node, które umożliwia utworzenie no-
wej tekstury, która zostanie przypisana do wybranej właściwości materia-
łu. W oknie tym aktywna powinna być zakładka Textures, zaś w rolecie 2D
Textures, należy przy tym się upewnić, że włączona jest opcja Normal (ry-
sunek 8.12).

Rysunek 8.12. Okno Create Render Node pozwala między innymi na tworzenie
nowych tekstur, które automatycznie przypisywane są określonym właściwościom
materiału
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3. W oknie Create Render Node, kliknij przycisk tekstury z nazwą Cloth, któ-
ra tworzy wzór przypominający tkaninę. W zależności od struktury obiek-
tu i współrzędnych mapowania (którym poświęcimy dalszą część tego ro-
zdziału), na powierzchni obiektu powinien pojawić się mniej lub bardziej
gęsty wzór tkaniny (rysunek 8.13). Uwaga: możliwe jest, że w przypadku
złożonego obiektu, dla którego nie zdefiniowano odpowiednio współrzęd-
nych mapowania, wzór będzie zupełnie nieczytelny - w takim przypadku
na potrzeby tego ćwiczenia należy wykorzystać jeden z obiektów standar-
dowych, na przykład sferę lub walec.

Rysunek 8.13. Obiekt z nałożoną teksturą Cloth

4. Wróćmy teraz do okna Hypershade i mając zaznaczony w scenie obiekt
z nowym materiałem, wybierzmy polecenie Graph > Graph Materials on
Selected Objects. W dole okna Hypershade powinien ukazać się graf mate-
riału Phong z przyłączoną do niego teksturą Cloth. W zależności od tego,
czy chcemy zmienić właściwości materiału czy tekstury, wystarczy klik-
nąć odpowiedni węzeł grafu i przejść do edytora atrybutów. Do tekstury

Rysunek 8.14. Graf materiału Phong z podłączoną teksturą Cloth
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domyślnie przyłączany jest dodatkowy węzeł o nazwie place2DTexture (ry-
sunek 8.14 po lewej), który umożliwia pozycjonowanie tekstury na powie-
rzchni obiektu.

5. Aby zmienić gęstość tekstury na powierzchni obiektu, zaznacz węzeł pla-
ce2dTexture w oknie Hypershade i w edytorze atrybutów zmień oba pa-
rametry Repeat UV na większą wartość. Parametry te odpowiadają za
liczbę powtórzeń wzoru tekstury na powierzchni obiektu (rysunek 8.15).

Rysunek 8.15. Zmiana gęstości wzoru tekstury na powierzchni obiektu
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Tekstury i mapowanie UV

9.1 Wprowadzenie

Tworząc materiały dla obiektów w scenie 3D prędzej czy później musimy uciec
się do wykorzystania tekstur, czego przykłady przedstawiono w poprzednim
rozdziale. Poza tak zwanymi teksturami proceduralnymi, czyli wzorami wyge-
nerowanymi przez Mayę, bardzo często korzysta się z tekstur ręcznie malowa-
nych w programach 2D lub stworzonych w oparciu o zdjęcia. Pozwalają one
nadawać modelom unikalny styl artystyczny lub uczynić je fotorealistycznymi,
umożliwiając jednocześnie pełną kontrolę nad każdym fragmentem powierz-
chni obiektu. Przykład fotorealistycznego obiektu - zardzewiałego metalowego
zbiornika - oraz nałożonej na niego tekstury przedstawiają rysunki 9.1 i 9.2.
W dalszej części tego rozdziału przedstawimy etapy pracy nad teksturami dla
tego typu obiektu.

9.2 Przygotowanie modelu do teksturowania

Obiekt przedstawiony na rysunku 9.1 jest bardzo prosty - odpowiedni materiał
oraz tekstura nadają mu złożony i realistyczny wygląd. Warto pamiętać o tym,
że nieskomplikowany model z dobrze przygotowaną teksturą może wyglądać
bardzo przekonująco, natomiast nawet najbardziej złożony obiekt poprzez zły
dobór materiału i tekstur można uczynić mało wiarygodnym.

Modelowanie obiektu

Aby wymodelować główną część zbiornika przedstawionego na rysunku 9.1,
wykonaj następujące czynności.

1. Wybierz polecenie Create > Polygon Primitives > Cylinder oraz dwukrot-
nie kliknij i przeciągnij kursorem w oknie widokowym, żeby zdefiniować
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Rysunek 9.1. Obiekt z fotorealistyczną teksturą

Rysunek 9.2. Fotografia zardzewiałej metalowej powierzchni użyta jako tekstura
obiektu z rysunku 9.1
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podstawę i wysokość walca. W edytorze atrybutów zmień wartość parame-
tru Subdivision Caps na 0, aby wyłączyć segmentację podstaw bryły (ry-
sunek 9.3).

Rysunek 9.3. Walec po wyłączeniu segmentacji podstaw

2. Kliknij na walec prawym klawiszem myszy i z menu podręcznego wybierz
tryb edycji ścianek (Face). W trybie tym zaznacz obie podstawy, klikając
je kolejno z wciśniętym klawiszem Shift (rysunek 9.4).

3. Wybierz polecenie Edit Mesh > Bevel, aby sfazować krawędzie podstaw.
Wedytorze atrybutów narzędzia Bevel zmień parametr Offset na 0.2, na-
tomiast Segments na 5, żeby uzyskać gładkie zaokrąglenia o małym pro-
mieniu (rysunek 9.5).

4. Kliknij prawym klawiszem myszy na obiekcie i z menu podręcznego wy-
bierz Object Mode, aby wyjść z trybu edycji ścianek. Jeśli zaokrąglenia na
obiekcie nie są poprawnie wygładzone, co zdarza się dość często, gdy uży-
wamy narzędzia Bevel (rysunek 9.6 - po lewej), należy zaznaczyć obiekt
i wybrać polecenie Normals > Soften Edge, żeby uzyskać idealnie gładką
bryłę, jak na rysunku 9.6 - po prawej.

Nakładanie wzoru szachownicy na obiekt

Zanim nałożymy na obiekt właściwą teksturę, należy odpowiednio przygoto-
wać jego współrzędne UV, czyli sposób rzutowania tekstury na naszym obiek-
cie. W tym celu pokryjemy obiekt wzorem szachownicy, który pozwoli nam na
ocenę i ewentualne skorygowanie aktualnych współrzędnych mapowania tek-
stury.



172 9 Tekstury i mapowanie UV

Rysunek 9.4. Zaznaczanie górnej i dolnej podstawy walca

Rysunek 9.5. Model zbiornika o zaokrąglonych krawędziach
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Rysunek 9.6. Obiekt z błędami wygładzania (po lewej) i wygładzony poprawnie
(po prawej)

W poprzednich rozdziałach była już okazja zapoznania się z przykładami
dotyczącymi nakładania tekstur, dlatego tutaj przedstawimy ten proces skró-
towo:

1. Wybierz polecenie Window > Rendering Editors > Hypershade, aby otwo-
rzyć okno edytora materiałów.

2. W oknie Hypershade wybierz polecenie Create > Materials > Phong.
3. Zaznacz próbkę materiału phong1 i w edytorze atrybutów z boku ekranu

kliknij szachownicę obok pola Color.
4. W oknie Create Render Node użyj przycisku Checker - na początek dla te-

stu użyjemy wzoru z szachownicą, aby lepiej zilustrować sposoby rzutowa-
nia tekstury na obiekt.

5. Kliknij próbkę materiału phong1 w oknie Hypershade i przeciągnij środko-
wym przyciskiem myszy na wymodelowany obiekt. Naciśnij klawisz 6, aby
włączyć podgląd tekstur w oknie widokowym. Rezultat powinien wyglądać
jak na rysunku 9.7 (warto włączyć wysoką jakość renderingu w oknie wido-
kowym za pomocą polecenia Renderer > High Quality Rendering z menu
umieszczonego ponad tym oknem).

6. Wzór szachownicy na obiekcie jest w tej chwili za mało gęsty, aby dokła-
dnie ocenić rzutowanie (mapowanie) tekstury na obiekt, dlatego też, na-
leży zmienić liczbę powtórzeń tego wzoru. Kliknij ikonę place2DTexture
w oknie Hypershade i w edytorze atrybutów zmień parametry Repeat UV
z domyślnej wartości 4 na 20. Po wykonaniu tej operacji obiekt powinien
wyglądać jak na rysunku 9.8.
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Rysunek 9.7. Obiekt z nałożoną teksturą szachownicy

Rysunek 9.8. Podgląd materiału po zagęszczeniu wzoru tekstury
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9.3 Dopasowanie współrzędnych mapowania UV

Obserwując rysunek 9.8, można zauważyć, że na bocznej powierzchni walca
tekstura jest nieproporcjonalnie rozciągnięta - przy poprawnym mapowaniu
wzór powinien składać się z kwadratów, a nie prostokątów. Nałożenie tekstury
fotograficznej na tak zmapowany obiekt spowoduje, że piksele fotografii na bo-
cznych ściankach będą rozciągnięte i nieostre. Aby uzyskać poprawne rzuto-
wanie tekstury na obiekt, musimy poprawić jego mapę współrzędnych UV.

Współrzędne UV są to koordynaty, które określają pozycje poszczególnych
wierzchołków siatki względem tekstury nałożonej na obiekt. W odróżnieniu od
współrzędnych XYZ w przestrzeni trójwymiarowej, tutaj mamy do czynienia
jedynie z dwoma wymiarami - poziomym (U) i pionowym (V), gdyż tekstura
nałożona na obiekt nie posiada trzeciego wymiaru. Odwzorowanie wierzchoł-
ków trójwymiarowej siatki w płaskim układzie współrzędnych UV jest często
dość problematyczne, zwłaszcza dla skomplikowanych brył, dlatego Maya po-
siada szereg narzędzi do mapowania obiektów i specjalny edytor do manualnej
edycji mapy UV - UV Texture Editor.

Rysunek 9.9. Domyślne współrzędne mapowania walca
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Aby uzyskać podgląd aktualnych współrzędnych UV obiektu, zaznacz go i wy-
bierz polecenie Edit UVs > UV Texture Editor z górnej listwy menu. Powinie-
neś ujrzeć widok zbliżony do tego z rysunku 9.9. Jeśli przeszkadza Ci szacho-
wnica wyświetlana w tle, wybierz polecenie Image > Display Image w oknie
UV Texture Editor.

Ręczne modyfikowanie współrzędnych UV

Analizując siatkę współrzędnych mapowania w edytorze UV, możemy stwier-
dzić, że domyślnie obiekt typu Cylinder mapowany jest planarnie dla gór-
nej i dolnej ścianki oraz walcowo dla ścianek bocznych. Rozmiar i proporcje
fragmentu siatki odpowiadającego ściankom bocznym powodują, że na tych
ściankach tekstura jest rozciągnięta. Możemy poprawić tę usterkę, dopasowu-
jąc skalę tego elementu w oknie edytora UV:

1. Kliknij prawym przyciskiem w oknie UV Texture Editor, w menu podrę-
cznym wybierz opcję UV, aby przejść do trybu edycji współrzędnych UV.

2. Przeciągnij ramką zaznaczenia nad wierzchołkami środkowego fragmentu
siatki, starając się nie zaznaczyć wierzchołków górnej i dolnej ścianki (ok-
rągłe elementy na siatce UV).

3. Po zaznaczeniu całego fragmentu siatki, włącz narzędzie skalowania (kla-
wisz R) i przeciągnij lewym klawiszem myszy czerwony uchwyt skalowania
w poziomie, tak aby rozciągnąć wierzchołki na kilkukrotnie większą sze-
rokość. Przeciągając kursorem, możesz obserwować w oknie widoku sceny,
jak zmienia się rozciągnięcie tekstury na powierzchni obiektu - powinieneś
przestać skalować, gdy wzór tekstury na bocznej powierzchni walca stanie
się szachownicą o kwadratowych polach (rysunek 9.10).

Optymalizacja rozkładu współrzędnych UV

Przy mapowaniu przedstawionym na rysunku 9.10 piksele tekstury nie ule-
gają już rozciąganiu i rozmywaniu na powierzchni obiektu, jednak rozłożenie
współrzędnych UV nie jest jeszcze optymalne. Jak można zauważyć w edyto-
rze UV, siatka współrzędnych mapowania obejmuje tylko pewien wycinek tek-
stury (kwadratu o współrzędnych U i V z zakresu od 0 do 1), więc w praktyce
po nałożeniu na obiekt fotografii wykorzystalibyśmy tylko jej część, co ozna-
cza konieczność stosowania pliku w dużej rozdzielczości, aby uniknąć efektu
pikselozy na powierzchni obiektu. Również edycja tak zdefiniowanej tekstury
w programie do grafiki 2D mogłaby być niezbyt wygodna, dlatego warto upo-
rządkować nieco rozkład siatki w edytorze UV:

1. Zaznacz wierzchołki bocznych ścianek walca w oknie UV Texture Editor
i przesuń je w dół (narzędzie Move - skrót klawiszowy W) kwadratu wy-
znaczanego współrzędnymi od 0 do 1. Przeskaluj go proporcjonalnie (na-
rzędzie Scale - skrót klawiszowy R) tak, aby boczne krawędzie siatki znaj-
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Rysunek 9.10. Model zbiornika po skorygowaniu współrzędnych mapowania

dowały się na skrajnych zakresach układu współrzędnych - wypełniając
teksturę od lewej do prawej krawędzi.

2. Zaznacz górną i dolną podstawę walca i przesuń je w górę edytora UV,
aby znalazły się na tym samym poziomie oraz możliwie blisko siebie (nie
pokrywając się żadną ścianką ani wierzchołkiem) - zobacz rysunek 9.11.
Ulokuj obie podstawy w narożniku wolnego obszaru tekstury. Jeśli rozmiar
kwadratów szachownicy na podstawach i bocznej powierzchni jest różny,
przeskaluj podstawy tak, aby uzyskać jednolitą skalę tekstury na całym
obiekcie. Wskazówka: aby ułatwić sobie zaznaczanie poszczególnych frag-
mentów siatki, nie musisz za każdym razem rozciągać ramki selekcji nad
wszystkimi ich wierzchołkami. Wystarczy zaznaczyć pojedynczy wierzcho-
łek danego segmentu i wybrać polecenie Select > Select Shell w górze okna
UV Texture Editor.

Optymalizacja wypełnienia tekstury

Układ współrzędnych UV z rysunku 9.11 daje nam jednolitą skalę tekstury
na całej powierzchni obiektu i pozostawia miejsce na dodanie kolejnych ele-
mentów (tego samego lub innego modelu) w obrębie tej samej tekstury. Do te-
go możliwe jest elastyczniejsze operowanie współrzędnymi UV gdyby później
korzystne było przesuwanie niektórych elementów w obrębie tekstury. Jeżeli
chcemy uzyskać większą rozdzielczość tekstury na podstawach walca, kosztem
spójności skali poszczególnych elementów, możemy przeskalować obie podsta-
wy tak, żeby wypełniały większą część pustej przestrzeni tekstury (rys. 9.12).
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Rysunek 9.11. Wstępna optymalizacja rozkładu współrzędnych UV

Rysunek 9.12. Optymalizacja wypełnienia tekstury
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Ze względu na charakter tekstury planowanej dla tego modelu (fotografia o je-
dnolitej skali szczegółów) zostaniemy przy wariancie pierwszym, czyli wersji
z rysunku 9.11.

9.4 Tworzenie fotorealistycznej tekstury

Modelowi przygotowanemu w sposób przedstawiony powyżej, można przypi-
sać teksturę w postaci dowolnej bitmapy. W naszym przypadku utworzymy
efekt zardzewiałego metalu, wykorzystując do tego celu fotografię skorodowa-
nej blachy.

Wyszukiwanie materiałów źródłowych

Materiał źródłowy do takiej tekstury bez trudu pozyskamy podczas wycieczki
z aparatem fotograficznym po mieście (fragment kosza na śmieci, kontenera,
pojazdu, metalowych drzwi itp.). W przypadku braku możliwości wykorzysta-
nia zdjęć można posiłkować się materiałami dostępnymi w Internecie. Należy
jednak zwrócić uwagę na fakt, że wiele spośród udostępnionych w sieci mate-
riałów jest objętych prawami autorskimi i wykorzystanie ich w celach komer-
cyjnych może być problematyczne. Na potrzeby niniejszego ćwiczenia możemy
jednak skorzystać z obrazów wyszukanych jedną z popularnych wyszukiwarek
(rysunek 9.13). Wpisując w wyszukiwarce na przykład “rust texture” (z ang.
“tekstura rdza”), powinniśmy znaleźć pokaźny zbiór różnego rodzaju fotografii
przedstawiających zardzewiałe powierzchnie. Plik o odpowiadającej nam to-
nacji oraz fakturze blachy należy zapisać na dysku, najlepiej w katalogu z pro-
jektem Mayi.

W omawianym tu przykładzie użyjemy fotografii fragmentu nadwozia za-
bytkowego pojazdu pancernego, wykonanej na terenie Muzeum Broni Pan-
cernej w Warszawie (rysunek 9.2). Tekstura ta oprócz wzoru rdzawych prze-
barwień zawiera inne szczegóły, które mogą uczynić obiekt bardziej realistycz-
nym bez konieczności modelowania większej liczby elementów - zatarte napisy,
przyspawana tabliczka z numerem pojazdu czy odpryski farby.

9.5 Nakładanie tekstury na obiekt

Aby nałożyć nowy materiał i teksturę na obiekt, powtórz czynności opisane
wcześniej w podrozdziale “Nakładanie wzoru szachownicy na obiekt” z tą róż-
nicą, że w oknie Create Render Node kliknij przycisk File zamiast Checker,
dzięki temu będziesz mógł załadować teksturę z pliku znajdującego się na dy-
sku zamiast wzoru szachownicy używanego wcześniej. W kanale mapowania
koloru materiału Phong zostanie umieszczony plik, który wskażemy w polu
Image Name edytora atrybutów (rysunek 9.14).
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Rysunek 9.13. Wyszukiwanie fotografii zardzewiałego metalu

Korekta mapowania obiektu

W zależności od skali szczegółów przedstawionych na teksturze, po jej nałoże-
niu obiekt może wyglądać mniej lub bardziej poprawnie. Należy pamiętać, iż
rozmiar elementów widocznych na powierzchni obiektu powinien odpowiadać
jego rzeczywistej skali - w naszym przypadku, półmetrowy fragment pancernej
blachy ma zbyt małą skalę, żeby dać realistyczną gęstość wzoru rdzy na po-
wierzchni dość dużego zbiornika. Widać to szczególnie, gdy otworzymy okno
UV Texture Editor i przyjrzymy się powierzchni zdjęcia obejmowanej siatką
współrzędnych UV (rysunek 9.15).

W takiej sytuacji mamy różne możliwości skorygowania skali tekstury na
powierzchni obiektu, z których każda ma swoje zalety i wady:

1. Przeskalowanie współrzędnych UV w górę lub zmiana opcji powtarzania
tekstury (jak w podrozdziale “Nakładanie wzoru szachownicy na obiekt”).
Tekstura zostanie zagęszczona na obiekcie i jej szczegóły ulegną zmniej-
szeniu. Jest to najszybsza metoda, jednak jej wadami jest to, że w wielu
przypadkach powtarzalność wzoru może być zauważalna, a bez odpowied-
niej obróbki fotografii na powierzchni obiektu pojawią się szwy, czyli miej-
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Rysunek 9.14. Tekstura załadowana z dysku określa kolor powierzchni materiału
typu Phong

Rysunek 9.15. Tekstura nałożona na obiekt ma zbyt małą skalę
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sca, w których widoczne będzie ostre cięcie na ściankach, gdzie schodzą
się przeciwległe krawędzie fotografii (rysunek 9.16). W przypadku, gdy nie
skalujemy współrzędnych UV i cała siatka mapowania znajduje się w ob-
rębie pojedynczego powtórzenia tekstury, szwy mogą wystąpić tylko na
brzegach siatki UV.

Rysunek 9.16. Przeskalowanie współrzędnych UV pozwala skorygować rozmiary
elementów tekstury, ale powoduje pojawienie się dodatkowych szwów na powierzchni
materiału

2. Załadowanie tekstury do programu służącego do obróbki bitmap (takich
jak Photoshop) oraz utworzenie tam nowej tekstury o większym zagęszcze-
niu szczegółów (np. pomniejszenie aktualnej tekstury i wklejenie jej kilka
razy do nowego pliku, aby uzyskać drobniejszy wzór). Rozwiązanie to daje
nam większą kontrolę nad wyglądem powierzchni obiektu (można poddać
bitmapę dowolnej obróbce, połączyć ze sobą kilka różnych zdjęć itd.), ale
podobnie jak w poprzednim przypadku, musimy zadbać o maskowanie
szwów pomiędzy poszczególnymi fragmentami tekstury i praca nad mo-
delem może być w tym przypadku bardziej czasochłonna (rys. 9.17). Jeśli
nie chcemy modyfikować zawartości tekstury poprzez jej edycję w Photo-
shopie, to zagęszczanie jej tą metodą jest pozbawione sensu.

9.6 Maskowanie szwów w programie do grafiki 2D

Przy kilkukrotnym powtarzaniu tekstury fotograficznej na powierzchni obie-
ktu zazwyczaj mocno widoczne są szwy, czyli niedopasowane do siebie krawę-
dzie zdjęcia w miejscach, gdzie kończy się jedno, a zaczyna kolejne powtórzenie
tekstury (rysunek 9.18). Oprócz tego szwy związane są nieciągłościami siatki
UV, które zależą od stopnia złożoności modelu i przyjętej metody mapowania.
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Rysunek 9.17. Nowa tekstura złożona z czterech powtórzeń wcześniej używanej
bitmapy - wzór pokrywający powierzchnię zostaje przez to zagęszczony

Rysunek 9.18. Szwy widoczne w miejscu łączenia kolejnych powtórzeń tekstury
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Aby wyeliminować szwy, konieczne jest wykorzystanie programu do grafiki
2D, takiego jak Photoshop. Żeby usunąć szwy pochodzące z brzegów obrazka,
należy w taki lub inny sposób zamaskować różnice pomiędzy lewą i prawą oraz
górną i dolną krawędzią zdjęcia. Można tego dokonać na przykład wypełniając
brzegi obrazka jednolitym kolorem, jednak rzadko tego typu rozwiązanie daje
dobre efekty. Jedną z najprostszych metod maskowania szwów jest wykorzys-
tanie filtra Offset (w polskiej wersji programu filtr ten nosi nazwę Przesunię-
cie). Aby przeprowadzić tę operację, wykonaj następujące czynności:

1. Załaduj plik tekstury w Photoshopie.
2. Wybierz teraz polecenie Filter > Other > Offset. W oknie dialogowym Of-

fset wpisz w polach Horizontal i Vertical liczby stanowiące mniej więcej
połowę rozdzielczości obrazka, lub przeciągnij kursorem obrazek, aby prze-
sunąć go względem ramki. Jeśli opcja Undefined Areas jest ustawiona na
Wrap Around, wtedy piksele odpowiadające krawędziom obrazu zostaną
przesunięte w stronę środka ramki (rysunek 9.19). Naciśnij przycisk OK.

Rysunek 9.19. Filtr Offset pozwala przesunąć piksele bitmapy w taki sposób, że
na środku obrazka widoczne stają się szwy biegnące wzdłuż krawędzi
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3. Aby zamaskować szwy związane z nieciągłością brzegów tekstury, należy
zamalować je pędzlem o określonym kolorze lub wkleić w ich miejsce mię-
kko wtapiające się w tło fragmenty pobrane z innej części obrazka. W tym
celu można wykorzystać na przykład stempel (klawisz S ) z dużą i mięk-
ką końcówką (rysunek 9.20). Przed użyciem stempla należy przytrzymać
klawisz Alt i wskazać kliknięciem obszar, z którego chcemy skopiować pik-
sele do maskowania, a następnie po zwolnieniu tego klawisza malować po
szwach tak jak w przypadku zwykłego pędzla, ukrywając je pod piksela-
mi pobranymi z wcześniej wybranego fragmentu bitmapy (rysunek 9.21).
W trakcie pracy można wielokrotnie zmieniać obszar, z którego pobierane
są piksele do maskowania.

Rysunek 9.20. Wybór narzędzia Stamp i jego końcówki

Gdy szwy przestaną być widoczne, możemy ponownie użyć filtra Offset,
by przesunąć krawędzie w ich pierwotne miejsca (o ile jest to potrzebne). Tek-
stura bez szwów nałożona na obiekt pozwala na zachowanie efektu ciągłości
powierzchni (rysunek 9.22), choć pojedyncze szwy mogą być ciągle widoczne
w miejscach, gdzie współrzędne UV są nieciągłe - jeśli chcemy usunąć i te szwy,
musimy odpowiednio podmalować wszystkie miejsca tekstury, które odpowia-



186 9 Tekstury i mapowanie UV

Rysunek 9.21. Maskowanie szwów narzędziem Stamp - strzałka ilustruje, skąd
i dokąd kopiowane są piksele (większość szwów jest już zamalowana)

dają nieciągłym krawędziom na siatce UV. Możemy też przesuwać i skalować
siatkę UV w edytorze Mayi, lecz często nie wystarcza to do odpowiedniego
zamaskowania pozostałych szwów.

W celu dokładnej korekty szwów w Photoshopie możemy zapisać podgląd
siatki UV na dysku z poziomu okna UV Texture Editor w Mayi - służy do te-
go polecenie Polygons > UV Snapshot, które pozwala wybrać format, roz-
dzielczość i inne właściwości bitmapy przedstawiającej siatkę UV. Bitmapę
można następnie otworzyć w Photoshopie i nałożyć ponad teksturę jako do-
datkową warstwę w trybie wyświetlania Screen lub Overlay, aby ujrzeć gdzie
dokładnie znajdują się wszystkie zewnętrzne krawędzie siatki UV (rysunek
9.23). Maskując te krawędzie pędzlem lub stemplem (często jest to trudne lub
czasochłonne w zależności od kształtu siatki i zawartości tekstury), możemy
ukryć wszystkie pozostałe szwy. Idealne zamaskowanie szwów w przypadku
złożonego obiektu i tekstury może być niemożliwe, jednak zazwyczaj nie jest
to konieczne, gdyż wszystko zależy od tego, z jakiej odległości i pod jakimi
kątami obiekt pokazywany będzie w scenie.
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Rysunek 9.22. Tekstura z zamaskowanymi szwami po nałożeniu na obiekt

9.6.1 Mapowanie dodatkowych właściwości materiału teksturą
fotograficzną

Po nałożeniu tekstury fotograficznej obiekt posiada powierzchnię o zróżnico-
wanej kolorystyce, jednak działanie oświetlenia na tym obiekcie zazwyczaj
pozostawia wiele do życzenia. Na rysunku 9.24 widać obiekt o teksturze poz-
bawionej szwów, którego powierzchnia wygląda mało realistycznie głównie ze
względu na odblaski rozchodzące się po idealnie gładkiej geometrii. W rzeczy-
wistości metalowy zardzewiały obiekt nie odbijałby światła w ten sposób, gdyż
intensywność odblasków zależy w dużym stopniu od chropowatości powierz-
chni oraz jej połyskliwości, która jest bardzo zróżnicowana przy tak niejedno-
rodnych strukturach.

Materiały w Mayi posiadają szereg właściwości, którymi można sterować
za pomocą tekstur podobnie jak kolorem powierzchni. W przypadku omawia-
nego modelu możemy wykorzystać istniejącą teksturę jako mapę odblasków -
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Rysunek 9.23. Podgląd siatki UV w Photoshopie pozwala zamaskować wszystkie
szwy wokół krawędzi UV

Rysunek 9.24. Obiekt z materiałem typu Phong i teksturą koloru wygląda mało
realistycznie ze względu na idealnie gładkie odblaski
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jasne (czystsze) obszary tekstury dadzą mocniejsze odblaski, a ciemne (rdza)
osłabią odblaski. Można też wykorzystać tę samą teksturę jako mapę nierów-
ności (Bump), która z kolei daje efekt wypukłości i zagłębień w zależności od
tego, czy piksel bitmapy jest jasny czy ciemny.

By tego dokonać, po zaznaczeniu obiektu z teksturą otwórz okno Hyper-
shade w Mayi i wybierz polecenie Graph > Graph Materials on Selected Ob-
jects, wyświetlając graf materiału (rysunek 9.24). Następnie kliknij środko-
wym klawiszem myszy na kwadracie z próbką tekstury (file) i przeciągnij go
kursorem nad kulkę z podglądem materiału (phong). W menu podręcznym,
które pojawi się na ekranie, wybierz pozycję bump map (rysunek 9.25).

Rysunek 9.25. Podłączanie tekstury do kanału mapowania nierówności (bump
map)

Po podłączeniu tekstury do kanału bump map obiekt najprawdopodobniej
przyjmie nienaturalnie chropowaty wygląd - jest to związane ze stosunkowo
dużą skalą mapowania nierówności. Aby wygładzić zbyt duże wypukłości, na-
leży w edytorze atrybutów dla mapy nierówności (rys. 9.26) zmniejszyć war-
tość parametru Bump Depth do np. 0.2. (Aby oglądać w czasie rzeczywistym
dokładny podgląd wszystkich zmian w materiale, w menu Renderer ponad ok-
nem widokowym Mayi należy wybrać pozycję High Quality Rendering.).

Powtórz opisaną wyżej procedurę, tym razem podłączając teksturę do ka-
nału specularColor (rysunek 9.27). W zależności od kontrastu tekstury odbla-
ski w zardzewiałych obszarach zostaną mniej lub bardziej wytłumione (rysu-
nek 9.28).

Jeśli chcemy w bardziej wyrazisty sposób podkreślić właściwości złożonego
materiału na powierzchni obiektu, można dodać do sceny odpowiednio usta-
wione źródła światła, które wydobędą odblaski oraz nierówności w interesu-
jących nas miejscach modelu. Za pomocą polecenia Create > Lights > Point
Light dodaj kilka świateł punktowych, rozmieszczając je w różnych miejscach
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sceny. Dla uzyskania ciekawego efektu warto dobrać też odpowiednio intensy-
wności i kolory tych świateł (rysunek 9.29). Podgląd oświetlenia po dodaniu
źródeł światła uzyskamy, naciskając klawisz 7, jednak dla obejrzenia ostate-
cznych rezultatów najlepiej jest zrenderować obraz sceny (ikona Render the
Current Frame na górnym pasku narzędzi).

Rysunek 9.26. Obiekt z wygładzonymi nierównościami

Rysunek 9.27. Podłączanie tekstury do kanału mapowania odblasków
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Rysunek 9.28. Obiekt z teksturą użytą do mapowania koloru, nierówności i od-
blasków

Rysunek 9.29. Scena po dodaniu punktowych źródeł światła
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